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The specifications on which this document is based are subject to change without notice.
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pliance

The equipment referred to in this guide has been tested and found to comply with the limits for a Class A device
pursuant to part 15 of the FCC rules. These limits provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. Stratasys 3D printing systems generate, use and can radiate
radio-frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference, in which case the user will be required to correct the interference at his own expense.

The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6-MATCAB.

NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification to this equipment.
Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the
equipment.

Equipment Recycling

®

Limitation

In the European Union, this symbol indicates that when the last user wishes to discard a product, it must be sent to
appropriate facilities for recovery and recycling. For information about proper disposal, check your purchase contract,
or contact the supplier of the equipment.
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The product, software or services are being provided on an “as is” and “as available” basis. Except as may be stated
specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any kind, whether express or implied,
including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose and non-
infringement.

You understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental, special,
consequential or exemplary damages, including but not limited to, damages for loss of profits, goodwill, use, data or
other intangible losses (even if Stratasys has been advised of the possibility of such damages), resulting from: (i) the
use or the inability to use the product or software; (ii) the cost of procurement of substitute goods and services resulting
from any products, goods, data, software, information or services purchased; (iii) unauthorized access to or alteration
of your products, software or data; (iv) statements or conduct of any third party; (v) any other matter relating to the
product, software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they are based are
subject to change. Stratasys Ltd. may, at any time and without notice, make changes to this document. Stratasys Ltd.,
for itself and on behalf of its subsidiaries, assumes no liability for technical or editorial errors or omissions made herein,
and shall not be liable for incidental, consequential, indirect, or special damages, including, without limitation, loss of
use, loss or alteration of data, delays, or lost profits or savings arising from the use of this document.
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Using This Guide

This user guide provides instructions for installing, operating and maintaining
Objet260 3D printing systems. It explains how to use features, and provides
practical examples to guide you as you use the system.

Important: Read the entire Safety chapter before using the system.

The text and figures in this guide are based on the Objet260 3D printer,
software version 29.2 and Objet Studio software version 9.2.

This guide assumes that—
« all the hardware, software, and network components of your system are
installed, configured, and operating correctly.

« the operator has a working knowledge of the Windows® PC platform.

For More Information

Visit the Stratasys Support Center to download the latest revision of this
document.This document is also available on the Support Center in other
languages.

If you have any questions or comments about the way information is presented
in this guide, or if you have any suggestions for future editions, please send a
message to c-support@stratasys.com.

Revision History

Translations of this guide are updated periodically. If you are consuming a translated
version, please check the English version for the latest revision and list of updates.

The following table lists the main changes in each revision of this document.

Revision

Release Date Description

Rev. |

February 2021 « About this Guide was updated.

* Additional Resources was added.

* Workstation Requirements was updated.
* Replacing the Odor Filter was updated.

* Replacing the UV Lamps was updated with
instructions for replacing the UV lamp bulb.

» Photobleaching for Transparent Parts was
updated.

» Text, style and format improvements.

Rev. J

May 2022 Replacing the Waste Container was updated
with correct waste container weights.

DOC-37004 Rev. J
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Terms Used in This Guide

Build tray In the print preparation application: The surface displayed on the screen
that represents the actual build tray in the printer.
In the printer: The substrate for 3D printing.

Cleaning fluid Cleanser for flushing material feed tubes and the printing block, used to
completely remove model and support material from the system before
loading another type of material in the printer and before long-term
shutdown. The cleaning fluid is supplied in material cartridges.

Client/user The workstation on which software is installed for preparing build trays
workstation for production on PolyJet printers. (There is no limit to the number of
client workstations.)

Connex™ The technology of producing 3D prints by jetting multiple materials
simultaneously from the print heads. This technology enables Objet260
printers to print in Digital Material mode.

Digital Material Combinations of model materials fabricated in the printer from the basic
model materials installed.

Digital Material The printer mode used to print a job using two or three different model

Mode materials. (This mode can also be used to eliminate the need for
performing the Material Replacement procedure when printing with a
single model material.)

GrabCAD Print A software application for preparing print jobs on a variety of 3D printers,
including Objet260-Connex3 printers.

host/server The workstation that interfaces directly with the Objet260 printer and is
workstation  typically positioned next to it.

Job Manager  The part of Objet Studio software that manages production jobs before
they are sent to the PolyJet printer.

Mixed part 3D prints that are produced using more than one model material.

Mixed tray A build tray containing 3D prints, each designed to be printed using a
different model material.

Model material Material used for building the 3D prints.

Objet Studio A software application that prepares files for printing on Stratasys
PolyJet printers.

OBJDF The extension of a file that contains information about the geometry of
an object and the materials required to print it. objdf files are created in
Objet Studio.
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OBJTF The extension of a file that contains all of the information needed for a
printing job on PolyJet 3D printers. An objtffile is used by Objet Studio to
send a print job to a PolyJet 3D printer.

OBJZF The extension of a compressed “wrapper” file containing all of the files
used in an Objet Studio build tray. Using objzffiles, a printing job can be
saved as a single file, for convenient storage and transfer.

Objet™ printer The Stratasys 3D printer referred to in this guide.

Printer The computer inside the Objet260 printer that operates it.

computer

Printer The GUI (graphical user interface) used for controlling Objet260
interface printers.

Printer Software running on the computer in the Objet260 printer, controlling all
software, printer operations.

printer-control

application

Resin The base substance from which photopolymer printing materials are

made for use in Stratasys PolyJet printers.
In Objet Studio and printer-application screens, “resin” refers to cartridges of
model and support materials.

SLC A file that contains bitmaps of individual slices of an object, for printing
3D models.

STL A file used for printing 3D models.

Support Material used for supporting the structure of models during production.

material

DOC-37004 Rev. J 1-4



Objet260 User Guide 1 About This Guide

Additional Resources

Stratasys encourages you to learn more about your additive manufacturing
printer, its capabilities and the technology. A wealth of information is available
on our online digital platforms.

Stratasys Academy

Stratasys Academy is your online learning platform. Here you can browse our
extensive and growing course catalog, register to webinars, view tutorials and
videos at your own pace, and enroll in face-to-face, in person courses. We
encourage you register and start your learning journey today.

Stra Welcome User Demo
Bign Out
ACADEMY™ MHome Hﬁumﬁdhrm

e e T W

Stratasys Academy”

IR 1B soneyom ey Trae Find Learning

[ soeas

it i o w1 LEASN soakary™ & 4

Brewse all coarses >

COMTAUE COURSE | -,

Core Application Essentials - Design For Additive
Manufacturing Using PolyJet Technology
ELEARMNMNG 182057

A SetAigres

OFTIMAL CONTINLE COWRSE

Core Application Essentials - Manufacturing Aids
Jigs&Fixtures

E-LEARNMG 1000003
PTIONL CONTIMUE COURSE | -,

| Core Application Essentials - PolyJet Multi-
Matenals
E-LEARraRG 1000082

Introduction to 3D Printing
E-LEARMPd 1000051
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Stratasys Support Center

The Support Center is your portal to thousands of knowledge assets, including
information on design, applications, and materials. The site also has links to
Web-based training, "how-to" videos and the Stratasys blog. In addition, you
can check the latest revision of the user guide for your printer, and download
documents in different languages.

The Support Center is available in multiple languages. You can change the
display language using the language drop-down menu in the top-left corner of
the homepage.

@ English ~ Stratasys.com | Request Support | Stratasys eStore | Stratasys Academy™ Contact Us

A
$ stratasys |

Printers Materials Applications Industries Resources Translated Resources 7.0

Welcome to

Type in keyword below and click the search icon

I -

GrabCAD Community

The Tutorials section of GrabCAD Community portal is a valuable source for
Stratasys-sponsored and user-genertated 3D printing tips. You can also ask
3D-related questions on the portal and download free CAD files.

GRABCAD

Learn from thousands of free Tutorials

Join the Community

DOC-37004 Rev. J 1-6
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Safety Features

Interlock Switch

Safety Lock

UV Screening

DOC-37004 Rev. J

UY screen

Stratasys 3D printers are designed to comply with CE and FCC
standards. They are equipped with the following safety features:

The power supplied to the UV lamp, the tray heater and the
motion motors is turned off when the cover is opened.

Warning

Do not defeat (override) the interlock switch. Doing so could
result in serious personal injury. If the interlock switch does not
function correctly, do not use the printer, and contact your
service provider.

The cover is locked while the printer is working. If you do
manage to lift it, the UV lamps and the motion motors turn off.

Warning

Do not defeat (override) the safety lock. Doing so could
result in serious personal injury. If the safety lock does not

function correctly, do not use the printer, and contact your

service provider.

The transparent section of the cover blocks harmful UV
radiation, allowing the operator to view the 3D prints during the
printing process.

Coverinterlock switch

Figure 2-1 Front view of the Objet260 printer

2-2



Objet260 User Guide 2 Safety

Circuit Breaker

The power to the printer is turned off in case of electrical
overcurrent.

Note: The circuit breaker is only accessible to service
personnel.

UV-Lamp Overheating
Protection

The power supplied to the UV lamp and the motion motors is
turned off if the temperature around the lamp reaches 90°C
(194°F). A label on the UV-lamp cover indicates if the
temperature has exceeded 65°C (150°F).

Grounded Chassis

The chassis of the printer is grounded, to prevent electrical
shock.

Note: The power outlet must be grounded in accordance with
the local electric code to provide this protection.

%( If the printer is not used as specified in this guide, these safety features may not
provide adequate protection.
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Symbols and Warning Labels

The following table lists the warning labels located on or in the printer.

Warning Symbol

Meaning

Location

Comments

Hazard (general)

On the name plate on

Read the instructions in

connectors.

Near the power-supply
enclosures.

the back of the printer. this document before
operating the printer.
Hot surface On the print block. Risk of burns. Do not
touch this surface after
printing.
/
High voltage Near the UV lamp Risk of electric shock.

Disconnect the power
before servicing.

Ultraviolet radiation

Near the UV lamps.

Risk of injury to skin and
eyes from ultraviolet
radiation. Disconnect the
power before servicing.

Moving parts

On the panel that is
visible when you open
the front doors of the
printer.

Risk of injury from moving
parts. Keep body parts
away from moving parts.
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Safety Guidelines

The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and maintaining
the system. If the system is not operated as specified, the user's safety
may be compromised.

Printer Installation

> |nstallation and removal of the printer should only be done by qualified
service personnel.

> Connect the printer (and the UPS unit) to the electric outlet using a power
cable that is safety-certified.

> The electric outlet should be easily accessible, near the printer.

> Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose the
operator to serious danger from electric shock.

> The following safety statement is followed by translations to Finish,
Norwegian, Swedish and Danish, as required by local regulations:

“The machine must be connected to a grounded power outlet.”

Fl: Laite on liitettava suojakoskettimilla varustettuun pistorasiaan.
NO: Apparatet ma tilkoples jordet stikkontakt.

SE: Apparaten skall anslutas till jordat uttag.

DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som
giver forbindelse til stikproppens jord.

aaaad

> Leave a minimum of 15 centimeters (6 inches) between ventilation
openings and walls or other objects.

> For Japan: The power cable supplied is provided for connecting the printer
to the AC electric source. Do not use it with other equipment.

Printer Operation

> The printer should only be operated by persons trained by an authorized
Stratasys representative.

> All persons operating or maintaining the printer should know the location of
first aid and emergency equipment and how to use it. Never block access
to this equipment.

> Keep fingers and other body parts clear of the printer when closing the
cover.

Never attempt to open the printer while it is working.
Never override the interlock safety switch.

If the interlock safety switch ever fails, do not use the printer.

Y Y VYV

Several parts of the printer remain extremely hot even after it has stopped
operating. Avoid touching the UV lamps and the print block.
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UV Radiation

The UV lamps used in the printer emit dangerous radiation

> |fthe UV lamps remain on when the printer is open, do not stare directly at
the UV light. Shut down the printer and call your Stratasys service provider.

Printer Maintenance

> Service operations should be performed only by qualified personnel who
have been instructed in relevant safety precautions.

> Notify co-workers and those who have access to the printer before
beginning non-routine and hazardous work.

% Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

Model and Support Materials

Model and support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all model
and support materials used by the printer are handled in sealed cartridges.
Normally, operators of the printer should never be directly exposed to
hazardous materials. In the unlikely event of a leak or spill, follow the
instructions that are included with the material cartridges used.

> Store model and support materials indoors, in a dry area with adequate
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.

> Keep model and support materials away from areas where food and drink
are stored, prepared and consumed.

> Uncured printing material is considered a hazardous substance, requiring
certain precautions when directly handling it. To prevent skin irritation, wear
neoprene or nitrile gloves. If there is any chance that model and support
materials might splash into the eyes, wear safety goggles. Prolonged direct
contact with printing materials can cause an allergic reaction.

> When handling UV-cured 3D prints that may not be completely cured on the
surface, common latex gloves are adequate.

> To prevent respiratory irritation, ventilate areas where model and support
materials are used. If the printer is not equipped with an exhaust duct, the
room ventilation system should replace the air 4—6 times per hour.

> Clean up model-material and support-material spills with disposable towels
or other absorbent, non-reusable material, such as sawdust or activated
charcoal. Rinse the spill area with denatured or isopropyl alcohol (IPA),
followed by soap and water. Dispose of the absorbent material in
accordance with local regulations.

> Do not wash contaminated clothing at home; clothing should be
professionally laundered.
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UV Lamps

DOC-37004 Rev. J

> Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing material
may re-expose the user when these items are worn.

UV lamps used by the printer to cure printing materials contain a small amount
of mercury. In the unlikely event of lamp breakage, avoid inhaling mercury
vapor, and ventilate the room. If the lamp ruptures (breaks) during operation,
leave the room and ventilate it thoroughly for about 30 minutes.

Use protective gloves to prevent contact with mercury and other lamp
components. Carefully remove spilled mercury with a method that prevents the
generation of mercury vapor, such as a syringe, packing tape or paper.

Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container. Dispose of the container in accordance with applicable
regulations.
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First Aid for Working with Printing Materials

In general, try to avoid direct contact with uncured printing material. If skin or
eyes come into contact with it, wash the area immediately and thoroughly with
water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing
materials contains important safety information. Keep this in an accessible
place where these materials are used and stored.

Contact with Skin

If uncured printing material comes in contact with skin, wash the affected area
immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears, nose
and other parts of the body that are not easily cleaned.

> Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

> Do not use solvents to clean skin.

> |flarge areas of skin have been exposed, or if prolonged contact results in
blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

> Avoid the accidental transfer of printing material from the hands to other
areas of the body, especially to the eyes.

> |f protective cream was used, do not reapply it until the skin has been
completely cleansed.

Contact with Eyes

Ingestion

DOC-37004 Rev. J

If uncured printing material comes in contact with the eyes, flush immediately
with large amounts of water for 15 minutes and seek medical attention.

> Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation.

Wearing contact lenses when handling liquid printing materials is not
recommended. If the liquid splashes into the eyes when contact lenses are
worn, immediately remove the lenses and flush the eyes with water.

> Clean and disinfect the contaminated lenses.

> Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.
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Inhalation

Vapors from printing materials can be irritating to the respiratory system. If
respiratory irritation occurs, expose the victim to fresh airimmediately.

> |f the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

Seek medical attention immediately.

>

> Keep the victim warm but not hot.

> Never feed anything to an unconscious person.
>

Oxygen should be administered by authorized personnel only.

Waste Disposal

Fully cured 3D prints can be disposed of as ordinary office trash. However,
special care is required when handling printer waste (uncured printing
material).

Printing Materials

DOC-37004 Rev. J

> When removing the waste cartridge/container from the printer, wear
neoprene or nitrile gloves.

> To prevent liquid waste from splashing into the eyes, wear safety goggles.

> Liquid waste from the printer is classified as hazardous industrial waste.
Therefore, printing-material waste must be packaged and disposed of in a
manner that prevents human contact with it and contamination of water
sources.

> Empty model-material and support-material cartridges contain residue of
their contents. Some leakage of this residue may occur through the broken
cartridge seal. Therefore, handle and store empty cartridges with care.

> Do not attempt to reuse empty cartridges, and do not puncture them.

> Dispose of used cartridges and waste containers in accordance with local
regulations.

> Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.
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UV lamps used by the printer to cure printing materials contain a small amount
of mercury, and are considered “Universal Waste.” Recycle or discard used
lamps in accordance with applicable regulations.

Broken lamps:

After ventilating the area, use protective gloves and carefully remove spilled
mercury with a method that prevents the generation of mercury vapor, such as
a syringe, packing tape or paper. Place the broken lamp, mercury and
contaminated materials in an air-tight, non-metallic container. Dispose of the
container in accordance with applicable regulations.
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Welcome to Connex™ Printing

The advanced capabilities of Connex printing systems are made possible by
technology specially developed by Stratasys for producing 3D prints
simultaneously with different model materials. Printing 3D prints with
combinations of basic materials (digital materials) enables you to choose from
a wide range of mechanical properties—from flexible to rigid—and colors.

With Connex printers, you can achieve the following results for 3D prints:

* You can prepare 3D prints for production using two or three designated
model materials and then print them at the same time. This enables you to
assign specific mechanical and color properties to 3D prints.

* You can print parts of the same 3D print—simultaneously—uwith different
materials (or material combinations“).

* You can print objects that have a “coating” made from a different material
than the main part of the object.

Because Connex printers can be loaded with different materials, you can
streamline and economize the process of producing 3D prints:

* Producing 3D prints made from different materials on the same build tray
(“mixed tray”), in the same print job, eliminates the time-consuming need
and expense of loading another material, flushing the system, and sending
a separate job to be printed.

* You can quickly alternate printing jobs using the model materials loaded (or
material combinations)—again, without the need and expense of replacing
materials.

Print jobs can be set up and sent to the printer with either of these applications:

* Objet Studio

» GrabCAD Print (Connex3 printers only)
These applications are described in the following chapters.

Objet Studio enables you to split 3D prints into component parts (“shells”) so
you can isolate, manipulate and print parts of a model. Then, you can assign
model materials and other characteristics to the shells. However, you have
ultimate control when separating parts into shells by preparing st/ files with
your CAD software.

Files saved as VRML can be opened in Objet Studio. When you prepare them
for printing on Connex3 printers, parts are assigned appropriate material
combinations to produce the desired colors in the 3D print.

1Connex2 and Connex3 configurations only
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Work Configurations
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Objet260 3D printing systems can be set up as single-station systems or as
multi-station systems. When connected to a local computer network, the
system can serve multiple users. In such configurations, each user (client)
prepares files for production. A server, typically next to the printer, sends jobs
to the printer.

Figure 3-1 shows the printer set up in a multi-client configuration.

Clientworkstations

Printer s erver

WUl sadich . .
Printer workstation

Prirter

Figure 3-1 Multi-client network configuration

When jobs are sent to the printer, Job Manager, on the server computer,
arranges them according to their priorities, model-material type, and other
factors. In multi-workstation configurations, the operator of the server—
typically the production administrator—has total control over the jobs sent to
the printer, and can prioritize jobs, delete jobs, review job history and reprint
jobs.
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Source Files

STL Files

SLC Files

VRML Files
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Objet260 printing systems produce 3D prints designed with most CAD tools
and some other 3D applications.

Objet Studio supports these file formats:

£ STL
«SLC

* VRML
GrabCAD Print (for Connex3 printers) supports STL, VRML, OBJ and 3MF
files. In addition, GrabCAD Print supports native CAD formats from these
programs: Creo, SOLIDWORKS, NX, CATIA and Inventor. To see the
complete list of file formats supported by GrabCAD Print, go to:
help.grabcad.com/print/file-formats.

All Objet260 systems feature the capability of producing different types of files
simultaneously.

STL is short for STereoLithography or Standard Triangulation Language. This
language views any object as a collection of surfaces, and describes each
surface of the object as a collection of triangles.

For example, a square can be described as two triangles; a cube (six squares)
as 12 triangles. Curved surfaces need more triangles to describe them. The
higher the tolerance (for smooth surfaces), the more triangles are needed.

Most CAD software can export STL files. Objet Studio/GrabCAD Print opens
these files for printing on the printer.

SLC is short for Stereo-Lithography Contour. SLC files describe 2D contours of
the 3D prints. These contour lines are polylines.

SLC files are ASCII (text) files that save 3D print as a series of slices. This
means that 3D prints based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the 3D
print’s orientation must be suitable for production before it is saved as an SLC
file. Because of the nature of SLC files, the appearance of 3D prints in Objet
Studio may be different than the solid-object images displayed from STL files.

VRML is a 3D file format which includes color information. VRML provides the
ability to apply different colors to a 3D print while designing in a CAD program.
VRML is a 3D file format which includes color and texture information. VRML
provides the ability to apply different colors and textures to a 3D print while
designing in a CAD program.


http://help.grabcad.com/print/file-formats
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When you create a VRML file in a CAD program, two files are created: a wr/
file, containing the 3D print's geometric information, and a picture file (bmp,
png, jpg, or tiff), containing the 3D print's color information. When you create a
VRML file in most CAD programs, two files are created: a wrl file, containing
the 3D print's geometric information, including texture, and a picture file (bmp,
png, jpg, or tiff), containing the 3D print's color information. Before placing a
VRML file on the build tray, make sure that the VRML file and its corresponding
picture file are in the same folder.
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Printing Materials

Objet260 printers produce 3D prints by jetting thin layers of printing materials
on the build tray, until the complete 3D print is formed. Two types of material
are used in this process:

* Model material—which makes up the finished 3D print.

» Support material—which fills gaps and spaces in the part during printing,
and is removed after printing.

% For up-to-date information about PolyJet printing materials and their
properties, go to www.stratasys.com/materials/polyjet.

Storage

Materials used for producing 3D prints with Objet260 printers are made of
resins, which are composed of reactive monomers and oligomers. Although
printing materials are supplied in sealed, UV-proof cartridges, care must be
taken when storing and handling them. Follow these guidelines to protect
operators and the environment, and to ensure optimum results.

* To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances (such
as polystyrene or polyvinyl chloride) are not suitable for storing PolyJet
printing materials.

* When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

 Store material cartridges indoors, in a dry area with adequate ventilation,
between 15-27 degrees Celsius (59-81 degrees Fahrenheit). If exposed to
heat or flames, cartridges might burst or ignite.

* Signs of premature polymerization in material cartridges include bulging,
leaking, the emission of heat, and unusual odor. Exposure to heat can
cause resin to gel in the cartridges.

» Make sure that material cartridges are stored in accordance with all local
regulations and other applicable requirements.

Shelf Life

Materials used for producing 3D prints have a limited shelf life. The expiry date
on the label is valid when properly stored in an undamaged, unopened
cartridge. Always rotate your stock, so that the cartridge with the earliest date
is used first.

Exposure to Light

If printing materials are not in their sealed cartridges, make sure to shield them
from sunlight and other sources of UV radiation, such as fluorescent and
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mercury-vapor lights. Exposure to UV radiation causes an increase in viscosity
and, eventually, solidification.

Safety Considerations

Before being cured, resins are hazardous materials. To prevent possible
health hazards, follow these precautions regarding printing materials:

» Do not expose to flames, heat or sparks.
» Prevent contact with skin and eyes.

» Ventilate areas where they are handled.

» Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

%{ You can find more safety information about resins in:

e "Safety Guidelines" on page 2-5
¢ "First Aid for Working with Printing Materials" on page 2-8

Disposal

Dispose of cartridges of model and support material in accordance with all
applicable laws and regulations.

Work Environment

Extreme heat and humidity conditions can adversely affect the operation of
your Objet260 3D printer. Use ventilation or air-conditioning systems, if
necessary, to keep the work area within the following ranges:

+ 18°-25° C (64°—77°F)

* 30%—70% relative humidity

Workstation Requirements

Objet Studio Workstation

The requirements for client computers running Objet Studio are listed in the
Objet260 Site Preparation Guide. You can download this document from

stratasys.com.

GrabCAD Print Workstation

GrabCAD Print is an application for preparing and managing print jobs on

Stratasys Objet260-Connex3 printers (and on other supported 3D printers).
» To download GrabCAD Print, go to: help.grabcad.com/print/sign-up.

* If there are several users in your company, you need to set up a company.
To do this: help.grabcad.com/article/203-all-about-company-accounts
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* To see the requirements for client computers running GrabCAD Print, go to:
help.grabcad.com/print/system-requirements.

* In addition, GrabCAD PolyJet Job Manager is required on the server (host)
computer. This program controls the actual printing. To download it, go to:
help.grabcad.com/print/polyjet.
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Preparing Files for Use with PolyJet 3D Printing Systems

Before printing design files with the Objet260 printer, make sure that they are in
a file format supported by the applications you are using to send print jobs to
the printer—Objet Studio or GrabCAD Print. (See "Source Files" on page 3-4.)

Converting CAD Files to STL Format

This procedure may vary slightly, depending on the CAD software used, but
the following instructions generally apply.

To convert a file to STL format (in a CAD program):

1. From the File menu, select Save As.

2. Inthe Save As dialog box, open the Save As Type drop-down list and select
*STL.

3. Click Options and set the following parameters:

O Total Quality—approximately 0.01 mm (deviation tolerance / linear-
dimension tolerance)

O Detail Quality—approximately 5° (angle tolerance)

Note: Lowering these values produces more accurate 3D prints, but results
in larger files and longer loading and processing times. For this reason, it is
generally not recommended that you use lower values.

4. Inthe file format option, choose binary or ASCII. (Both binary and ASCII
formats can be used in Objet Studio. However, binary files are smaller, so
this option is recommended.)

5. Click OK or Save.

After converting the 3D print files, it is recommended that you check them for
defects before opening them in Objet Studio and producing the 3D print. You
can do this in GrabCAD Print or in a third-party STL-repair application (such as
Magics™, by Materialise®).

For more information, download From CAD to Objet Studio Workflow for
Connex Technology.

Converting CAD Files to WRL Format (VRML)
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You can save CAD designs as VRML files (WRL format) for printing. If you
assign RGB values to shells (parts) in the CAD design and then import the
VRML file in Objet Studio, Digital Materials that provide the best color match
are automatically assigned to the shells. The printer fabricates these Digital
Materials from the base materials loaded in the printer.

Objet Studio supports VRML 2 files (also known as VRML97 files).
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Converting CAD Files to SLC Format

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that 3D prints are properly orientated before being
saved as SLC files. Considerations for suitable orientation are explained in
"Manual Positioning" in Chapter 3 on page 5-31.

Software Applications for Preparing Print Jobs

Both Objet Studio and GrabCAD Print (for Connex3 printers) offer you a wide
variety of file-preparation options that follow this basic procedure:

1. Defining the materials you want to use on the build tray
2. Inserting one or more objects on the build tray

3. Positioning the object(s) on the build tray

4. Configuring object and tray parameters
5

. Sending the file to a 3D printer for production

Objet Studio
Objet Studio is an application for preparing print jobs on Stratasys 3D printing
systems. It consists of two main screens:
+ Studio
» Manager
In the Studio screen, you prepare source files for production in the printer.
Using Objet Studio to perform these tasks is described in detail in Chapter 5,
"Using Objet Studio".
The Manager screen displays the queue and status for all jobs sent to the 3D
printer.
GrabCAD Print

GrabCAD Print is an application for preparing print jobs on a variety of 3D
printers, including the Stratasys Objet260 Connex3 printer. These are the main
features of GrabCAD Print:

» The same application prepares jobs for printing on multiple platforms,
including Stratatsys PolyJet and FDM printers (for supported printers, go to:
help.grabcad.com/print/printers).

» Support for many CAD file formats (see supported formats at
help.grabcad.com/print/file-formats).

» Automatic repair of 3D files.

» Scheduling and monitoring of multiple printers and print jobs, from local and
remote computers and from mobile devices.

* Intuitive design and ease of use.

DOC-37004 Rev. J 3-10


http://help.grabcad.com/print/printers
http://help.grabcad.com/print/file-formats

Objet260 User Guide 3 Introducing the 3D Printer

Workflows

With Objet260 printing systems, you have great flexibility in preparing files and
printing them. Below are the major workflows available.

Stage Workflow A Workflow B Workflow C

CAD program* » Design a 3D object. » Design a 3D object. » Design a 3D object.
e + Saveitasasingle st/ + Saveitasanassembly <« Apply colors to parts
i T file. of stlfiles. (Connex3 only).

» Save the objectas a

- % VRML/wri file.

Objet Studio / * Open (Insert) the stl * Open (Insert) the stl * Open (Insert) an objdf
GrabCAD Print* file. files as an assembly. file (Objet Studio).
e ¢ Separate the object + Assign materials to the (objdf files contain
- into its components assembly’s model-material
: (“shells”). components. information.)
ES  Assign materials to the » Open (Insert) a
components. VRML/wrl file.

(wrl files contain
model-material and
color information.)

«Save the object as an objdffile (Objet Studio,
optional).

«Save the build tray. / Send the build to the printer.

Objet260 Printer

Models are produced in the printer.

«Remove the Support material from the models

Finished model

Finished model.

3D printing workflows, from design to finished models

* In addition to the options shown, GrabCAD Print supports most native CAD file formats.
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How to Install Objet Studio

Objet Studio software is installed during printer installation. This section is
provided in case you need to reinstall Objet Studio, or install it on a remote
(client) computer.

The Objet Studio setup wizard guides you when installing this software. Objet
Studio is installed on the printer-server (“host”) computer, but it can also be
installed on remote, “client” computers and on computers used to prepare files
for printing, or for training and demonstration purposes. During installation, you
choose to install either the printer-server (“host”) application or the client
application.

To install Objet Studio software:

1. Connect the USB flash drive (supplied with the printer) to a USB port.

2. On the USB flash drive navigate to the Objet Studio installation file, and run
it.

3. Toinstall Objet Studio, you must agree to the license agreement. After
reading its terms, click Yes to continue, or No to close the wizard.

If you click Yes, the following screen should appear.

ObjetStudio - InstallShield Wizard X

Please note...

15 of the printer software:

er thiz Objet Studio installation.

Figure 4-1 Objet Studio compatibility check

4. Make sure that your printer is compatible with Objet Studio by checking the
list displayed.

Note: The printers displayed are legacy printers that are not compatible
with this version of Objet Studio.
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5.

In the Installation type screen, select the required installation option.

Select Objet Studio for a Server computer—

3 if you are installing Objet Studio on the server (“host”) computer—the
computer directly connected to an Objet260 printer.

O if you are installing Objet Studio on a standalone (offline) computer.

Select Objet Studio for Client workstations if you are installing Objet
Studio on a “client” workstation—a remote computer that prepares print
jobs and then sends them to a server computer.

ObjetStudio - InstallShield Wizard X

Installation type

Figure 4-2 Objet Studio configuration selection
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6. Inthe Choose Destination Location screen, verify the destination folder and
click Next.

ObjetStudio - InstallShield Wizard X

Figure 4-3 Objet Studio installation-folder selection

%( It is recommended that you do not change the default destination folder.

7. Inthe Select Printer Type screen, select the 3D printer and click Next.

ObjetStudio - InstallShield Wizard X

Select Printer Type

Obijet260 Connex
Connex350
Cornexa00

Obiet1000 Connexe

Figure 4-4 Printer selection
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8. When the following screen appears, click Install to begin installation.

ObjetStudio - InstallShield Wizard it

Ready to Install the Program
Th

Figure 4-5 Ready to Install screen

After clicking Install, a progress bar shows the progress of the installation
process.

ObjetStudio - InstallShield Wizard X

Setup Status

Cancel

Figure 4-6 Installation progress bar
%( Objet Studio requires that Microsoft® DirectX® is installed on the computer.

If necessary, an installation screen for this program will appear. To continue
with Objet Studio installation, accept the DirectX agreement.
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When installation is complete, the final InstallShield wizard screen appears.

ObjetStudio - InstallShield Wizard

InstallShield Wizard Complete

installed DbjetStudio.

Figure 4-7 Final installation screen

9. To complete the software installation, click Finish.
The installation process ends when the appropriate icon(s) appear on the
computer desktop:

* Objet Studio
« Stop Job Manager (for servers and standalone stations)

How to Uninstall Objet Studio

If there is ever a need to uninstall the Objet Studio software, do not attempt to
do so from the Windows Control Panel. (This does not completely remove all

software components.) Instead—
> From the Start menu, select All Programs > Stratasys > Uninstall Objet
Studio.
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Launching Objet Studio

"-».; -

)

After you install Objet Studio, a launch icon él“ appears on the Windows
desktop. Open the application by double-clicking this icon, or by selecting
Objet Studio from the Start menu.

Objet Studio Interface

When Objet Studio opens, the Tray Settings screen appears, showing an
empty build tray.

— '\Help
\jﬂnd ard toolbar
ctive ribbon

JobManager tab

Objet Studio Commands ITIEI'IL/U = o

——er

Quick Access toolbar

Model Tree pane/

Figure 5-1 Objet Studio opening screen
The Objet Studio interface consists of two main screens:

» Tray Settings—for arranging models and preparing them for printing.

» Job Manager—for monitoring and managing print jobs.

This screen is described in "Monitoring and Managing Print Jobs" on
page 5-80.

Each screen is controlled by menus and icons on its own ribbon. An additional
ribbon, Model Settings, displays controls for configuring and manipulating
selected models.

Objet Studio anticipates your workflow by displaying and enabling the options
relevant to your current task. For example, when you first open Objet Studio,
the Model Settings ribbon is disabled until you place a model on the build tray.
Similarly, options available from the standard toolbar menus are enabled or
disabled to match the current workflow.
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The ribbon, colors used, and several other interface features can be
customized. How to change the appearance of the interface is explained in

"Customizing Objet Studio" on page 5-67.

Instructions for using the commands for preparing models for production
and sending jobs to the printer, appear later in this chapter.

=onen x|

Connex3, Loaded materials: VeroGrey, VeroWhite, VeroBlack

e 2 &
O, Psh): Objet Studio: Objet
- Arrange Tray Job Manager Edit ~ View - Object ~ Jools ~ Style ~ (@ -
. y o & - . . e - i
‘%ﬁ 7 &2 3 % {%J ,& @ @ J\ { ﬂ Q @ %8 I@ VeroGrey single Material
Insert || Placement Validate Estimate Build Select New Open Save || Undo Redo single Zoom Isometric By Legend | VeroWhite T ¥ Multiple Materials
Element ~ View ~ Tray~ - Material = VeroBlack -
Select File Edit View Color Tray Materials

Madel Tray

Figure 5-2 Tray Settings ribbon

= 4

Objet Studio: Objet500 Connex3 =
Edit - Wiew ~ Object = Tools - Style - IQ) -

O\\ 'tl & '::‘ @ v Wrench Key
=

= Tray Settings Model Settings Job Manager
) ' ; ; i Wi (155,90 mm
_°° » %%‘ \WA w«" @ |:| Q @ _ = 9 \_‘j % ; ;
"l £ Select Move Transform Lock Single Zoom Isometric || ¥ 4966 HMillimeter Matte |Glossy Advanced | Multiple | Colors
. Element = Wigw ~ Tray = - 7. 10,20 “ Materials ~ -
Edit Selection Manipulate Wigw Dimensions {rnm) Lnits Options

Figure 5-3 Model Settings ribbon
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Ribbon Commands

The following table lists the Tray Settings and Model Settings ribbon command
groups, and shows when they are enabled, and where they appear.

Insert

Model

the build tray.

Group Purpose When enabled | Tray Model
Settings | Settings
Ribbon | Ribbon
e = Setting display colors. Always.
Matfgial' e ’/ ’/
B © Selecting perspective Models are on
e and zoom level. the build tray. ’/ ’/
;m Choose to selecta Models are on
s plane, elements, or the build tray. J J
o element groups
. (assemblies).
(Y Change the perspective | Models are on
Tsometric of the active pane. the build tray. J J
p=l
=0
b= L
£
b=
e Assigning printing Build tray is
ru materials. empty. J
Models are not
selected.
Vs Undoing or redoing After an action or
i actions. object selection. J J
388 ]Ei)lzznmg and saving zﬂec?:j:dare not J
New Open Save . .
File
% Placing model files on Always.
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Group

Purpose

When enabled

Tray Model
Settings | Settings
Ribbon | Ribbon

. w &
¢ ¥ 99

Pre-build/build

Models are on

Placement. Validate Estimate Buld commands. the build tray. ’/
% [3.60 %) Uniform Scale Setting model A model is
iff | R0 dimensions. selected.
2101 J
Dimensions {rmm)
K3 _-_-.’c‘1 Cutting, copying, pasting | A model is
EEsERiE and deleting models. selected. J
Ed
¥ W, -.l‘-'!' Moving, rotating and A modelis
T resizing models. selected. J
" " « Assigning a material | A model is
— to a model or shell. | selected. J
B « Separating a model
into shells.
DS % ASS|gn|r?g model finish | Amodelis
R ciossy Advanced and setting support selected. J
strength/“hollow.”
mm Setting a model’'s unitof | A modelis
- measure (millimeters or | selected. J

inches).

% To quickly identify an icon, move the cursor over it to display a tooltip. The “Undo” and

“Redo” tooltips change to reflect your last Objet Studio action.

%Z\ After activating some of the ribbon commands (by clicking them), they remain active
until you click another button or until you press the Escape key.

DOC-37004 Rev. J
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Objet Studio Commands Menu

DOC-37004 Rev. J

Clicking the © iconinthe upper-left corner opens the Objet Studio
Commands menu. This menu displays basic application commands and

options.

A\ Bess):

\é Hew Recent trays
- 1 tesbangn
&g Open...
| 2 Traydd
&é Savea
3 CAProgram Fiesh. . \Tray33
% Save As

@ Save BEmap... CirHE
B8 onort packed Job...
@. Expart Packed Job...
@, Build Properbes. ..

-
KE User Preferences...

{& Printer Properties...

Restart

4 Ci\Program Flest., \Trayl

o= |

Figure 5-4 Objet Studio Commands menu
The Options button opens a dialog box for customizing Objet Studio.

]

Options

Automatic Placement

Automatic Lay On [Gravily)
O Never

() Always
(O When under the lray

Latge Files

(=) Load Full
() Load Pattial reduced)

Load Search Order
) Local
() Driginal

| Appearanice || Grid | Manipulate | Display | Settinge

Quick Automabc Placement after adding new object
Pigserve 1 mm  distance betwesn objacts

l ok I[ Cancel ] Apply

Figure 5-5 Options dialog box
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Model Tree Pane

The Model Tree pane lists the objects placed on the build tray in a parent-child
hierarchy. By default, the pane “floats”— that is, you can move it to another
position on the screen and resize it. Alternatively, you can fix its position at the
left of the application window, and even hide it.

Assigning Properties to Hidden Objects

To enable you to assign materials and other properties to parts of objects that
are hidden from view on the build tray display, you can temporarily turn off the
display of some objects.

To prevent the display of objects:

1. Right-click an object, either on the build tray or in the model tree.

2. From the menu that opens, select one of the following options—
O Hide, to cause the selected object to disappear.

[ Hide Others, to cause all other objects on the build tray to disappear,
so that only the selected object is displayed.

Alternately, you can clear the check box next to the name of the object
in the model tree to cause that object to disappear.

|
Figure 5-6  Left: All objects displayed; Right: Display with object hidden
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Preparing Models for Production

Model preparation involves the following basic steps:

1. Place objects or assemblies on the build tray.
2. If necessary, manipulate the object’s orientation and position.

3. Select the materials and model finish.

Just as Objet260 printers can produce different models on the build tray using
different materials, you can produce components of a model with different
materials. To do this, each part of the model must be a separate st/ file.

If the model’s component parts were not saved in the CAD software as
separate st/ files, you can use Objet Studio to separate the model into
component parts. (This is described in "Splitting Objects into Components" on
page 5-21 and in "Dividing Objects" on page 5-61.)

OBJDF Files: Overview

An objdffile describes both the geometry of a single object and the materials,
and finish required to print it. The objdf file can represent an object thatis a
single st/ file, or an object assembled from component st/ files.

Objet Studio enables you to split an st/ file representing a complex object into
an assembly of component st/ files, and save the assembly as an objdffile.
Each part (stl file) described by the objdffile can have its own model-material
characteristic, so that the Objet260 printer produces the component parts from
specific materials.

Another use for objdffiles is for saving a group of separate objects on the build
tray as one unit, together with their relative positions and materials. This is
especially useful for producing models in the future with the same materials. In
fact, when you save objdffiles, you specify materials for printing models
without regard to the material cartridges loaded in the printer. The same object
can later be placed on build trays for printing. Each time you send a build tray
to the printer, you decide whether to allow printing with substitute materials or
only with the materials specified.

The Connex version of Objet Studio enables you to display, manipulate and
print component parts of a model assembly that was saved as an objdffile,
since each component is a separate st/ file. This can be useful for printing only
specific parts of a model.

Further explanations of objdffiles and assemblies, and their features, appear
throughout this chapter.

Model Files

To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in
several ways:

* by inserting individual st/ files (or an assembly of st/files).

* by inserting an objdf file (an assembly).
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* by pasting objects that you copied to the Windows clipboard.

Placing Objects on the Build Tray

To place an object on the build tray:

1. Open the Insert dialog box—
O From the Object menu, select Insert.

or—
[ Onthe Tray Settings ribbon, click Insert )
or—

O Right-click on the build tray, and select Insert from the context menu.
The Insert dialog box appears.

Look in: | 2 Samples w €) S v E"
N |_T)Basic Shapes
! :3 | )Chess

My Recent IS)Connex Samples
Dacuments |5 Connes_Samples

F |)Eden_alaris_Samples
L_'% [ChImages
Desktop [ sample file

IC235LC Files
. |05 TL Files
.J | Texkah
My Documents QTrayl y
W) sample file
-
5
My Computer
‘h‘] File name: zample file hd
N
by Netwark Files of type: STL Files [* 5H) v
Units: Millibd eter v [ Azsembly
Mumber of Copies: |1 s [O0nent Automaticaly
Coordinates

Width (%) Depth [v]  Height [£]
Extents 229 502318 229

Previewm

Figure 5-7 Insert dialog box
2. Inthe Look infield, display the appropriate folder.
3. Inthe Files of type field, select the file type to display.

4. Select the desired file, and make sure that it appears in the File name field.

If the Preview check box is selected, the object is displayed in the dialog
box, as shown in Figure 5-7.

Note: When selecting a VRML (wr/) file, the object is displayed in the
dialog box only if there is an equivalent bmp file in the same folder.
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Therefore, when saving VRML files in a CAD program, a bmp file of the
assembly should be saved.

You can open several stlfiles (and VRML files) to place several models on
the build tray. If you select multiple st/ files that make up an assembly, you
can select all or some of the parts. To print the entire model, select all of an
assembly’s component st/ files, and select the Assembly check box. This
positions the parts as a complete, integrated model instead of as
independent parts. The effects of selecting the Assembly check box—in
both the model tree and the build tray display—are shown in the following
figures.

mavicd Tree

Figure 5-8 Assembly check box selected—st/ files are placed as an
assembly

T

il

Figure 5-9 Assembly check box not selected—st/ files are placed as
parts

The Model Settings ribbon is displayed when objects are placed on the
build tray.
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5. Select any of the following options, as required:

3 Units—Millimeters or inches for the object’s units of measure.

The 3D file contains the object's proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters or
inches when inserting an object. Otherwise, the size of the object on
the build tray will be either much too large or much too small. To change
the measurement units of objects already placed on the tray, see
"Measurement Units" on page 5-36.

O Number of copies—How many copies of this object to place on the
build tray.

[ Orient Automatically—Automatically orient objects on the build tray
for efficient model building.

[ Assembly—Mark this check box if you selected multiple st/ files that are
part of an assembly.

Note: The Extents values displayed in the Coordinates section of the
Insert dialog box, represent the maximum dimensions of the object on each
axis. These dimensions correspond to the virtual “bounding box”
surrounding the object see Figure 5-51 on page 5-45).

. Click Insert.

Objet Studio places the object on the build tray, and in the model tree.

@ TRoy v e Lo DBet aane: Comnes L
o e el el E D - P - ek -
*v B % 8cmn BRI K e ® 3 o w8
G P G e fewew @O " ﬁ‘ B e arcanl ,k,__., S e iwa m Legand
el - . e} s

. et Mg ete = s Ao g M e

IModel Tree

aAR Ll o B pane

Pl T
I -E=
-

Figure 5-10 Default screen layout

The Model Settings ribbon is displayed when objects are placed on the
build tray.
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If the object is over a certain size, the Loading Placed Elements dialog box

appears.
Loading Placed Elements E|
tadel Mame |\ AGRendsrBinhTrayl . objtf

[ )

Flaced Element  |C:h... Stestbuild.objdf

[ ]

- |
Figure 5-11 Loading Placed Elements dialog box

You can speed up the opening of large files by changing the Large Files
settings—see "Loading Large Files" on page 5-50.
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Opening objdf Files

Before placing objdf files on the build tray, Objet Studio must extract the
component st/ files together with information about their relative position and
model materials. To do this, Objet Studio creates a folder with the same name
as the objdffile, in the same location.

%{ If you are opening an objdffile, the Insert dialog box also includes a
Materials field that shows the object’s printing material assignment (see

below).
Insert @E|
Loak in: | I3 Samples v ) ] -
Y |5) Basic Shapes
:3 ) Chess
My Recent |51 Connex Samples
Documents |25 Connesx_Samples
= | ) Eden_alaris_Samples
I Images
Desktop |) sample file
|31 5LC Files
: IC2)5TL Files
.-—./' |0 Texkal
I Trawvl
My D 1
v Documents ﬂ:.
-
s
tdy Computer
‘;'] File name: Trapl
]
My Natwork | Files of type: Objst Digital Files [ obidf)
Urikg: Millitd eter hd
Mumber of Copies : |1 Es E] [ Orient Automaticaly
Coordinates
Width [%] Depth[¥] Height [Z]
E stents
M aterials
Packed szsembly File
Yerowhite
Preview
Figure 5-12 Insert dialog box (objdffile)

QE{ A warning message appears if a part is defined with materials not supported
by your system, or if an object already on the build tray uses different
materials. (If this happens, see "Model-Material Settings" on page 5-22 for
printing options.)
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Opening Objet Tray Files

You can open trays that were saved as objtffiles. (Saving objtffiles is
described in "Saving Build Trays" on page 5-65).

To place an object saved as an Objet Tray File (objtf) file on the build
tray:

1.

-1

From the File group, click apen.
or—

From the Objet Studio Commands menu © , select Open.

The Open dialog box is displayed.

Open @El
Laok in: | I Basic Shapes v Q il
Y (5 e
> omm

tdy Recent
Documents

Deskiop

tdy Documents

-
0L
tdy Computer
‘,} File name: Trapl b
2
My Network | Files of ype: Objet Tray Files [*.obitf] ~

Coordinates

Preview

Figure 5-13 Objet Tray File Open dialog box

Select the desired file, and make sure that it appears in the File name field.
If the Preview check box is selected, the object is displayed.

Click Open.
Objet Studio opens the tray file.

%{ The objtffile is actually a file containing instructions for printing—which st/

DOC-37004 Rev. J

files to print and their position on the build tray. Because the objtffile
references the st files used, they must remain in the same file location as
when the objtf file was saved.
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STL file loading preference

If there are identically named st/ files in more than one location, you need to
ensure that the correct component st/ files are linked to the objtffile. For
example, if there are identically named st/ files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you can
set the default location from which files are loaded.

To set the Load Order:

1. From the Tools menu, select Options.
or—

In the Objet Studio Commands menu © , click Options.

2. Inthe Options dialog box, display the Settings tab.

Options §|

Appearance || Gid | Manipulate | Display | Settings
Autornatic: Placement

[uick sutomatic: Placement after adding new object

Preserve 1 mm  distance between objects

Autornatic Lay On [Grawvity]
() Mever

(#) Always
() wihen under the tray

Large Files

(¥ Load Full
(" Load Partial

oad Search Order
() Local
(#) Original

I ak. H Cancel l

Figure 5-14 Options dialog box, Settings tab

3. Under Load Search Order, select an option:
O Local—to load files from the location where they were last saved.
[ Original—to load files in their original location.

4. Click OK.
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Quick-Access Model Commands

Model Toolbar

You can access common commands for working with objects on the build tray
with the convenient Model Toolbar and context menus.

Select an object in the tray to display the Model Toolbar that contains icons to

perform common tasks.

QDK WG

FullCure7 20

@

Figure 5-15 Model Toolbar
The table below describes the Model Toolbar icons.

Icon Description

- Applies a matte finish to the model.

7 Applies a glossy finish to the model.

&y Opens the Advanced Properties dialog box for setting the

Grid Style and the Hollow option.

xf-:'*'- Enables dragging an object (see page 5-38).
D

N | Opens the Transform dialog box for changing the object’s
4 position and scale.

iy Toggles the Lock Model Orientation setting.

TangoBlack+

Allows you to choose the printing materials.

™

Enables you to apply a coating to the model, or change the
coating previously applied.

Right-click model menu

If you right-click on an object, a pop-up context menu is displayed from which

you can also select the model finish, change its position and scale, and set the

Grid Style and Hollow options.

% You can also create a Quick Access toolbar with your most commonly used
icons grouped together. See "Creating a Quick Access Toolbar" on page 5-

DOC-37004 Rev. J

67.

5-18



Objet260 User Guide 5 Using Objet Studio

Selecting Objects

To manipulate an object on the build tray or assign characteristics to it (model
material, building style etc.), you must first select the object. You select an
object by clicking it, either on the tray or in the model tree. Its image on the
build tray changes color (to light blue, by default) and its name is highlighted in
the model tree. You can select multiple objects by drawing a box around them
with the mouse cursor, or by pressing the Ctrl or Shift keys while clicking
additional objects.

Alternatively, select or de-select objects using the following Edit menu
commands:

» Select All
* Invert Selection

» Undo Select object

Edit - Miew = Object -

A Undo Select object

Select Al

Inverk Selection

Figure 5-16 Editmenu

Sometimes, you need to select individual elements of an assembly. Other
times, you need to select the entire assembly. The Selection icon displayed on
the ribbon determines what will be selected when you click on the model:

L2 ™Y

Select Select
Element = Group -

Selection Qr | Selction

To change the selection action:

1. On the Tray Settings or Model Settings ribbon—

a. Click the Selection icon: or = . :
b. On the flyout toolbar, click the appropriate icon:

LT
Eth'l_ Select Element

%'}-)7 Select Group

n
Figure 5-17 Selection flyout toolbar
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Copying and Pasting Objects

If you need to duplicate objects on the build tray, you can insert the same
object from its file more than once. An easier way, however, is to copy and
paste the object. You can copy objects from the build tray or the model tree—
individual or multiple parts or assemblies. The objects copied remain in the
Windows clipboard until you paste them onto the build tray.

You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another one.
However, Objet Studio allows only one tray to be open at a time. For each build
tray you need to work with (at the same time), you must open a separate Objet
Studio window, by running the application again (from the Windows Start
menu).

%{ Having multiple Objet Studio windows open can be convenient when you
need to manipulate or configure objects before inserting them in your
production build tray. For example, if you need to change the model
material of an object saved as an objdffile to match the model material
already used in the production build tray, you must do so on another tray
before inserting the object. Copying and pasting also allows you to use
objects already configured on previously-used build trays for newer
projects.

You perform the Copy and Paste commands as in other Windows applications:

+ from the right-click context menu.

* by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).
The Paste Special command (from the object’s right-click context menu)

enables you to place duplicate objects even more efficiently:
* You can specify the number of duplicates to place on the build tray at once.
* You can set the distance, on each axis, between the duplicate objects.

* You can manipulate mirror images of the original object, and flip them on
selected axes.

Paste Special E]

Mumber of Copies -
Delta
w100 Y100 Z |0 M

bl anipulate

Mirrar =AY |dz
Flip [l Cly [z

[] 5ave as Defaults [ (] l [ Cancel

Figure 5-18 Paste Special dialog box
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Surface Finish

Models can be printed with a matte or glossy surface finish. To create a matte
finish, the printer surrounds models with a thin layer of support material.

To set the model finish:
1. Select the model.

2. Select Matte @ or Glossy «" in one of the following places:
[ Model Settings ribbon, Options group
(J Model Toolbar

O right-click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects’ surface finish
on the build tray by color. To configure how Objet Studio displays objects, see
"Setting Object Colors" on page 5-49.

Splitting Objects into Components

You can convert a complex object to an assembly of component parts. To do
so, you split the st/ file that represents the object into a group of separate st/
files, each one representing a component. (This is referred to in the Objet
Studio interface as separating the object into shells.) You can then assign a
model material to each st/ file, and you can save the newly-created assembly
as an objdffile.

To split an object into an assembly of component parts:

1. Ifthe objectis not displayed, place it on the build tray by inserting its st/ file
(see "Placing Objects on the Build Tray" on page 5-11).

The object appears—on the build tray and in the model tree pane—as a
single part. It is assigned, by default, the “primary” model material. (If Objet
Studio is configured with a secondary material, you can assign it—or a
digital material—to the entire object. This is explained in "Model-Material
Settings" on the next page.)

Figure 5-19 Object placed on the build tray from a single st/ file

Note: There is no need to resize or arrange the object on the build tray at this
time.
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2. With the object selected:
O From the Object menu, select Separate into Shells.

or—

Separake ko Shells

3 On the ribbon, click .

A dialog box opens in which you can specify where to save the component
stl files. (By default, Objet Studio offers to save the new files in a folder in
the same location as the original st/ file.)

Separate to Shells

Save to Folder: u"-.Eiarn lez%5TL Files\dpplications - wiench H.r:I..

| ok | [ Cancel

Figure 5-20 Folder selection for saving stl files after splitting into shells

3. Click OK.

Objet Studio splits the object into an assembly of component parts, each a
separate st/ file (“shell”).

The object appears—on the build tray and in the model tree—as an
assembly of parts (“shells”). You can assign each part a different model
material (This is explained in "Model-Material Settings" below).

Figure 5-21 Object after being converted to an assembly of component
parts

Model-Material Settings

Before placing objects on the build tray in Objet Studio, you should pay
attention to the material selection settings on the Tray Settings ribbon.

VeroBlack * | Support FullCure70: -
Verowhite x single Material
FullCure7 20 = ' Multiple Materials

Tray Materials

Figure 5-22 Material selection settings
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* By default, the material selection settings on the ribbon correspond to the
three Model cartridges loaded in the printer.

* The materials displayed are basic model materials. With Connex2 and
Connex3 printers, these materials can be combined to create digital
materials (see "Digital Materials" on page 5-25).

The material displayed on the top (VeroBlack, in the figure above) is
considered the primary model material (“Model-1”). It is assigned to objects
that do not have a material assignment when you place them on the build
tray. For example, since st/ files do not contain information about the model
material, Objet Studio assigns the primary model material to them. Also, if
you try to insert objdf files whose assigned materials are not recognized by
your version of Objet Studio, you can insert the file by substituting the
primary model material for the missing materials.

Select Single Material if you want to print using only one material—all of
the material drop-down menus contain the same material. If you decide to
print with multiple materials, the material in the top drop-down menu
remains assigned to the object until you select another material.

If you insert an objdf file into an empty build tray, and the model-material
assignment does not match the settings on the Tray Settings ribbon, these
settings are changed automatically. However, if there is an object already
on the build tray whose materials do not match the material assignment in
the objdffile, you cannot place the new object on the tray. To print this
object, you have the following options:

O Instead of printing it on the same build tray, print the new object as a
separate job.

O Change the materials assigned to objects on the build tray to match
those assigned to the new object (see "Changing the Model Material" on
the next page and "Assigning a Model Material to Objects" on page 5-
26).

O Change the materials assigned to the new object before inserting it, so
there is no conflict with the settings on the Tray Settings ribbon.

To change the materials assigned to an object before inserting it:

1.

Open another Objet Studio window, by running the application from the
Windows Start menu.

Insert the new object (objdffile) into the empty build tray.

Change the material selection settings on the Tray Settings ribbon to those
used on the other build tray.

Assign materials to the object (see "Assigning a Model Material to Objects"
on page 5-26).

Select the object and copy it.

Display the other Objet Studio window, and paste the object onto the build
tray.

Note: You can save the object with the new materials either as a new objdffile,
or by saving the original file with the changes.
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Changing the Model Material

When you design a build tray in Objet Studio, you can use model materials that
might not be currently installed in the printer. Because the installed materials
are displayed by default, change the material selection settings on the Tray
Settings ribbon, if necessary.

Ve aid ey - Sifighe BAME i

veraWhine ¥ o Rbuttpie Materadi

D Tangoarey
. WeroBi
D VeroBlue
[ verociear
[0 verocrey
|:| Vero\White

Figure 5-23 Selecting a new model material

Changing the Support Material

To change the type of Support material:

1. Inthe printer application, run the Material Replacement Wizard (see
"Changing the Printing Material" on page 6-13).

2. In Objet Studio:
3 When changing to SUP706, the recommended Grid Style is "Lite."

Note: Cleaning models printed with Standard or Heavy grid style can
clog the filter in DT3 and CSIIP cleaning stations. If necessary, clean
these models with a WaterJet cleaning station.

O When changing to SUP705, the recommended Grid Style is "Standard."

% You can override the default grid style settings for the current print job in the
Advanced Properties dialog box (see "Choosing the Support Strength" on
page 5-62).

You can set the default grid style in the User Preferences dialog box (see
"Setting User Preferences" on page 5-72).

When you send a print job to the printer, the new Support material appears in
the Available Resources section of the Job Manager screen.
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Available Resources -

SUPZ06 /] VeroGrey /| VeroWhite 4 VeroBlack /]

ibgram] | | (6 gram)

Figure 5-24 Available Resources in Job Manager

Digital Materials

When different model materials appear on the ribbon, you can produce objects
from any of them or from a combination of them—digital materials. Different
combinations of model materials enable you to print objects with a wide range
of color and mechanical characteristics.

To view the digital materials available for printing objects (using three basic
model materials):

1. Make sure that you have selected the appropriate model materials, and that
Multiple Materials is selected.

VeroCyan Sangle Matenal

Werohignk o MuRiphe Matenals

VeroWhite
D""“T s | VeroWhite, VeroBladk
W verccian

[0 veraGrey

W ercnagnt

I:I'.'tm'l.'\"rutr

[T wersrenow

Figure 5-25 Material selection with three basic model materials
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2. Click ‘=,

The Material Selection Guide appears, showing the basic model materials
and the digital materials available (combinations of them).

Material Selection Guide 3]

I:IVeroWhile [General Purpose: High Dimensional Stabiliy, HDT 43C)

I:I Dh_8505_Grey20 [High Rigidity, Impact 25 J/m, Elongation at Break 15%-25%)
I:I DM_8510_Grey25 (High Rigidity, Impact 25 J/m, Elongation at Break 15%-25%)
I:l DM_B515_Grey325 (High Rigidity, Impact 25 .J/m, Elongation at Break 15%-25%)
I:I Dh_8520_Grey40 (High Rigidity, Impact 25 J/m, Elongation at Break 15%-25%)
I:I DM_8525_GreyS0 (Balanced Rigidity, Impact 25 J/m, Elongation at Break 20%-30%)
I:I Dh_8530_GreyE0 (PP-like. Impact 30.J/m, Elongation at Break 25%-35%)
- DM_9895_ShoreS5 [Rubber-ike, Shore 495, Elongation at Break 507%)

- DM_9885 ShoreB5 [Rubber-ike, Share 485, Elongation at Break B0%)

- DM_9870_Shore?0 [Rubber-ike, Shore 470, Elongation at Break 75%)

- DM_9860_ShoreB0 [Rubber-ike, Shore 460, Elongation at Break 80%)

- DM_9850_5horeB0 [Rubber-ike, Shore 450, Elongation at Break 105%)

- Dt_9840 Shored [Rubber-ike, Shore 440, Elongation at Break 125%)

I 7 orgoBlack+ (Rubberlike, Shore 427, Elongation ot Break 218%)

Figure 5-26 Material Selection Guide, showing the digital materials
available with the basic model materials

Assigning a Model Material to Objects

You can assign any of the available materials to objects on the build tray.

To assign a model material to objects:

1. Select an object on the build tray (see "Selecting Objects" on page 5-19).

When an object is selected, its properties—including model materials—are
displayed on the Model Toolbar and on the ribbon.

E @ x i @

Ribbon

Mllmeter | [Matte|Ghssy Advanced pﬂm Saparate bo Shels
Rt Lt

@D DKW E
@

Ver oWt

Model Toolbar

Figure 5-27 Object properties, on ribbon and Model Toolbar

2. Display the material drop-down list and select the desired material.

veroilack

W ek
[ verawmie
O verosrey

Figure 5-28 Menu for assigning materials to objects

When you de-select the object on the build tray, it is displayed, by default,
with the color of the material you selected. In the same way, you can assign
model materials to each of the independent objects on the build tray.
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To separate an object into independent, component parts (each an st/ file),
see "Splitting Objects into Components" on page 5-21.

Color Selection

You can assign materials to models using a color palette if certain
combinations of materials are available.

RGO-CMWOLE0M = G

L
ROGIE-CM -0 T
Strong Reddish Purple

Figure 5-29 Color palette

To change the material selection method—color palette or material list:

> From the Tools menu, select Color material selection.

Edit = View = Object 'WS‘.:’M I
Grid
Snap to Gid
Conpiemints Settangi

Placement Wakdation

LI 1

Automatic Placement
Sechion

Flane dlignment ¥
Profeitionsl Made
Axsembly Mag .
Langusge

Ciptions.

Select from Bt Color matensl selection ®

V' Select from color palette

Figure 5-30 Setting the color material selection method
Coating Objects

You can print composite models where the surface layer is a different material
than the inside. This can be useful to achieve unique mechanical and textural
characteristics. This technique is called “coating.”

To coat an object with a different model material:

1. Select an object on the build tray.

2. Onthe Model Toolbar or the Model Settings ribbon, click G.
The Coat with dialog box opens.
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3. Select Coat With and, from the drop-down list, select the coating material.

[“)Coat With: | FullCure720 w

Thickness: 1 mim

I Apply l [ Cancel

Figure 5-31 Coating material selected

4. Inthe Thickness field, enter a coating thickness between 0.3 and 3
millimeters.

Note: The coating thickness does not affect the external dimensions of the
object, which remain unchanged. The coating layer replaces part of the main
model material.

5. Click Apply.

Note: When you de-select objects, they are displayed, by default, with colors
representing the model-material. Even after adding a coating to an object, its
color remains that of the main material, not the color of the coating material.

To inspect, modify or remove the coating applied to an object:

1. On the Model Toolbar or the Model Settings ribbon, click ¢ .
The Coat with dialog box opens.

2. Perform one of the following actions—
O Change the coating settings, and click Apply.
[ Toremove the coating, clear the Coat With check box and click Apply.
O To keep the current coating settings, click Apply or Cancel.
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Positioning Objects on the Build Tray

To produce models efficiently and with the required finish, it is important to
carefully position objects on the tray. Objet Studio supports the automatic
positioning of objects. However, you should check to make sure that the
objects are orientated optimally for your needs, according to the considerations
explained in "Manual Positioning" on page 5-31.

Two things that affect the positioning of objects on the tray are orientation and
placement. You can let Objet Studio determine the optimum orientation and
position, or you can control them.

Automatic Orientation

By default, Objet Studio automatically orients objects, when placed on the build
tray, for the shortest printing time. (You can later change the orientation
manually.) However, you can cancel automatic orientation when placing an
object on the build tray.

To place an object on the build tray without automatic orientation:

> In the Insert dialog box, make sure Orient Automatically is not selected.

Look irn: | I Samples w €) x A El,
3 |Z)Basic Shapes
\ :3 IZichess

My Recent ) Connex Samples
Documents |23 Connex_samples

= |)Eden_alaris_Samples
L% ) Images
IZ)5LC Files

I)STL Files
| Text3D
[ Trayl

Desklop

sample file

My Documents

=1
oL
My Computer
‘_-‘] File name: zample file A
-
by Metwork, Files of type: STL Files [ st w

Units: Millitd eter w [ Azsembly

Mumber of Copies : |1 e E] || Orient Autarnaticaly

Coordinates
Width (] Depth [v)  Height [£)
Extents 22.9 50.2318  [229

Preview

Figure 5-32 Orient Automatically option disabled

%{ You can change the default setting, so that automatic orientation is not
applied unless you select the Orient Automatically check box each time you
place an object on the build tray. To do this, see "Default Settings" on
page 5-74.
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Automatic Positioning

After placing several objects on the build tray, you can let Objet Studio arrange
them before printing. This ensures that the objects are positioned properly, and
that they will be printed in the shortest time and with a minimum of material.

To automatically arrange objects on the build tray:

> On the Tray Settings ribbon, click Feesmn:
or—

From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.

Figure 5-34 Tray arrangement after applying Automatic Placement
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e For best results, arrange the tray with Automatic Placement,on the
TraySettings ribbon, even if you inserted the objects with the Orient
Automatically option.

¢ The physical characteristics of each type of Model material you use can
affect the positioning of objects on the tray. Therefore, select materials
before running Automatic Placement.

Manual Positioning

You can change the position of objects on the build tray—even if they were
inserted with the Orient Automatically option. Tools for changing the position of
objects are presented in "Manipulating Objects on the Tray" on page 5-33.

The orientation of models on the build tray affects how quickly and efficiently
they will be produced by the printer, where and how much Support material is
used, and whether or not model parts will have a glossy finish. Therefore, you
should consider a variety of factors when deciding how to place models on the
build tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

> Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along the
Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.

> Surfaces that come into contact with Support materials become matte.

> Since models are built up, on the Z-axis, in 16- or 30-micron layers
(according to the printing mode), it is very time-consuming to print a tall
object. From this point of view, it is advisable to place the object's smallest
dimension along the Z-axis.

> Since the print heads measure about 2 inches (5 centimeters) on the
Y-axis, models measuring less than this (on the Y-axis) are printed in one
pass. From this point of view, it is advisable to place the object's
infermediate dimension along the Y-axis.

Tall-Left Rule

This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

> Since the print heads move along the X-axis from left to right, taller sections
on the right require the print heads to scan unnecessarily from the left until
reaching them. If, on the other hand, the taller sections are positioned on
the left of the build tray, the print heads only have to scan the model until
printing these sections—once the lower parts have been completed.
Therefore, you should position the taller side of the model, when possible,
on the left.

The following rules are based on the fact that Support material is not
required on the top of the printed model.
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Recess-Up Rule

This rule considers models containing surface recesses.

> Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.

Fine-Surface Rule

This rule considers models that have one side on which there are fine details

(like the keypad side of a telephone).

> The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.

Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at least

one side (like a pipe or a container).

> |t may be advantageous to print a model standing up, so Support material
does not fill the hollow, even though printing the model lying down would be
much faster.
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Positioning Objects on the Z-Axis

When you use the automatic positioning option to arrange objects on the build
tray (see "Automatic Orientation" on page 5-29), the objects are positioned
directly on the tray. If you do not insert objects with automatic positioning, they
often appear either above or below the tray.

In practice, the Objet260 system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects
directly on the build tray with Objet Studio is to correctly display the objects

on the screen.
To position objects directly on the tray:
1. Select the object.
2. From the Object menu, select Lay On.
To ensure that objects are always positioned directly on the tray:

1. From the Tools menu, select Options, and display the Settings tab.

| Appearance || Grid | Manipulsle | Display | Settings

Automabic Placement
Quick Autornatic Placement after adding new object

Pieserve i mm  distance between objects

Autornalic Lay On [Gravily)
(O Newer

() Blways

(3 wWhen under the tray
Large Files

() Load Full
() Load Partial [reduced)

Load Search Order
O Local

[ 18 l[ Cancel ] Apply

Figure 5-35 Options dialog box, Settings tab
2. Inthe Automatic Lay On (Gravity) section, select Always.
Other Z-axis options (in the Automatic Lay On section):

* When under the tray—The display of objects that are below the build tray
is automatically changed so that the object is at tray level.

* Never—The display of objects that are above or below the build tray is not
changed.
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Valid Object Placement

You can ensure that models do not overlap when you position them on the
build tray, and that they do not extend beyond the tray.

To ensure valid object placement:

1. From the Tools menu, select Constraints Settings.

B)
Constraints
Colars
Drefault Color
Outzide Tray

Callision

iin

Bath

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outzide Tray
Object Collizion

Figure 5-36 Constraints Settings dialog box

2. Select Dynamic check to identify—

O invalid object placement while placing objects—On Drop selected.
invalid object placement after moving objects—While Drag selected.
objects placed beyond the tray’s boundaries—Outside Tray selected.
objects that overlap—Object Collision selected.

aa

% Even if you do not use Dynamic Check when placing objects on the build
tray, Objet Studio automatically checks if there is a problem with the
positioning of objects on the tray before sending it to the printer. You can
also manually check for problems after positioning objects (see "Tray
Validation" on page 5-54).

Note: Because of the unique characteristics of each type of model material
and finish, always check valid placement after changing the material/finish.
Remember that Objet Studio calculates the space occupied by an object
including the “bounding box” surrounding it (see Figure 5-51 on page 5-45).
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Using a Grid to Position Objects

Displaying a grid on the image of the build tray can be useful when positioning
objects. To use the grid features, select the following menu options.

Menu Option Result
Tools > Grid Displays a grid on the build tray.
Tools > Snap to grid When moving the object, it aligns with the nearest grid line.
Tools > Options > Grid Enables you to change the grid origin
(X- and Y-axis meeting point) and appearance.

You can review and configure grid settings—and apply them—from the
Options dialog box.

To view and change grid settings:

1. From the Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.

Options g]
Appearance | Grid Manipulate | Display | Settings
[ Display grid
[] Shap to grid
Colars
Tile size 20 = mm
Baze -
Major divisi 10 > | tib
ajor division ilez Bt -
MNumber of tiles |32 £
Major -
Line style Dot
Units Millitd eter v
Origin 1] >0 >0 % |mm
[ Ok ] [ Cancel ]

Figure 5-37 Options dialog box, Grid tab

2. Asrequired, change the settings, and select or clear the check boxes.
3. Click Apply or OK.
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Measurement Units

3D files contain an object's proportions, but not its units of measure. Therefore,
make sure to correctly select either millimeters or inches when inserting an
object. Otherwise, the size of the object on the build tray will be either much too
large or much too small.

To set the measurement units when inserting an object:

> |n the Insert dialog box, Units field, select Millimeter or Inch:

Loak in: | I3 Samples w | Q2 o
EY [)Basic Shapes
| :; ichess
Iy Recent I Connex Samples
Documents | Connex_Samples
i [C)Eden_slaris_Samples
=
U_% @Images
Desktap [C)sample file
I)5LC Files
. [C5TL Files
,.] [ Textan
tdy Documents oyt y
(D sample file
Iy Camputer
'7_- File: narne: | v | [ Ingert ]
My Metwork Filez of type: STL Fi )

Urits:
Figure 5-38 Units field in the Insert dialog box

To change measurement units for a selected object from the
Model Settings ribbon:

1. Open the Units flyout toolbar.

mm
=
Millirneter

m iks
inch

Figure 5-39 Units flyout toolbar

2. Select the measurement units desired.
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To change measurement units for a selected object from the standard
toolbar:

1. From the Object menu, select Change Units.

Model Units

Units | MiliMeter v ok |

Ihich

Figure 5-40 Model Units dialog box
2. Inthe Model Units dialog box, change the setting and click OK.

Setting Model Dimensions

You can change an object’s dimensions by changing its size on the X-, Y-, and
Z-axes, from the Dimensions group on the Model Settings ribbon.

¥: |3.60 «. ) Uniform Ecalai
i 416
Z: 1.01

Dimensions {mm)

Figure 5-41 Dimensions on the Model Settings ribbon

* If Uniform Scale is enabled, changing the object’s dimension on one axis
affects the other dimensions, proportionately.

+ After changing a measurement, press Enter or click in another field in the
Dimensions group.

Note: You can change the height of the objects on the build tray only if this is
allowed by the Objet Studio settings (see "Positioning Objects on the Z-Axis"
on page 5-33).
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You can manually move and rotate an object on the build tray with the arrow
keys, or by dragging it with the mouse.

To manually manipulate an object:

1. Select an object by clicking it on the build tray, or in the model tree pane.

2. Click == on the Model Toolbar, or on the Model Settings ribbon.

A frame appears around the object, and the cursor changes to indicate that
the object can be moved.

Figure 5-42 Manually moving an object

3. Ifyou click on a corner of the frame, the cursor changes to indicate that the
object can be rotated.

Figure 5-43 Manually rotating an object

4. Manipulate the object with the arrow keys or with the mouse.
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Using the Transform Dialog Box
You can make precise changes to an object by changing the properties in the
Transform dialog box.

To access the Transform dialog box (when an object is selected):

* Click W on the Model Toolbar or on the Model Settings ribbon.
* From the right-click context menu, select Transform.

* From the Object menu, select Transform.

Transform E|
Width[] Depth(v']  HeightZ)

Translate: | 0 2 I =

Ratate: iy = gy a =

Scale: I i 1= [ =

Urifarrn Scaling | Apply | | Heset |

| Cancel Actions |

Figure 5-44 Transform dialog box
To change an object with the Transform dialog box:

> Change any of the values, then click Apply to see how the object changes
on the build tray.

Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see how
the object changes on screen each time you click Apply.

To reset all of the values in the dialog box:

> Click Reset.

Note: The object does not change. Any changes previously applied remain.
To undo all changes made with the Transform dialog box:

> Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings
ribbon or from the Edit menu) cancels all changes made with the dialog box.
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Changing an Object’s Orientation

There are several methods for changing the orientation of objects on the build
tray.

To rotate an object:

> Select the object and use the Object menu options (see also "Manually
Repositioning Objects" on page 5-38).
To re-align an object’s plane:

1. Onthe Tray Settings or Model Settings ribbon—

%

Select Select
Element = Greup T

a. Click the icon in the Selection group: ' zin  OF skaon

b. On the flyout toolbar, click the Select Plane icon:

®

or—

From the Tools menu, select Plane Alignment > Select Plane.

2. Click on part of an object on the build tray.
The selected plane is displayed.

LY 2 Alignment toolbar
e L

Selected plane

Figure 5-45 Aligning by plane

DOC-37004 Rev. J 5-40



Objet260 User Guide 5 Using Objet Studio

3. Onthe Alignment toolbar, click an appropriate icon to change the
alignment.

or—

From the Tools menu, select Plane Alignment, and select an alignment

option.
Plane Aligriment M| S Select Plane
v | Professional Mode =i Align Boktorn

= align Top
1% Align Front

fssembly Map ...
%0 align Back,

L

== l2SE b align Lefr

Dptions...

=F * Align Right

Figure 5-46 Tools menu, Plane Alignment options

To cancel plane selection after re-aligning objects on the build tray:
> Onthe Tray Settings or Model Settings ribbon—

L S

Select Seleck
Element = Ereup T

a. Click the icon in the Selection group:  ssim = Or e,
b. On the flyout toolbar, click the Select Element or Select Group icon:

e

Select
Plane ~

or—

> From the Tools menu, select Plane Alignment > Select Plane.
To flip an object 180 degrees on any axis:

1. Select the object.

2. From the Object menu, select Flip > Flip X/ Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:
1. Select the object.

2. Display the Transform dialog box (see Figure 5-44 on page 5-39).

3. Change the Rotate parameters for each axis.
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Grouping and Ungrouping Objects

You can manipulate two or more objects on the build tray, at the same time.

* Selecting multiple objects

Manipulating done to one object affects all selected objects. For example,
turning one object on its axis causes all selected objects to turn on their
respective axes.

» Converting the objects to an assembly

Separate objects become parts of one unit. For example, turning the
assembly on its axis causes all its component parts to turn as one unit.

To convert objects to an assembly:

1. Select the objects (see "Selecting Objects" on page 5-19).

2. From the Object menu, select Group to Assembly.
In the model tree, the objects now appear as children of a parent

(assembly).
Model Tree
= ﬁ Trayl
|1 shder
o W
v Pocket Card Holder _Shelll
v Pocket Card Holder _Shell2
| __| Pocket Card Helder_shell3
v| __| Pocket Card Holder_Sheld
v _| Pocket Card Holder_Shals
v Pocket Card Holder _Shels.
] Pocket Card Holder_Shel7
| __| Pocket Card Holder_Shelis

Figure 5-47 Assembly in the model tree

The model tree does not display the assembly file name unless you open
(insert) it as an objdffile.

After creating an assembly, you can save it as an objdffile, for re-use. (Saving
the assembly is not necessary for manipulating and printing it.)

To save an assembly:
1. Select the assembly (either on the build tray or in the model tree).

2. From the Objet Studio Commands menu o , select Save As.

3. Inthe Save As dialog box, select the objdfformat, choose a location, name
the file, and click Save.
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To separate assemblies into individual objects (st/ files):

1. Select the assembly (either on the build tray or in the model tree).

2. From the Object menu, select Ungroup.
In the model tree, the elements are not parts of an assembly.

HModel Tree

- Trayl
< L] e
| Pocket Card Holder_Shell
| Pocket Card Holder_Shellz
| Pocket Cord Holder_Shel3
| | Pocket Card Holder_Sheds
| Pocket Card Holder_ShelS
Pocket Card Holder_Shellé
| Pocket Card Holder_Shell?
| Pocket Card Holder_Shelis

EARCARGANE VR RCARCANC Y

Figure 5-48 Separate objects in the model tree

Freezing Model Orientation

DOC-37004 Rev. J

If you manipulate an object on the build tray, you can freeze its orientation so
that it does not change when you position it automatically (see "Automatic
Positioning" on page 5-30).

To freeze an object:
1. Select an object on the build tray.

2. On the Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click & .

To unfreeze an object:

> Select the object and click # (to de-select it).
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Display Options
Viewing Objects
From the View menu, you can change the way objects are displayed. The

default method for displaying models on the build tray is as solid (“shaded”)
objects.

Figure 5-49 Tray and model displayed in Shaded view
The other display options are WireFrame and Points.

To display the build tray in WireFrame view:

> From the View menu, select WireFrame.

Figure 5-50 Tray and model displayed in WireFrame view

To revert to the shaded view:

> From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions
instead of their shape:

> From the View menu, select Display Bounding Box.

I"‘i

Figure 5-51 Model displayed with bounding box

To display the area around objects needed for support material (to
produce a matte finish):

> From the View menu, select Display Thickening Box.

Figure 5-52 Model displayed with thickening box

To display the maximum build height:
> From the View menu, select Display Tray 3D Box.

Figure 5-53 Tray 3D Box
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To display objects without the build tray:
> From the View menu, clear (de-select) the Display Tray option.

Screen Layout

Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models from
different perspectives by changing the screen layout.

To change the screen layout:
> On the View flyout toolbar, select Single View, or 4 Views.

Figure 5-54 Screen layout icons
O Single View @] is the default screen layout.

O 4 Views & displays perspective, top, front and right views.

Figure 5-55 Single-view screen layout
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e es® e i | -

Figure 5-56 4-view screen layout

Tray Perspective

DOC-37004 Rev. J

The default perspective of the build tray is “isometric.” You can change the
perspective of the active window with one of ten options.

To change the perspective of the build tray in the active window:

1. Onthe Tray Settings ribbon, open the Perspective flyout toolbar.
Isi

&

el
ometric
S

2
)

Figure 5-57 Perspective toolbar

2. Click the icon that represents the desired perspective.
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Tray Positioning
To view the tray and models from different directions, you can move the tray
around the screen and change its display angle.

To move the tray in the Objet Studio screen:

> Press the mouse wheel while moving the mouse.

Figure 5-58 Tray after moving it in the Objet Studio display
To manually rotate the tray:

> Press Alt and press the mouse wheel while moving the mouse.

Figure 5-59 Tray after rotating it upside-down

To view the tray and models from different directions, you can change its
display angle.
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Setting Object Colors

The color of objects on the build tray can indicate how they are printed. Objet
Studio enables you to choose the color display so that you can easily see the
material, surface and coating of objects.

To choose how colors are applied on the display:

> On the Model Settings ribbon, in the Colors group, select one of the options
from the flyout toolbar.

£28

By
Material = Color Indicates Mode material

g% olor
| Fcnlur indicates Mode surface
@/, Colorindicates if coating is used

Figure 5-60 Colors display options

% Before sending a build tray to the printer, or when you perform tray
validation, Objet Studio checks if there is a problem with the st/ files or the
positioning of objects on the tray. If so, the affected objects are displayed
with special colors (see "Tray Validation" on page 5-54).
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Loading Large Files

Very large stl files can be slow to load and may be difficult to manipulate easily
on the build tray. If this is the case, you can display just an image of the object

on the build tray without loading the entire file. The st/ file itself is not changed,

and the complete file is sent to the printer.

To display an image of st files when you place objects on the build tray:

1. From the Tools menu, select Options, and display the Settings tab.

Options rX |

| Appeaiance Grid | Maripuiale | Disslay | Seltngs |
Autematic Flacemenk
Quick Auloratic Flacsment alter adding new chiject
Pleserve Il mm  distance bebween objects

Auteenatic Lay On [Gravily)
O Mever

) Blways

Crwhen unde the Iray

Large Files

O Load Full

(%) Load Partial [reduced|

Load Search Urder

O Local

Sou

Figure 5-61 Options dialog box, Settings tab
2. Inthe Large Files section, select Load Partial (reduced).

Large File Manipulation

If you need to work with a detailed model that is composed of a large number of
polygons, you can speed up its display and manipulation in Objet Studio by
reducing the number of polygons on the screen. Although this may reduce the
resolution on the screen, it has no affect on the printed models.

_—

Figure 5-62 Object displayed without polygon reduction
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Figure 5-63 Object displayed with only five percent of its polygons
showing

To use polygon reduction:

1. From the Tools menu, select Options.
or—

From the Objet Studio Commands menu © , click Options.

2. Inthe Options dialog box, display the Display tab.

Options |z|

| Appearance || Grid || Manipulate| Display |Settings|

[[] Enable Polygon Reduction
Dizplay while changing wiew
(® Bounding Box

Adaptive Polygon Reduction
() Entire Object

Diizplay when static view
O Bounding Box

Paolygon Reduction [Percents]
(%) Entire Object

Save Polpgon Reduction Data
Default

[ QK _H Cancel ] Apply

Figure 5-64 Options dialog box, Display tab
3. Select Enable Polygon Reduction.
4. Select Polygon Reduction (Percent).

5. Enter the percentage of total polygons to display.
When you click Apply, the display changes.

Note: The setting affects the static display (when the object is not being
moved).

6. Setdisplay options when the object is being moved (Display while changing
view):
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O Bounding Box—A box representing the object’'s maximum dimensions
is displayed.

O Adaptive Polygon Reduction—Varying degrees of polygon reduction
are applied, as necessary.

[ Entire Object—No polygon reduction is applied.

To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.

8. Click Apply to see the results of the settings without closing the dialog box.

%{ Selecting the Entire Object option cancels polygon reduction.

Object display options

Zoom Options

DOC-37004 Rev. J

The display format affects how quickly objects display. For example, if you
select Bounding Box, objects display faster than they do when you select
Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).

To select the object display preference while changing view, and in
static view:

1.

Select to display objects:

O With a Bounding Box (see Figure 5-51 on page 5-45)
O With Adaptive Polygon Reduction (changing view only)
O With Polygon Reduction (static view only)

O Entire Object

Click OK when done.

While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:

> On the ribbon, open the Zoom flyout toolbar and select an option:

Zoom Object

Zoom Tray

Zoom by Rectangle

Figure 5-65 Zoom flyout toolbar

O Zoom Object focuses on the selected object.
O Zoom Tray displays the whole tray.
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O Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray. See "Automatic Zoom" on page 5-75.
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Handling Trays

After preparing models on the build tray, you can do the following:

* Test that it can be printed ("validation").

+ Calculate the time and material resources needed to print it.
» Send it to the printer for production.

» Save it for later completion or printing.

» Save it as a compressed file for convenient storage and transfer.

Tray Validation

Before sending a job to the printer for production, you should check that the
tray is “valid” and can be printed.

Note: Because of the unique characteristics of each type of modeling

material, make sure that the correct material is selected before performing
Tray Validation.

To validate that the tray can be printed:
¥
> On the Tray Settings ribbon, in the Build Process group, click vsidszs .
or—

From the Tools menu, select Placement Validation.

If the tray is not valid, the color of the problematic models on the tray
changes according to a pre-set code.

x|

Constraints
Colars
Default Color
Outzide Tray

Callision

iin

Bath

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check

Outside Tray
Object Collizion

Figure 5-66 Color code

Note: The “Both” color also indicates a problematic st/ file.
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The validation status appears on the bar at the bottom of the screen.

Walidakion succeeded Maodels: 1

Figure 5-67 Validation details in status bar

Production Estimates

Objet Studio enables you to calculate the time and material resources needed
for producing trays before sending them to the printer. The time it takes Objet
Studio to perform this calculation depends on the number of objects on the tray
and their complexity. Calculating the production estimate for a full tray could
take up to 15 minutes, depending on your computer’s specifications.

To calculate the time and materials needed for producing the current
tray:

P
> Onthe Tray Settings ribbon, in the Build Process group, click Estmats

While the estimate is being calculated, a progress bar is displayed—on the
right side of the status bar (at the bottom of the screen).

=

CEEELELLL | # —Cancs

Figure 5-68 Estimate progress bar

When Objet Studio finishes calculating the production resources, the
results are displayed in a dialog box.

Production Estimates

(X

Frinting tode FullCure7 20 Consumption Suppart Consumption Build tirne:
High Gluality 149 48y 02:19
High Speed 103 g Iy 01:25
Digital Material 107 g 39g 02:39

[ Hep | [ ok |

Figure 5-69 Production resource calculations for different printing
modes

As shown in the Production Estimates dialog box, the resources needed for
producing the models on the tray depend on the printing mode used by the
printer when producing the job. You might want to consider these estimates
when deciding on the printing mode (see below), and whether or not to allow
using substitute model materials when printing the job.

Note: You select the printing mode and material substitute options after you
send the build tray to the printer (see "Printing the Tray" on page 5-57).
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Printing Modes

Objet260 printers can build models using three possible printing modes.
HQ (High Quality) Mode—

» Models are printed in 16-micron layers, resulting in smooth surfaces,
suitable for producing fine-detailed and delicate items.

* Almost twice as much time is required to print most trays, compared to the
High Speed setting.

* This setting is only available when model material can be used in four print
heads, in single-material printing.

Single-material printing: All print heads print models without regard to the
source of the model material. This happens in the following situations:

¢ All print heads are supplied with one model material.

¢ Each pair of print heads is supplied with a different model material, but
models are printed as if they were the same material. The result is an
arbitrary mixture of materials in the printed model.

HS (High Speed) Mode—

» Models are produced in 30-micron layers, suitable for producing larger
models.

* Much less time is required to print most trays, compared to the High Quality
setting.

* This setting is only available when model material can be used in four print
heads, in single-material printing.
Digital Material Mode—

» Used when producing trays designed to be fabricated from two or more
model materials.

* Used when producing a tray containing two or more models, each designed
to be made from a different (single) model material.

» Used when producing models from only one of the model materials loaded
in the printer by printing with only two of the print heads.

* Models are produced in 30-micron layers, but the printing is near-high
quality.

* Printing time is similar to printing time in High Quality mode.
Although printing time is longer than with High Speed mode, Digital Material

mode can make material replacement unnecessary—saving both time and
the cost of wasted model material.

Digital Material Mode is selected automatically when more than one model
material is assigned to objects on the tray.

You can see estimates of time and material resources needed for printing trays
using the different printing modes (see "Production Estimates" on the previous
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page). You also see these production estimates when you send the tray to the
printer. At that time, you can select the printing mode, including an option that
enables Objet Studio to print the tray by the most efficient method (see
"Printing-Mode Selection" on page 1).

E-mailing Objet Digital Files

Printing the Tray

DOC-37004 Rev. J

You can easily e-mail objdf files using Microsoft® Office Outlook®. Sending
objdffiles is recommended (instead of stl files) because the size of afile is
typically reduced by more than half. An added benefit is that the objdf file
contains the model-material information for the object.

To e-mail a file:

1. From the Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the e-mail
form.

2. Enter the e-mail address and send the file.

When a tray is ready to be printed, it is placed in the Jobs Queue. When the job
reaches the head of the queue, Objet Studio pre-processes the tray file to
create slices, and feeds them to the printer.

To send the tray to the print queue:

> On the Tray Settings ribbon, Build Process group, click B;na .

O If printing the tray requires two or more model materials (Digital Material
mode), the Job Summary dialog box opens.

Job Summary [t

This Job will be printed in Digital Material™

Material and Time Estimates:

Printing Mode “erdWhite Consumption “eroCyan Consumption “erobdgnt Congumption Support Consumption Build time
Digital Material 136 g 4q 4q 45 g 02:43

‘ Fine Estimation ‘

| Help ‘ ‘ Build | [ Cancel ]

Figure 5-70 Job Summary (multiple model materials)

Note: The values displayed are the result of a quick calculation, and
represent a rough estimate of the materials and time input required to
print the job. For a more accurate calculation, click Fine Estimation.

> Click Build and continue on page 5-60
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O If printing the tray requires only one model material, the Printing Mode

Selection dialog box opens.

Printing Mode Selection EI

Select Printing Mode

() High Quality () High Speed (%) Automatic

Material and Time Estimates

Printing Mode FullCure720 Conzunption Support Consumption Buaild tirme:
High Quality 156 g 78 g 02:14
High Speed 145 g FAN:! 0122
Digital Material 148 g 74y 02:37

l Fine Estimation I

[ or ) [von ] [coma ]

Figure 5-71 Printing Mode Selection dialog box

Note: The values displayed are the result of a quick calculation, and
represent a rough estimate of the materials and time input required to
print the job. For a more accurate calculation, click Fine Estimation.

> Select the appropriate printing mode.

% For an explanation of printing modes, see Printing Modes

* If you require the job to be printed in High Quality mode, select this
option.

Note: The availability of High Quality mode depends on the
material selected.

* If you require the job to be printed in High Speed mode, select this
option.

* If you do not require the job to be printed either in High Quality or
High Speed mode, select Automatic.

This setting enables the Objet260 software to determine (just before
printing) the most efficient way to print the tray. Digital Material
mode is used if this removes the need to perform the Material
Replacement procedure. Otherwise, High Speed mode is used.

For example, if printing the tray requires only one of the model
materials loaded in the printer, only the two print heads using that
material are used to print models—Digital Material mode. (High
Quality and High Speed modes call for printing model material with
four heads, which would require you to perform the Material
Replacement procedure.)

On the other hand, if printing the tray can be done using four print
heads without running the Material Replacement procedure, High
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Speed mode is used. This is possible if all print heads are supplied
with one model material, or if you allow printing with an arbitrary
mixture of similar materials (see below).

%{ Model Quality When Digital Material Mode is Used

» Near-high-quality is achieved for most models.

« If all objects on the tray are inserted from individual st/ files,
they are printed with the standard resolution of 600 dpi (dots per
inch) along the Y-axis—unless glossy finish is required (see
"Surface Finish" on page 5-21).

« Ifthere is an assembly on the tray, all of the models on the tray
are printed with a resolution of 300 dpi along the Y-axis.

> Click Next.

* If no other selections are required, the Job Summary dialog box
opens.

> Click Build and continue on the next page

O If material substitution is allowed for this job, the Model Material
Substitution dialog box opens.

Model Material Substitution g]

Can another model material be used instead of the
one you selected?

(O es, use any material with similar characteristics.
(®) Mo, use DMLY the selected model material.

| Back | | Build | |[cancel | | Help |

Figure 5-72 Model Material Substitution dialog box

If you allow the use of substitute model materials, the printer will use
different materials whose characteristics (strength, flexibility, etc.) are
similar to those of the material you assigned to the object when
designing the build tray—under the following conditions:

» The material you assigned is not installed in the printer at the time of
printing.

In this case, the tray is printed with either one or two substitute
materials (depending on the materials installed in the printer at the
time of printing). If possible, High Speed mode is used.

* In addition to the material you selected, there is another (similar)
material installed in the printer at the time of printing.

In this case, High Speed mode is used, by printing with a mixture of
the two materials (as if they were the same material).

> Click Build and continue on the next page
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Continue Here
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If the build tray file has not been saved when you click Build, the Save As
dialog box opens for you to save it.

Objet Studio checks if there is a problem with the positioning of objects on
the tray. If so, the affected objects are displayed with special colors (see
"Tray Validation" on page 5-54), and a warning message appears.

Warning

Overlapping objects!
- Click Mo to separate objects manually
or with Automatic Placemert.

- Click Y'es to print the tray az is.

Do you want to proceed anpway?

Figure 5-73 Tray validation warning message

> To cancel the Build command so you can correct the problem, click No.

> To print the models as they are positioned on the tray, click Yes.

The Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See "Monitoring and Managing
Print Jobs" on page 5-80.
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Applying Additional Objet Studio Features
Dividing Objects

You can use the Split Object feature to produce objects larger than the tray
area by dividing the model into separate parts. With this feature, you produce
only a specific section of a model.

To split an object:
1. Select the object.
2. From the Object menu, select Split.

3. Inthe Split Object dialog box, enter the values to determine how Objet
Studio will divide the object. You can divide an object along any of its axes,
by entering either exact measurements or the number of parts.

Model Tree

Q Trayl
| Applications - FLUTE_Shell3_Part1
| applications - FLUTE_shell3_Part2

Object Size 315 228 22 6048

() Split by Size 347 347 202 Default

Figure 5-74 Split Object dialog box

4. In Save to Folder, enter the folder name.

5. Click OK.

The composite parts are saved as new st/ files with “Part 1,” “Part 2,” etc.,
added to the original file name.

Note: Before printing the newly created st/ files, it is recommended that you
check them for defects in an STL-repair application, such as Magics™, by
Materialise®.
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Choosing the Support Strength

When producing models, support material fills some hollow and empty
sections (see "Manual Positioning" on page 5-31). Objet Studio allows you to
adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or
small/delicate models. For most purposes, the default setting provides
adequate support strength.

To change the strength of the support structure used when printing a
model:

1. Select a model on the tray.

2. On the Model Settings ribbon, in the Options group, click % .
or—

O Onthe Model Toolbar, click o i
or—

O From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.

Advanced Properties E

Grid Style [ Hallaw
(%) Standard

) Heawy
) Lite

A pply

Figure 5-75 Advanced Properties dialog box

Note: If an objectis splitinto shells, the Advanced Properties enabled vary
with the object selection. If a single element is selected only Hollow is enabled.
If a group of elements is selected only Grid Style is enabled.

3. Inthe Grid Style section, choose the support strength suitable for the
selected model. You can select a different support strength for each model
on the tray.

O Standard—for models needing average support (most models).
O Heavy—for large models needing much support.

O Lite—for models printed with SUP706 Support material and for delicate
models needing little support. (This setting makes it easy to remove the
support material.)

4. Click Apply.
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“Hollow”— Filling Models with Support Material

DOC-37004 Rev. J

Many objects placed on the tray from st/files are “solid.” This means that, when
printed, the model will be completely filled with model material. Often,
especially with large objects, this is unnecessary. Instead, the model can be
filled with support material, which is less costly. It is also advisable to fill models
with support material when preparing them for investment casting, since this
material burns off more quickly during the process of making the cast.

Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. When using this
feature, called “Hollow,” the thickness of the shell should be no less than 0.5
millimeters.

To use the Hollow feature:

1. Select a model on the tray.
or—

7 On the Model Toolbar click % .
or—

[ From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.

2. Select Hollow.

Advanced Properties E|
Grid Style H il
(%) Standard
(O Heawy Shell Thickness: 1.35
{3 Lite

Figure 5-76 Advanced Properties dialog box
3. Set the shell thickness, in millimeters.
4. Click Apply.

Note: There is no change in the display of objects in Objet Studio when
Hollow is selected.

To inspect, change or cancel the Hollow setting:

1. Select a model on the tray.
2. Access the Advanced Properties dialog box, as above.

3. If you change or cancel the Hollow setting, click Apply.

5-63



Objet260 User Guide 5 Using Objet Studio

Displaying the Cross Section of Objects

The Section feature enables you to view the interior of an object by “slicing” it
on any axis. You can then manipulate the object to inspect the interior from
different angles. This may be important for deciding on the type of support
necessary when producing the model (see "Choosing the Support Strength" on
page 5-62). Displaying an object’s cross section only affects how the tray is
displayed on the screen; it does not change the object itself.

To display a cross section of the tray:

1. From the Tools menu, select Section.
The Section dialog box opens.

Section

Section |

¢ Enable Clipping

Figure 5-77 Section dialog box
2. Select Enable Clipping.

3. Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that you
see the cross section you want.

Figure 5-78 Left: Whole view; Right: Cross section view after using
the Z-slider
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Saving the Screen Display as an Image File

You can save the image displayed in the active viewing screen as a graphic
file.

To save the screen display as an image:

1.

2.
3.
4.
5.

Saving Build Trays

Press Ctri+B.
or—

From the Objet Studio Commands menu © , select Save Bitmap.

The Save Bitmap dialog box opens.

Save Bitmap @@

Savein: |9 STL Files =] = EB-
[C2-0096 G0 To Lask Folder Visited
IZ)2-0148

*Applications - Tab Coating.bmp

*TrayS.bmp

File name: |Applications - Tab Coating
BV el 1 indows Bitmap [*.bmp) Cancel

[rata Type: |F|GB True Color  [24-bit] j

Compressior: | Mon-Compressed j

Figure 5-79 Save Bitmap dialog box

At the top of the dialog box, select the appropriate folder.

At the bottom of the dialog box, enter a file name.

Open the Save as type drop-down list, and select the file format.
Click Save.

You can save your work in different Objet Studio file formats, depending on
how you want to use them later.

OBJTF Files

objtffiles contain instructions to Objet Studio and to Objet260 printers for
displaying and producing the st/ files used on the tray. When you save build
trays in Objet Studio, they are saved as objtffiles.

Saving in objtfformat is useful, for example, if you have not finished preparing
the tray for printing, or if you want to make changes before printing it again in

DOC-37004 Rev. J
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the future. objtf files are also useful when working from your company's
network, where the STL files are stored.

Note: Because the objtffile references the st/ files used, they must remain in
the same file location as when the objtf file was saved.

To save the tray as an objif file:

8

> Inthe Tray Settings tab, File group, click **

To open trays saved as objtffiles, see "Opening Objet Tray Files" on page 5-
16.

OBJZF Files

To conveniently save all of the files as they are positioned on the build tray, for
storing the job, or for transferring it to another location, Objet Studio
compresses them into one objzffile. To later use the objzffile, the file must first
be expanded in Objet Studio and its component files saved.

Note: If you export an objzffile containing a st/ file originally saved as read-
only, you cannot open (import) this objzffile to the folder where the read-only
stlfile is saved.

To create an objzf file:

1. From the Objet Studio Commands menu @ , select Export Packed Job.
The Save As dialog box opens.

2. Select the folder, set the file name, and click Save.

Note: You can also export a print job as an objzf file from the Job Manager
screen—see "Additional Server Features" on page 5-91.

To open an objzffile:

> Double-click on the objtffile.
or—

1. From the Objet Studio Commands menu @ , select Import Packed Job.
2. Inthe Open dialog box, display the appropriate folder and select the file.

3. Inthe Browse for Folder dialog box, display the folder in which you want
Objet Studio to expand the compressed file, and click OK.

The objtffile and associated st/ files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.
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Customizing Objet Studio

You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

[ Creating a quick-access toolbar for frequently used commands.
[ Changing the position of the Quick Access toolbar.

[ Minimizing the ribbon.

O Changing the Objet Studio color theme.

[ Configuring default settings for objects placed on the build tray.

Creating a Quick Access Toolbar

As you work with Objet Studio, you may use certain commands frequently. You
can create a quick-access toolbar to make your work easier.

To create a quick-access toolbar:

1. Above the ribbon tabs, click * .
The Customize Quick Access Toolbar menu opens.

e

Customize Quick Access Toolbar

Inserk
Placemnent
Estimate
BEiuild
Qpern,..

More Commands. ..

Show Below the Ribbon

Minimize the Ribbon

Figure 5-80 Customize Quick Access Toolbar menu

2. Select a command you want to add to the toolbar.
An icon for the selected command is added to the toolbar.

. :

Tray Settings Job Mana

b ¥ S

Insert || Placement Yalidate [Estimate Build

Miode| Build Process

Figure 5-81 Quick Access toolbar
To add another command, repeat the above procedure.
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3. To choose from a wider range of commands:

@ From the Customize Quick Access Toolbar menu (see Figure 5-80 on
the previous page), select More Commands.
or—

O Right-click on the Objet Studio Commands icon © , or elsewhere on
the ribbon, and select Customize Quick Access Toolbar.

Customize Quick, Access Toolbar, ..
Show Quick Access Toolbar Below the Ribbon

Minimize the Ribbon

Figure 5-82 Right-click ribbon menu
The Options dialog box opens.

Options

Customize Choose commands from:
*opular Commands w Job Manager
Commands:
<Separators

,{d’- Autornatic: placement
@ Buid
:'} Ingert Model
© tew R
% Open
£ Placement validation -
@ Save

] 5how Quick Access Toolbar below the Ribbon

Kepboard shortcuts:

Figure 5-83 Quick Access Toobar Options dialog box

4. Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.

5. Selecta command and click Add.
6. Click OK.
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Hiding the Ribbon

To make more room for displaying the build tray, you can hide the Objet Studio
ribbons.

To hide the ribbons:
1. Right-click anywhere on the ribbon or on the menu bar, or in the Objet
Studio Commands menu O .

2. Select Minimize the Ribbon.

The ribbons disappear, but you can temporarily display the ribbon icons by
clicking Tray Settings or Job Manager on the menu bar. When you next
click outside of the ribbon, it disappears again.

To return the permanent ribbon display:
> Repeat the steps above to cancel Minimize the Ribbon.
Display Colors
You can customize some of the colors used for displaying Objet Studio
screens and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:

1. From the Tools menu, select Options.

Options. lﬁ

Appearance |Gid | Manipulate | Display | Settings |

Select Indication

Mode Shaded -

Calar
[ Transparent
Window's Backaround Calor

) Color

@ Gradient

Default

[ ok ][ cance |

Figure 5-84 Display settings
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2. Inthe Appearance tab of the Options dialog box, you can configure the
display.
O The Mode selection determines how models appear on the build tray.

The default method for displaying models on the build tray is as solid
(“shaded”) objects. The other options are WireFrame and Points.

O If Shaded is selected, you can display the model on the tray as a see-
through object.

Figure 5-85 Transparent display
O Double-click the color patches to customize colors.

O The Windows Background Color settings enable you to change the
color behind the build tray—with either a solid or a two-color gradient.

O To return to the default display settings, click Default.

Changing Color Themes

Objet Studio offers a choice of four background color themes—blue, black,
silver and aqua.

g
e
2 LEAE 2 2R (e
= - o=
B - i |

i hﬂﬂ.i_.T

Figure 5-86 Background color themes

To change the color theme:

> From the Style menu, select one of the options.
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Keyboard Shortcuts

You can define shortcut keys for frequently used commands.

To define shortcut keys:

1. Above the ribbon tabs, click ~ .
The Customize Quick Access Toolbar menu opens.

=)

Customize Quick Access Toolbar

Inserk
Placement
Estimate
Build
Qpen...

Maore Commands. .

Show Below the Ribbon

Minimize the Ribbon

Figure 5-87 Customize Quick Access Toolbar menu

2. Select More Commands.
The Options dialog box opens (see Figure 5-83 on page 5-68).

3. Click Customize.
The Customize Keyboard dialog box appears.

Customize Keyboard [Z|
Categories: Commands:
-~
Print Preview Build Properties —3
Amange Tray Default Properties..
Model Settings Exit
Job Manager Export Packed Job... —
Import Packed Job...
Job Manager...
M achine Properties w
Current Keys: Press new shortcut kew:
Harme
Aszzigned to:
[Unazsigned]

Set Accelerator for:

Default w @
Description:
Build

Figure 5-88 Customize Keyboard dialog box
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4. Select command Categories to display all the commands in that category,
for example, all the Model Settings commands.

Current shortcut keys are displayed.

5. Enter the shortcut key in the Press new shortcut key field, and click Assign.

6. If you want to redefine all shortcut keys, click Reset All.

Setting User Preferences

You can change several Objet Studio settings that affect objects placed on the
build tray.

To change default settings:

> From the Objet Studio Commands menu O , select User Preferences.

User Preferences E|
Building Style Grid Style
(3 Matte () skandard
) Glossy ) Heawy
() Lite

Application Settings
Support Materials

[JLack Srientation

[ Hollow

SUP706 w

[ Cancel H Save

Figure 5-89 Setting work preferences
* Building Style—see "Surface Finish" on page 5-21.
* Grid Style—see "Choosing the Support Strength" on page 5-62.
* Application Settings:
O Lock Orientation—see "Freezing Model Orientation" on page 5-43.

O Hollow—see "“Hollow”— Filling Models with Support Material" on
page 5-63.
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Professional Mode Features

Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:

> Open the Tools menu.

Tools =|Skyle - -_@I -

Grid

Snap ko Grid

Constrainks Setkings. ..

Section

Flane alignment 3

V' | Professional Mode

Language...

Options. ..

Define Colors, ..

Figure 5-90 Tools menu, showing Professional Mode selected
If Professional Mode is selected, advanced features are displayed.

To change the Professional Mode setting:

1. From the Tools menu, select Professional Mode.
The following message is displayed, reminding you that the change will
only take effect the next time you open Objet Studio—even though the
check mark next to the Professional Mode option appears immediately.

1 'j The configuration changes vou hawve made will nok take effect until the next bme you run the application.
-

Figure 5-91 Configuration-change message

2. Close and re-open Objet Studio to use the Professional Mode features.
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Default Settings
You can control the default settings of several Objet Studio features from the
Advanced tab of the Options dialog box.

To display the Options dialog box
> From the Tools menu, select Options.
or—

In the Objet Studio Commands menu O , click Options.

Options EI

Appearance Grid I anipulate Dizplay
Settings Advanced Troubleshooting

[ swita Zoam
(riemt Ohjects ALtarmaticaly

[ 0K ][ Cancel ]

Figure 5-92 Options dialog box, Advanced tab

The Advanced tab is only accessible when Professional Mode is active (see
"Professional Mode Features" on the previous page).

Automatic Orientation

By default, when Objet Studio places objects on the build tray, it orients them
optimally, for the shortest printing time. If necessary, you can choose to cancel
automatic orientation each time you place an object on the build tray (see
"Automatic Orientation" on page 5-29). In any case, when objects are on the
build tray, you can change their orientation manually (see "Manual Positioning'
on page 5-31.)

To change the default setting so that Automatic Orientation is disabled:

> In the Advanced section of the Options dialog box, clear the check box.

DOC-37004 Rev. J 5-74



Objet260 User Guide 5 Using Objet Studio

Automatic Zoom

When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms in, to display the objects placed on the build tray. This
allows you to carefully inspect and manipulate the objects.

By default, this feature is not enabled. In any case, you can change the zoom
level, as necessary (see "Zoom Options" on page 5-52).

OpenGL Driver Configuration
The OpenGL driver displays 3D graphics on your screen. There is normally no
reason to adjust its settings. If you suspect a problem with the way Objet Studio

displays objects, you can use the OpenGL Driver Configuration tool to check
and configure the driver settings.

To access the OpenGL Driver Configuration dialog box:

1. From the Tools menu, select Options.
or—

In the Objet Studio Commands menu © , click Options.

2. Inthe Options dialog box, display the Troubleshooting tab.

Options E|

Appearance Grid Manipulate Dizplay
Settings Advanced Troubleshooting

l OpenGL Driver Configuration...

[ 0K H Cancel ]

Figure 5-93 Access to OpenGL Driver configuration

The Troubleshooting tab is only accessible when Professional Mode is
active (see "Professional Mode Features" on page 5-73).
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3. Click OpenGL Driver Configuration.

The dialog box that opens displays details of the pixel format ID (index) for
the window and the memory.

OpenGL Driver Configuration

Wwindow Pivel Format | Memary Pisel Format | Advanced

() Pixel Format 1D

@ Chooze Format | Option 1 3z
Calor Bits 24
Depinfits |32
Alpha Bits i

[ 0k ][ Cancel ]

Figure 5-94 OpenGL Driver Configuration dialog box

If you want to display the values and change them, click [:I Alternately, you
can select Choose Format and change the values in this dialog box.

To perform a test of the driver configuration and enter the suggested
pixel format ID:

1. Select Choose Format.

2. Click Test.
Objet Studio returns the recommended pixel format ID.

Objet Studio 3

L.l
\ll) Choose Pixel Format: 5

Figure 5-95 Recommended pixel format ID

3. Click OK.

4. Inthe OpenGL Driver Configuration dialog box (Figure 5-94), select Pixel
Format ID and enter this number.

5. Click Apply.

6. Display the other pixel format tab, and repeat this procedure.
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Getting Additional Objet Studio Assistance

Objet Studio Help provides on-screen instructions and information, as you
work.

To view Objet Studio Help:

> On the standard toolbar, click ¥ and then click Objet Studio Help.

Tools - Style - (@) -

Ohijet Studio Help )

Troubleshooting
Check For Updates

@ About. ..
Figure 5-96 Help options

You can also view information on the following subjects:

O Troubleshooting opens a list of error messages and their explanations.

[ Check for Updates checks if you are using the latest Objet Studio
version.

Objet Studio Version, Material Module and Licensed Features

You can view details of the Objet Studio version, the material module installed,
and the features available with your license.

To view details of your Objet Studio installation:

> On the standard toolbar, click % and then click About....

Tools = Stwle - -._@'I o
Objet Studio Help
Troubleshooting

Check for Updates

@ about...
Figure 5-97 Displaying Objet Studio details
About Objet Studio tab

The About Objet Studio tab shows the Objet Studio version number and basic
information about your computer.
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© (23|

About Objet Studio | Materials Module I Feature License|

(IBJET

Obijet Studio Ver. 5.2

Copyright ® 2013 Stratasys Lid.
All rights reserved.

For Applications Support: applications-nkjet @stratasys.com

Operating System:  Professional -Service Pack 1 (Build 7601)

Processor: Pentium Vs
Awvailable Physical Memory: 515 MB
System Resources: 4%

Figure 5-98 About Objet Studio tab
Materials Module tab

The Materials Module tab shows details of the material module installed.

© X

Materials Module | Feature License

Module version:  9.2.7.7
Module Date: 28.01.2013

Module Properties: Default

Figure 5-99 Materials Module tab

® Module version
If a Materials Module upgrade (patch) was installed, the new Materials
Module version is displayed. If no patches were installed, the Module
version is the same as the Objet Studio version.

* Module date

If a Materials Module upgrade (patch) was installed, the date of its creation
is displayed. If no patches were installed, the Module date is the date of the
Objet Studio version.
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® Module properties

If a Materials Module upgrade (patch) was installed, its description is
displayed. If no patches were installed, “Default” is displayed.

Feature License tab

The Feature License tab shows the Objet Studio features available with your
license.

Ahout Objet Studic | Materials Module | Feature License | Credentials

=R (bjet2A0 Connex3
Modes
M aterials
Digital materials
Mixed tray

Figure 5-100 Feature License tab
Click ® to expand the details for each feature.
* Modes shows the printing modes available.
See "Printing Modes" on page 5-56.
* Materials shows the basic model materials available.
* Digital Materials shows the digital materials available.

* Mixed Tray shows if your license enables printing a build tray containing
objects, using a different model material for each.
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Monitoring and Managing Print Jobs

In the Job Manager screen of Objet Studio, you monitor and manage jobs sent
to the printer. There are a few differences between Objet Studio on client
workstations and on the computer connected directly to the 3D printer—the
server workstation.

* Objet Studio installed on a client computer only displays the queue and
status for jobs sent to the 3D printer server from that computer, and it allows
the user to edit only these jobs.

Note: Ifthere are several PolyJet printers on the local network, client
computers can connect to any of them, but only one at a time.

* Objet Studio installed on the computer directly connected to a specific 3D
printer (server), displays the queue and status for all jobs sent to that 3D
printer by the server and by all client computers on the network. It also
allows editing and manipulation of all jobs, and enables re-sending
previously-printed jobs to the printer.

% If Objet Studio is not connected to a printer (or printer server), you can

prepare tray files for any PolyJet printer. Later, these files can be used by
Objet Studio on the appropriate printer server.
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Job Manager Screen

The Job Manager screen on the client and server workstations looks identical.
The only difference is that options only relevant to the server workstation are
disabled for client installations.

D : oy N e e
- o
JobManager__ || 2.2 © ¢ s
Ribbon -
i, Gt -I( ey —
[ep— S ey R S S —— ety ) Yeewne § Yeesiierh 4
S e W mE Teeh B e
Jobs Queue | .
. . Available resources
Myres | | Wpeem | | g
[ i
. B e e _a"
Print Progress __| P

Materials consumption

Print Histony — -

W wad e g
O I y "":.‘- *a ] # - - T
rl 9 —Tray Preview
Waste status — g

e

Figure 5-101 Job Manager screen
The Job Manager screen is divided into panels:

+ Jobs Queue

* Printing Progress

* History

* Available Resources

» Material Consumption
* Tray Preview

» Waste
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Jobs Queue

On the server, the Jobs Queue lists the last 15 jobs sent from client computers.
On client workstations, it lists jobs sent from that computer to the server.

Information for each of the queued jobs is displayed, including the job status.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be
continued (Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was placed
in the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing The 3D printer is readying itself for printing: the cover locks,

the print heads warm up and are put in starting position, the
UV lamps are turned on, and the build tray level is adjusted.

On Schedule The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:

* Owner—the computer that sent the job
* Build Time—the estimated building time for the job

* Model Consumption—the amount of model material required to complete
the job, and the amount actually used till now

» Support Consumption—the amount of support material required to
complete the job, and the amount actually used till now

* Printing Mode—HS=High Speed, HQ=High Quality, DM=Digital Material

Printing Progress

The Time panel shows printing times and the number of slices sent to the
printer.

History

The History panel shows information for the last 50 jobs and their final status.
You can drag a job from History to Jobs Queue to print the tray again.

Available Resources

The Available Resources panel contains graphic indicators that show the
amount of available printing materials remaining in the printer.1

10bjet Studio displays the weight of the printing materials in both cartridges as long as each cartridge contains more than 100 grams of
material. The weight under 100 grams is not calculated and displayed. However, if a cartridge contains less than 100 grams of
material, the printer uses it—as long as the material in the other cartridge weighs more than 100 grams. In any case, the weight of each
cartridge is displayed in the printer application.
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Material Consumption

* Actual—the amount of material used till now
* Required—the amount of material still needed to finish the job

Tray Preview

The Tray Preview panel displays the build tray view of the job selected in the
Job Queue or the History list.

On a server, you can open an enlarged preview window by clicking on the Tray
Preview display (see "Additional Server Features" on page 5-91).

Waste

The amount of waste appears when the cursor is over the Waste display.

Setting the Printer Connection

When your printer is installed, the server computer is connected to that printer.
Normally, there should be no reason to change this connection. Occasionally,
however, you may need to reset the connection, to connect the server to

another printer, or to use Objet Studio in offline mode (without a printer
connection).

To set (or change) the printer connection:

>
1. On the Job Managerribbon, in the 3D Printer group, click “m=,

2. Inthe Set Printer dialog box, click Connect.

Set Printer Features E|
Printer
+- Desktop
+- Eden
+- Connes
+)- Objet260
+)- Objet350
) ey

Figure 5-102 Connecting to a printer (A)
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3. Enterthe computer name or its IP address, or click Browse to find and
select it.

Eriter printer name/|P address.

Browse...

Use 'Unknown' for off-ine mode.

Figure 5-103 Connecting to a printer (B)

4. Click OK.
When the connection is established, Objet Studio is configured to prepare
print jobs for that printer.

If you can see the material levels in the "Job Manager Screen" (see Figure
5-101 on page 5-81), Objet Studio is connected to the printer.

Note: A printer can be listed by its name or by its computer's IP address.

Offline Mode

You can use Objet Studio to prepare trays for printing in offline mode, on a
remote computer or when the printer connection is not available. You also use
offline mode to prepare trays for printing with other printers. In this case, if
Objet Studio is currently connected to a printer, you must change to offline
mode by removing this connection.
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To disconnect Objet Studio from the printer:

>
1. On the Job Manager ribbon, in the 3D Printer group, click ==

2. Inthe Set Printer Features dialog box, click Connect (see Figure 5-102 on

page 5-83).
Set Printer Features Ps__<|

Printer
Deskiop
Eden
Connex
Obijet260
Obijet350
Objst500

Figure 5-104 Disconnecting Objet Studio from a printer (A)

3. Inthe Printer Connection dialog box, delete the computer name/IP address.

Printer. Connection

Enter printer name/P address.

(Browse.. |

Use 'Unknown' for off-line mode.

Figure 5-105 Disconnecting Objet Studio from a printer (B)
4. Click OK.
“Unknown” appears in the printer-name field.

5. Click OK.
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6. Inthe pop-up message, confirm that you want to work in offline mode by
clicking No.

I Job Manager

1) Ohbijet Studio is in off-ine mode,

Do you wank Eo conneck o a 30 printer?

[ es §|[ Ma ]

Figure 5-106 offline message

When Objet Studio is in offline mode, you can configure it for preparing print
jobs for different printers.

To change the Objet Studio offline configuration:

1. Inthe Set Printer Features dialog box, select a printer type.

Set Printer, Features r5__<|
Frirter
Desktop
Eden
Connex
Obijet260
Obijet350
ooett Q = D
Ok

Figure 5-107 offline printer selection

2. Click OK (not “Connect”).
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Setting the Remote Printer Connection (Client Mode)

When you open Objet Studio for the first time in a client installation, you are
prompted to connect to a server computer that sends jobs to a 3D printer. To
do this, the server computer must be operating and connected to the local
network.

To set (or change) the connection to the server-computer:

2
1. On the Job Managerribbon, in the 3D Printer group, click “m=,

2. Enter the name of the server computer or its IP address, or click Browse to
find and select it.

3. Click OK.

Specify Server Computer name/|P address.

Browse...

Usze ‘Unknown' for off-ine made.

Figure 5-108 Printer Server Connection dialog box

Job Manager Commands

The Job Manager ribbon has three icon groups:

O 3D Printer
O Queue
O Job

P ¢ (Hadde0Oeese

Connect Motifications | Top Up Down Botbom | Restart Stop Resume Delete View  Edit
30 Printer Queue Job
Figure 5-109 Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example, since
you cannot stop printing a job that is not being printed, the Stop command is
disabled when the printer is idle.

Job Manager icons are described in the table on the next page.
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The following operations are available on the Job Manager ribbon:

Group |Icon Purpose
3D v Server: Sets the printer connection. See "Setting the Printer
Printer | connes Connection" on page 5-83.
Client: Sets the server connection. See "Setting the Remote Printer
Connection (Client Mode)" on the previous page.
=) Configures options for printer alerts. See "Configuring User Alerts" on
MokFicat page 5_90
Queue | 3 Server: Moves a job to the head of the Jobs Queue.
T“’ Client: Disabled.
See "Jobs Queue" on page 5-82.
= Server: Moves a job to a higher position in the Jobs Quevue.
- Client: Disabled.
See "Jobs Queue" on page 5-82
7 Server: Moves a job to the bottom of the Jobs Queue.
Lo Client: Disabled.
See "Jobs Queue" on page 5-82.
5 Server: Moves a job to a lower position in the Jobs Queue.
| Client: Disabled.
See "Jobs Queue" on page 5-82.
Job 2. Server:
Rastat » Forajob in the Jobs Queue—Prints it again (from the beginning).
» Forajob in the History list—Moves it to the Jobs Queue for
printing.
Client: Disabled.
See "Restarting Jobs" on page 5-93.
01 Server: Stops a job in progress.
S Client: Disabled
- Server: Continues printing the current job from the point where print-
ety ing stopped.
Client: Disabled.
See "Resuming Jobs" on page 5-93.
b Removes the selected job from the queue.
Dbt
= Refreshes the image of the selected job in the Tray Preview display.
b
2 Opens the Tray Settings screen and displays the tray. For deleted
-

jobs, this enables you to make changes before printing.
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In addition to using ribbon command icons, you can use commands on context
(pop-up) toolbars and from the Job menu on the standard toolbar.

Restart
&
Stop - é-‘—— Delete
a’ r
Edit —""} hk_— Resume
. d_
Export packedjnh"’fz Schedule

Figure 5-110 Icons on pop-up toolbar (server)

E —— Delete
Edit "4
-

Figure 5-111 Icons on pop-up toolbar (client workstation)

Note: Mosticons and menu commands are only enabled when a job is
selected.

When you position the cursor over an item, a tooltip displays the name of
the command.

Job ~ Tools = Skwle -

I@ Skop...

*. Delete 1ob...

Show 3dProgress

& Export ...

Figure 5-112 Job menu options (server)
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Configuring User Alerts

Objet Studio can alert you (and others) to the status of jobs sent to the server
for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:

* The level of model or support material is low.
* The job was interrupted.

* The job was completed successfully.

To send e-mail and SMS alerts, make sure that e-mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular
phone service must support the transmission of e-mail messages by SMS.
Only the subject line of the e-mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:

4
1. On the Job Manager ribbon, in the 3D Printer group, click T

Notifications g|
Sound Alert
@ (&) Voice Messages ) PC Speaker
7

Feport to Printer

HP Dreskl ot S30C/332C/335C [ Piner.. |
Report to s-mail
T Add Fecipient.

John h

Fremove Reecipient]

i
Add Recipient.

[¥] Repot via 5MS

A RenindMe |15 min | Before Cartiidges Emply

A RenindMe |100g v | Before Cartiidges Emply

Figure 5-113 Notifications dialog box (server)

Notifications @

Sound Alert
@ () Voice Messages () PC Speaker
s
[] Repot ta printsr
poit ko e-mail
Add Recipient..
[J Repoit via SMS
0K Cancel

Figure 5-114 Notifications dialog box (client workstation)
2. Set the desired reporting options.
3. Click Details.
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x|

Select Events to report on;
Successful job finish
Job interuption

End of Material reminder

[ Ok ] [ Cancel ]

Figure 5-115 Event selection for alerts
4. Inthe Reports Events dialog box, select the alert events and click OK.

5. Inthe Notifications dialog box, click OK.

Printing from the Jobs Queue

If there is a job in the Jobs Queue, it is sent automatically to the Stratasys
PolyJet printer—as long as it is on, there is a connection to the printer, and the
printer is on line.

Chapter 6 describes starting and operating the printer.

Additional Server Features

Objet Studio on the printer server includes the following additional features:
» Extended Tray Preview
+ Editing Jobs
* Restarting Jobs
* Resuming Jobs
» Scheduling Jobs
» Exporting Jobs (objzf)
* Modifying the Job Manager Screen
These features are described below.

Extended Tray Preview

In this window, you can view the tray from different angles and magnifications
without leaving the Job Manager screen. In addition to displaying the selected
jobin the Tray Preview pane, you can open an enlarged build tray window.

To display the build tray window:

1. Selectajobin the Jobs Queue or the History list.
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2. Click the Tray Preview pane.

ré@@@ﬁiﬂlﬁlf_ii-'@;

.B‘-ack

Figure 5-116 Job Preview

[ To change the tray magnification, turn the mouse wheel.

O To view the tray from a different perspective, click the relevant icon.

O To resize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more from
being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:
1. Double-click on the object you do not want to print.

2. Display the Build tab.

3. Select Exclude from Build.

2-0148.5tl

|Info | Options | Build |

Exclude from Build

0Objet Studio

' : Are you sure you want to exclude this model from build process?
.

Figure 5-117 Excluding a model from the build

4. Click Yes to confirm.

On server computers, you can use Tray Preview to dynamically display objects
as they are printed, layer by layer. This enables you to visually monitor printing
progress on the computer screen.

To display printing progress in the Tray Preview pane:
> From the Job menu, select Show 3dProgress.

% This option uses additional system resources.
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Editing Jobs
You can open jobs in the Jobs Queue for editing.

To edit a job:
1. Select the job.

2. Click the Editicon & .

The Tray Settings screen opens, displaying the build tray. The status of the
jobin the Job Manager screen changes to “Editing.”

3. Editthe job.

Iy
=

4. Onthe Tray Settings ribbon, click w s
The status of the job in the Job Manager screen changes back to “Waiting.”
Restarting Jobs
You can restart jobs from the Jobs Queue and the History list.

To restart a job:

1. Select the job.

"

2. Click the Restarticon === _
The job status changes to “Waiting” (in the Jobs Queue).
Resuming Jobs

If the printing process is stopped or interrupted, you may be able to continue
printing the job from the point where printing stopped.

When resuming a print job, the printer tray does not move. The printer expects
Objet Studio to send the slice from where the stoppage or failure occurred.

To resume printing:
1. Select the job.

v
2. Click mesee
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Scheduling Jobs

You can schedule jobs to be printed at a future time. For example, you can

configure Objet Studio to start long printing jobs in the late evening and early
morning hours.

To schedule a job:

1. Selectajobin the Jobs Queue, and click Jb}* on the pop-up toolbar.

2. Inthe Scheduler dialog box, set the Start Date and Start Time for the job.
Click on the Start Date arrow to open a calendar.

Iv Start Printing job in schedule:

Start Date: Sunday  11/04410 -
Bl apiizonn

Sun Man Tue Wed Thu Fi Sat |-
12 3

4 5 6 7 8 3 10
[ 12 13 14 15 16 17
1|13 20 21 22 23 M
25 26 27 28 23 30 J

— Today: 4/11/2010

Figure 5-118 Scheduler with calendar displayed
3. Click OK.
Exporting Jobs (objzf)

You can save print jobs as compressed files.
%{ For an explanation of objzffiles, see "Saving Build Trays" on page 5-65.

To export a print job:

Select a job. R

On the pop-up toolbar, click I

In the Save As dialog box, select a folder.
Click Save.

A\
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Modifying the Job Manager Screen
You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:
* the Jobs Queue panel
* the Time panel

» the History panel

Similarly, you can change the way the screen area is divided between the main
section (Jobs Queuel/ Time/History) and the panels on the right side of the
screen.

You can collapse (hide) the right panels (Available Resources/Material
Consumption/ Tray View) by clicking the top of the panel.

> Click again to display the panel.
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Frinter cover

Filtercumpartmerrt\

Waste compartment
Figure 6-1 The Objet260 3D Printer

Starting the Printer

Caution

¢ Do not attempt to operate the printer before being trained by an authorized
Stratasys representative.

¢ Observe all safety warnings and follow the safety guidelines described in
Chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2 Main power switch

The main power switch turns on the Objet260 printer, which includes the
built-in computer.
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2. After the printer-control computer boots, log in to Windows and launch the
printer-control program:

(3 On the printer-computer desktop, double-click the Objet260 printer icon.
or—

O From the Windows Start menu, select (All) Programs > Objet >
Objet260.

%( A HASP plug containing a valid product activation key is required on the
printer computer. This is supplied during printer installation or upgrade. If
the application does not open and a HASP message appears, contact your
Stratasys dealer or service provider.

All monitoring and controlling of the printer is done from this interface.

File” Opgtions Help

20 Mar 2014 17:45

Printer mode 1
| 400 gr 400 gr J
\ M.Cleanser M.Cleanser |
|

\

r Model materials

1 400 gr 400 gr

Current activity

M.Cleanser M.Cleanser

Previous job last slice: 0

S.Cleanser S.Cleanser

— Support materials

Display

toggle button — —— ORJET 260

— Online/offline button

Stop button Pause button

Figure 6-3 Printerinterface

QE{ Objet260 installations use one monitor for displaying both the computer
running Objet Studio and the computer installed inside the printer. Make
sure that the KVM (keyboard-video-mouse) switch is in the correct position
so that the printer interface is displayed.
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Loading Model and Support Cartridges

Objet260 printers use up to six cartridges of model material and two cartridges
of support material, each weighing 3.6 kilograms when full.

The material cabinet contains a module that identifies loaded printing
materials. Tampering with this module will render the printer inoperable and
may void Stratasys warranties and service contracts.

Important: If you need to replace the printing material currently installed with
another type, see "Changing the Printing Material" on page 6-13. Otherwise,
make sure to replace the material cartridge with one containing the same type
of material.

To load model and support material:

1. Load model and support cartridges into their respective compartments.
You should feel some resistance, as a needle pierces the cartridge seal.

2. Check the printer interface to make sure that the new cartridge is detected
and that its weight is displayed (see the figure on the previous page).

3. Close the material cabinet.

Tips about loading and replacing material cartridges:

¢ You can replace material cartridges either before or during printing.

¢ You can replace a partially used cartridge to avoid the need for replacing it
during printing.

e The cartridge type is automatically detected by the printer. If you replace a
cartridge containing different model material, a message appears
recommending that you run the Material Replacement wizard to flush out
the old material.

« If printing stops for an extended time before you replace a material
cartridge, the printer may go into Standby or Idle mode. If this happens, see
"Resuming Production After Printing has Stopped" on page 6-10.
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Producing 3D Prints

3D print can be produced after they are arranged on a virtual build tray in a 3D
printing application. Two such applications are available for preparing trays for
printing on the Objet260 printer:

» Objet Studio

» GrabCAD Print (for Connex3 printers)

For information about preparing files for printing, see the relevant
documentation—

* "Using Objet Studio" chapter in this user guide or Help in the Objet Studio
application.

* GrabCAD Print online documentation.

Preparing the Printer

Before beginning to produce 3D prints, it is recommended that you check the
current printing quality of the print heads by performing the Pattern Test.

To prepare the printer for printing:
1. Make sure that the build tray in the printer is empty and clean.

2. If not, remove cured material with the scraper, and clean the tray thoroughly
with a cleaning cloth soaked with 90% alcohol (IPA or ethanol).

Caution

Use protective gloves when cleaning the build tray, and be careful of the
sharp edges of the scraper blade.

3. Make sure that there is sufficient model and support material loaded, as
indicated on the printer interface (see the figure on page 6-4). You may
want to replace the cartridges of model and support material currently
loaded in the printer to avoid the need for replacing them during printing.

Note: When you click Printin GrabCAD Print, a warning message appears if
there is not enough of one or more material.

For loading material cartridges and replacing empty ones, see "Loading
Model and Support Cartridges" on the previous page.

For changing the type of material currently loaded, see "Changing the
Printing Material" on page 6-13.

For installing material cartridges and replacing empty ones, see "Loading
Model and Support Cartridges" on the previous page.
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You can monitor printer status by switching the printer interface display. To do
this, click the display toggle button on the printer interface screen.

Temperature behind

print block 3
Temperature of each Temperature of each
Support head ISR e S S Model head

Temperature in

front of print block | Support/Model material

‘ in print block reservoir

Waste weight — BEEIUES

Ambient(°C) ss === Vacuum level
Chamber——’

temperature Temperature of

Left UV lamp — material pre-heaters

OBJET 260

Right UV lamp — \- Display toggle button

Printer set to online
mode (green)

Figure 6-4 Printer status

Starting Printing

To begin printing:

> On the printer interface, click the red button to switch the printer to online
mode.
The color of the button changes from red to green (see the figure on
page 6-4). If there is a job in the Job Manager queue, itis sent to the printer.
If there is a job in the printing queue, it is sent to the printer.

When switching the printer to online mode, a message is displayed if a
maintenance activity is required to ensure optimum printing quality. (See
"Routine Maintenance Schedule" on page 6-26.) Maintenance notifications
can be disabled/enabled from the Options menu.

In the printer interface, the printer mode changes from /dle to Pre-print, as the
printer's components prepare themselves for production:

* The print block is heated.

* The UV lamps are powered and they warm up.

When printing begins, the print manager program sends a number of slices to
the printer-control application. This fills the buffer between the print manager
and the printer to ensure continuous printing. As each slice is printed as a layer
on the build tray, another slice is sent to the printer.

Depending on the size of the 3D print(s) to be produced, printing can take
between several hours to several days. As long as there is enough model and

support material in the supply cartridges, printing proceeds automatically until
the job is finished.
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%{ During printing, the server computer must remain on and it must
communicate with the Objet260 printer. Do not log-off Windows until
printing is finished.

The Objet260 printer uses one, two or three model-material cartridges and one
Support-material cartridge to produce 3D prints. If additional cartridges are
installed and they are not immediately needed for printing, the printer interface
indicates this (see "Printer Interface Color Key" below).

* Blue cartridge—active
» Gray cartridge—standby

Printer Interface Color Key

The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.

* Green—suitable/ready for printing
For example, in Figure 6-4 on the previous page:

[ Heads (°C)—The heads have reached the temperature required for
printing.

O Ambient—The ambient temperature of the printing chamber is within
the acceptable range.

O Heads Liquid—The level of model and support material in the
print-block reservoir is OK.

[ Heads Vacuum—The vacuum level in the system is within the
acceptable range.

O Pre-Heaters—The model and support resins have been heated to the
required temperature before being supplied to the print block.

* Blue—not ready
For example, in Figure 6-4 on the previous page:

O UV lamps—The UV lamps are not on.

* Red—not suitable for printing (or indicates a warning)

O Waste—The weight of the waste container is 9000 grams, more than
allowed when beginning a print job. (See "Replacing the Waste
Container" on page 6-90.)

The color of the material cartridges displayed in the printer interface indicates
which cartridges are active for the current (or next) print job.

For example, in Figure 6-3 on page 6-4:

* Blue—active cartridge

» Gray—reserve cartridge
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Printing Indicators

The printer interface screen changes when you send a print job to the printer, if
the printer is online:

» The mode changes from Pre-print to Printing.

* The specific activity being performed is shown in the “current activity” field.
* Current job-printing information is displayed.

* The printing progress bar is displayed.

» The Stop and Pause buttons are enabled.

Printer mode

Job information

Current activity

Job information

1
|
¢

|
L
1

VeroBlue

M3L

40091
VeroBlack

M2L

400gr

Verowhite

M-1L

40091
Fullcure705

160ct2012  19:14
Veroblue

M-3R
400 gr J
Veroblack

400 gr
Verowhite

M-1R

400 g
Fullcure705

st SK =B | Progress bar

OBJET 260

Stop button Pause button

Figure 6-5 Printer interface during printing
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Resuming Production After Printing has Stopped

If the printing process is interrupted, the print manager stops sending slices to
the printer. This can happen, for example, if the printing material runs out in the
middle of a print job, and you do not replace the empty cartridge immediately.
After the printer changes to Standby or Idle mode, you need to resume printing
from the Job Manager screen of Objet Studio. After the printer changes to
Standby or Idle mode, you need to resume printing from the print manager (in
Objet Studio or in GrabCAD Print).

After printing stops, the printer goes into Standby mode, when heating of
the print heads is reduced. About 10 hours later, the printer goes into /dle
mode, when heating of the print heads is stopped.

To continue printing from GrabCAD Print:

1. Ifthe printer is in offline mode, switch it to online mode by clicking the red
button at the bottom of the printer interface.

The button changes from red to green.

2. If you don’t know why printing has stopped, make sure that the connection
between the printer and the server computer is active.

3. Inthe Manager screen of Objet Studio, or in the Schedule screen of
&

GrabCAD Print, click the Resume icon—Ff=sw= or .

Note: To display the Resume icon in GrabCAD Print, click on the job in the
Schedule screen.

4. Inthe Continue from Slice dialog box that appears, confirm the slice
number, after checking the printer interface.
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5. Inthe job-preparation application, make sure that the correct slice number
is entered in the dialog box.

Continue from Slice: (x|

163

[k | Cancel |

Figure 6-6 Slice confirmation in Objet Studio

Print Job 1l.Impeller GrabCAD
Last printed shce 168

Resume printing by choosing a slice number

Slice number 169

Figure 6-7 Slice confirmation in GrabCAD Print

Printer mode

Print Time 00:00:43

Height 5.29mm of 77.88mm

Slice 168 of 2782 (6.8%)

Previous job last slice Last slice printzd

Figure 6-8 Printer interface after interrupted printing

6. If, for any reason, the correct number does not appear in the dialog box,
enter the number and click OK.

You cannot continue printing if:

» The number of the last slice printed does not appear in the printer interface,
even if the server computer displays the Continue from Slice confirmation
dialog box.

» There was a relatively long interruption in printing, even if the “last slice” and
“continue from slice” indicators are correct. This is because the part already
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printed might slightly deform or shrink before printing continues, causing a
visible difference between it and the part printed later. The effects of a
printing stoppage depend on part size and structure, the model material
used, ambient temperature and the length of the stoppage.

If you cannot continue printing:

1. Cancel the job in the printing application (Objet Studio or GrabCAD Print).
In GrabCAD Print, you do this from the Schedule screen:

O Right-click on the job to display the pop-up menu, and select Cancel
job.

Resume job
Reprint job

Cancel job

OR—
O Left-click on the job to display the Job Status details, and click the

Cancelicon .

2. Remove the partially printed 3D print from the build tray.
3. Restart the job from the Job Manager screen (in Objet Studio).
4. Resend the job to the printer from the printing application.

&

3 In Objet Studio, click #=sume

O In GrabCAD Perint, click .

%{ You can stop printing from the printer interface or from the printing
application (Objet Studio or GrabCAD Print).

* After clicking the Stop button in the printing application, you can resume
printing from the printing application or from the printer interface.

* After clicking the Stop button on the printer interface, you can resume
printing only from the printing application.

» After clicking the Pause button in the printer interface, you can resume
printing only from the printer interface.
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Changing the Printing Material

Before producing 3D prints using a different type of printing material than is
currently installed, run the Material Replacement wizard to flush the print block
and feed tubes.

%( After changing support material with the wizard, Head Optimization is
required before printing.

% You should carefully plan production of 3D prints the with different materials
to avoid unnecessary waste of the materials currently loaded. The amount
of material flushed depends on the flushing cycle chosen and if you are
replacing one or more cartridges.

The Material Replacement wizard suggests the best slot locations for
placing different material cartridges, based on the materials currently in the
system. This ensures minimum flushing of materials currently loaded.

Note: When performing manual material replacement, certain replacement
options are blocked to protect the system. In these cases, follow the
recommendations of the Material Replacement wizard for best replacement
options.

To replace the printing material with the wizard:

1. Start the Material Replacement wizard from the Options menu.

File  Options Help

Go to Tray Upper Position

Go to Purge Position 24 Sep 2015 9:49
Wipe

Go To Head Inspection

w Purge Sequence F4 r
Pattern Test
Wizards 3 Material Replacement

\_f Built In Tests... Ctrl+Alt+B Wiper Cleaning f

Head Cleaning

Collect Service Data Head Filling Calibration
3 UV Calibration {

UV Lamp Replacement

| Maintenance Counters...

Head Alignment

Head Optimization
Previous job last slice: 0 Load Cell Calibration

Shutdown

Figure 6-9 Starting the Material Replacement wizard
2. Inthe opening screen, click Next.

3. Ifthe printer cover is not closed, a screen appears, prompting you to close
the cover. Confirm that it is closed and click Next.
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Material Replacement Wizard
Material Replacement Options
Printer Configuration
Single matenal (HQ., HS)
@ Multiple matenials (DM)
Reguired Model Materials Required Support materials
MNote: Cartidge positioning in material cabinet is determined autormatically.
| veroCyan - VeroMagnt = | vereYeliow - FullCure705 M|
¥ Both cartridges | Bath carridges ¥ Both cartridges 4| Bath carridges
Flushing Cycle
@ Full @ Full @ Full
Economy Economy Econamy
‘Full’ provides you with exact color immediately
‘Economy’ enables a faster malerial replacement cycle
| 2 Hep | | Advanced Settings.. | X Cancel Nest 3

Figure 6-10 Material replacement options

In the Material Replacement Options screen, you select the settings that
determine how the wizard replaces material currently in the system with
newly loaded material.

. Choose whether you want to produce 3D prints in Single Material mode or

in Digital Material (“multiple-materials”) mode.
Single Material mode

Four print heads are used to print, using one model material.

O This mode is required to produce build trays with the High Quality
setting, and to produce trays with the High Speed setting, using only
one model material.

Digital Material mode
Each of the model materials loaded is used in two of the print heads.

O If only one of the model materials is required for printing, 3D prints are
produced using two print heads. This makes it unnecessary to replace
the other model material.

O If model-material substitution is allowed, the printer produces trays with
the High Speed setting using a mixture of model materials (see "Model
Material Substitution" on page 1).

. In the Required materials section of the wizard screen, select one or more

replacement materials cartridges.

. For model materials, select Both if you need to load two replacement

cartridges.

Loading one replacement cartridge is more economical because it
potentially requires less flushing of material currently in the system.
However, when one cartridge is not sufficient, loading two cartridges
enables continuous printing until the print job is completed. When one
cartridge empties and the other one is being used, you can replace the
empty cartridge with a new one.

. For Support material, select Both if you need to load two replacement

cartridges.
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8.

In the Flushing cycle section of the wizard screen, choose how thoroughly
you want to flush out material currently in the system:

O

Economy. This cycle can be used when replacing a light-colored model
material with a darker material (such as Agilus30 Black™ or
VeroBlack™) or if the exact color of the 3D print is unimportant. Use this
cycle when replacing cleaning fluid with any model material.

The wizard flushes the system with the minimum amount of material
needed to ensure that 3D prints have the mechanical properties of the
new material.

Full. Use this cycle when the 3D print must have the exact color of the
new material. This cycle should also be used before printing with
MEDG610 or MEDG620, if any other model material is currently loaded in
the printer.

The wizard thoroughly flushes the feed tubes and print heads needed
for printing, based on your selections in the previous screens.

There are additional settings that you can select for special purposes (see
"Advanced Settings"). If necessary, click Advanced Settings before
clicking Next.
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9. Click Next to begin the material replacement process in the printer.

The Cartridge Positioning screen appears, showing you the new location of
all cartridges in the material cabinet.

Material Replacernent Wizard

Cartridge positioning and process progression
L R Insert the new material cartridge as shown below. and click Start.

Left Right

M3 VeroMgnt \4 VeroMgnt v
M2 VeroCyan VeroCyan (X]
M1 VeroYellow (X VeroYellow (X]
Suppet  mmmmmeee FullCure705 @
Start... ]

Replacement progress

[ 0%

Stratasys

[ X Cancel | [ € Brevious|

Figure 6-11 Cartridge placement
Symbols:

¥ The correct cartridge is in this slot.
“ No cartridge (or the incorrect cartridge) is in this slot.

“ The cartridge in this slot has insufficient weight to complete the material
replacement process.

Y The expiration date of the cartridge in this slot has passed.

10.Replace material cartridges as necessary, according to the instructions in
the wizard screen.

11.Click Start.

12.Read the warning message, and click OK.

%{ If you continue, you must complete the material replacement process

DOC-37004 Rev. J

before you can produce 3D prints. To replace material cartridges at another
time, click Cancel. If you continue (by clicking OK) and you do not complete
the process, you will need to run the wizard again before producing 3D
prints.
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Matenal Replacement Wi

Material replacement completed
Prrter's cusmant corhouston
Laft Right

VeroBlue VeroBlue
VeroBlack VeroBlack
M1 VeroWhite VeroWhite
Suppo FullCure705 FullCuref05

Printing mode: Digital materials (DM)

aF
Stmmsﬁ Important: After cloging this wizard, chean the ares around the purdge unit.

v [lone

Figure 6-12 Final wizard screen

13.In the final wizard screen, click Done.

The printer-control application is automatically updated, and it restarts.

When it opens, the interface displays the new material(s). Objet Studio (on

the server computer) is also updated and displays the new material(s).

The interface in the job preparation application is also updated, and it

displays the new material(s).

14.Inspect the area around the purge unit and clean it, if necessary.

After changing the type of Support material, you need to run the Head
Optimization wizard before printing. See "Optimizing (Calibrating) Print

Heads" on page 6-46 .

DOC-37004 Rev. J
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Printing With Bio-Materials

To ensure the bio-compatibility of printed parts when changing from standard
printing materials to bio-compatible materials, follow the instructions for
loading the relevant material. To download the required document, search for
"Biocompatibility Requirements" on the Stratasys Support Center.

Advanced Settings

The Advanced Settings dialog box enables you to configure the Material
Replacement wizard for special purposes. If necessary, click Advanced
Settings in the Material Replacement Options screen before clicking Next.

Advanced Settings

. - oning
% Afomatc slof selaction (Recommended)
I~ Marusl siol salection

This selachon appkas o ths wss of the wizard only.

Select matenal most used in Single matenal mode (optonall)

E—

< Corcel || coon 3 |

Figure 6-13 Advanced Replacement settings

Positioning

By default, Automatic slot selection determines the best slot locations for the
cartridges in the material cabinet, based on materials currently in the system.
This ensures minimum flushing of materials currently loaded.

Select Manual slot selection—

« if there is a special need to load cartridges in certain slot locations.

« if you only want to change one of the cartridges for a given material
channel.

Some materials cannot replace certain other materials. If you attempt to do
so, the wizard notifies you.

To select the slots for the cartridges manually:

1. Inthe Material Replacement Options screen, click Advanced Settings.
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2. Inthe Advanced Settings screen, select Manual slot selection, and click
Apply.

Material Replacement Wizard

Advanced Settings

Cariridge positioning:

() Automatic slot selection (Recommended)

@ Manual slot selection

This selection applies to this use of the wizard only.
Optional settings:

[] Enable flush again” options

-/ Stratasys

Figure 6-14 Manual slot selection

This selection applies to this use of the wizard only.

[ € Cancel | [ dprly 3|

3. Inthe Material Replacement Options screen, Both cartridges is selected
for each position. To print with only one of the cartridges, clear the check
box and then select either the left (L) or the right (R) cartridge.

DOC-37004 Rev. J

Material Replacement Wizard
Material Replacement Options
Printer Configuration
Single material (HQ, HS)
9 Multiple matenals (DM)
Required Model Materials Required Support materials
Material 1 Material 2 Material 3
|verovelion VeroCyan - [veroMant b | Fullcure705 -
[7] Both cartridges Both eartridges [7] Both cartridges Both cartridges (L
L
- |
Lala
Flushing Cycle
@ Full @ Full @ Full
Econormy Econamy Econormy
'Full’ prevides you with exact coler immediately
‘Economy’ enables a faster matenal replacement cycle
[ 2 Hep | |Advancedsetings..| [ % cancet [ Hewy

Figure 6-15 Manual cartridge selection
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When printing in High Speed mode (three materials), the same material is
used in both sections of each print head. The material selected for one of
the cartridge slots is also used in the other print head channel.

L R

Indicates
manual-placement
Required materials: mode
Material 1 Material 2 Material 3 \
’\c’eroWh ite: w7 ] ’\c’eroBIack 7 ] ’\c’eroBIue s ] ;'\
[7 Both cartridges Both cartridges [ Both cartridges w
L

R |

Figure 6-16 Manual cartridge selection—3 model Materials

4. After selecting the materials for the appropriate cartridge slots, the
Cartridge Positioning screen appears. Place the cartridges in the materials
cabinet as shown in this screen.

Material for Single Material mode

DOC-37004 Rev. J

If you regularly use a certain material for printing in single material mode, and if
this material is currently loaded in the printer, you can select it from the drop-
down menu. The wizard will take this into account when determining the new
cartridge locations. When possible, the selected material will remain in parts of
the system (cartridge slots, tubes, print block) so that it is available when next
needing it. This option is recommended if you often switch between single and
multiple-material modes because it can reduce the amount of material flushed
during replacement.

6-20



Objet260 User Guide

6 Operating and Maintaining the Printer

Additional Flushing Cycles
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The flushing cycle you select in the Material Replacement Options screen

determines how thoroughly to flush out material currently in the system. After
selecting the Economy cycle and completing the wizard, you might decide that
you require a more thorough flushing, to ensure accurate colors. Or, you may
notice that the 3D prints are not satisfactory because they contain traces of the
previous material. If so, you can flush out more material, so that the next print
job will be printed with pure material.

To perform additional flushing cycles:

> |n the Advanced Settings screen, select Enable "flush again" options

and click Apply.

Material Replacement Wizard

stratasys
2 Help

Advanced Settings

Cartridge positioning:
@ Automatic slot selection (Recommended)
_ Manual slot selection

This selection applies to this use of the wizard only.
Optional settings:

Enable “flush again” options
This selection applies to this use of the wizard only.

[ € Cancel | [ donb 3 | |

Figure 6-17 Enable flush again options selected

The Material Replacement Options screen appears, where you can select the
material(s) you need to flush again.
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Keeping the Printer in Idle Mode

DOC-37004 Rev. J

Between printing jobs, the printer can be left unused for up to one week. If the
printer will not be used for more than a week, use the Shutdown wizard to
automatically perform the procedures that must be done before turning off the
printer (see "Shutting Down the Printer" on the next page).

When the printer stops printing, the printer software automatically reduces the
temperature of the print heads, as follows:

After printing stops Mode Change in heating of
print heads

first 15 minutes Standby 1 no change

next 10 hours Standby 2 heating reduced

(to room temp.)

after Standby 2 Idle heating stopped

Note: The printer mode is indicated in the upper left of the main printer
interface screen (see the figures on pages 6-4, and 6-9).

If, after printing a job, you know that the printer will not be used for 10 hours or
more, you can immediately turn off the heating of the print heads by putting the
printer into Idle mode.

To put the printer into Idle mode:

> From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the printer application
and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this
mode—with the cover closed—for up to a week. For longer periods, shut
down the printer by running the Shutdown wizard (see "Shutting Down the
Printer" below).
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Shutting Down the Printer

You only need to shut down the printer if it will not be used for 30 days or more.
Otherwise, the printer can remain on, in Idle mode. However, if there is a need
to turn off the printer sooner, use the Shutdown wizard to automatically perform
the necessary processes before turning off the printer

% The Shutdown process flushes printing materials from printer components.
To avoid flushing out valuable material, make sure to print at least once a

week. Many printer operators use this opportunity to print customer
samples or test parts.

To properly shut down, the printer needs to perform several processes. These
are controlled by the Shutdown wizard. Except for immediate servicing, do
not attempt to shut down the printer by simply closing the computer
interface (the printer-control application), and never disconnect power
to the printer before completing this wizard.

& Caution

Turning off the printer for an extended period without first running the wizard
can cause serious damage to print heads and other expensive printer parts.

Depending on the length of time the printer will not be used, you can choose
between a short shutdown procedure, and a more thorough procedure.

* Up to 10 days: The wizard empties the print block of model and support
material, to prevent leaks. This takes about 10 minutes.

* More than 10 days: The wizard empties the print block, then flushes the
system with cleaning fluid. This takes up to 35 minutes, and you must be
present to load a cleaning-fluid cartridge when instructed.

Note: Before selecting More than 30 days, make sure that the following
cartridges are available (each containing a minimum of 250 grams):

[ Three (3) Model cleaning-fluid cartridges
3 One (1) Support cleaning-fluid cartridge

DOC-37004 Rev. J 6-23



Objet260 User Guide

6 Operating and Maintaining the Printer

To run the Shutdown wizard:

1. Start the Shutdown wizard from the Options menu.

Shutdown Wizard

-~ .,

i; G%/s
—

stratasys

Shutdown Wizard

This wizard controls the processes necessary for shutting
down the printer.
Press 'MNext' to continue or 'Cancel' to quit.

Shutdown Wizard

= ~

a9y
N /

-/ Stratasys

Shutdown Wizard

You can leave the printer in an idle state for up to 10 days.

Use this wizard whenewer you want to shut down the
printer. Do not atternpt to shut down the printer by turning
off the printer computer, and never disconnect power to
the printer before completing this wizard.

‘When shutting down the printer, you hawe two options,
depending on the length oftime the printer will not be
used:

-Upto 10 days: This process takes up to 10 minutes.

-More than 10 days: This process takes up to 35 minutes.

x LCancel |

Figure 6-18 Shutdown wizard, opening screen

2. Click Next.

3. Select the option corresponding to the length of time that the printer will not
be used—Iless or more than 10 days.

Note: Before selecting More than 10 days, make sure that cleaning-fluid
cartridges are available.

Shutdown Wizard

-/ stratasys

4 Help

Select Action

Shutclown the printer for:

" More than 10 days [requires cleaning-fluid cartidges).

Figure 6-19 Shutdown options
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4. Inthe next screen, verify that the tray is empty and click Next.
The shutdown procedure begins.

Shutdown Wizard

Shutdown in Progress

ity

- Stratasys

Figure 6-20 Shutdown progress

Shutdown Wizard

N Wizard Completed
You may now shut down the printer computer and turn off
power ta the printer.
- Stratasys

Figure 6-21 Final Shutdown wizard screen

5. After the printer computer shuts down, turn off the main power switch at the
back of the printer (see Figure 6-2 on page 6-3).
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Maintaining the Printer

Performing routine maintenance tasks is essential for getting satisfactory
results from your printer. Perform the tasks at specified intervals.

Routine Maintenance Schedule

Frequency

Task

For More
Information

Before printing

Clean the UV lamp lenses.

See "Cleaning the
Print Heads and the
Roller" on page 6-
29.

Before / after printing

Check the UV lamp overheating indicator.

See "UV Lamp
Check " on page 6-
29.

Before / after printing

Clean the print heads and the roller surface.

See "Cleaning the
Print Heads and
the Roller" on
page 6-29.

Daily

Clean and inspect the wiper.

See "Cleaning and
Replacing the
Wiper" on page 6-
32.

Weekly

Perform the Pattern test.

See "Pattern Test"
on page 6-34.

Weekly—when printing with
Biocompatible materials

Calibrate the UV intensity.

See "Testing and
Calibrating the

UV Lamps" on
page 6-64.
Weekly Restart the printer computer and the
server computer.
Weekly Clean the roller waste collector. See "Cleaning the

Roller Waste
Collector and
Inspecting the
Roller Scraper” on
page 6-36.

Every 300 hours of printing (A
reminder message appears.)

Calibrate the UV intensity.

See "Testing and
Calibrating the
UV Lamps" on
page 6-64.

Every 300 hours of printing (A
reminder message appears.)

Optimize the print heads.

See "Optimizing
(Calibrating) Print
Heads" on page 6-
46.

Monthly, and after replacing
print heads

Check the alignment of the print heads.

See "Aligning the
Print Heads" on
page 6-42.
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Frequency Task For More
Information
Monthly Clean debris from the Z-axis shaft with a vacuum
cleaner.
Monthly Inspect the exhaust system (duct, fan,
connections).
Monthly Calibrate the load cells. See "Calibrating
the Load Cells" on
page 6-73.

Every two years or every 3500 | Preventive maintenance visit by service engineer. | Contact your

hours of printing

Stratasys service
provider.

Maintenance Counters

DOC-37004 Rev. J

The printer computer application records the dates and frequency for each
maintenance task. You can display the Maintenance Counters screen from the
Options menu.

Dptions Help
o ko Tray Upper Position FS
20 Eo Purge Position F&
Wipe F7

Go to Head Inspection F&

Execute Purge Sequence F4

Pakktern Tesk F3

Wizards »
Heads Yolkages Calibration »
Built In Tests... Ckrl+AlE+B

Maintenance Counkers, ..
Callect Service Data h Fz

Figure 6-22 Selecting Maintenance Counters
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If there is a maintenance task due, this is indicated on the main interface
screen.

stratasys

Maintenance Required

Figure 6-23 Maintenance Required indicator

If this indicator appears, you can display the Maintenance Counters screen by
clicking on it.

&l Maintenance Counters (Hours) rz|

File  Units

Item Total Dated Warning Time Uszer Warning

Total Printing time | ‘ | | | |

&

P is Due | | ‘ | | ‘

Operator Maintenance

LIy Calibration

]

| || |
| || |

HEY | || ||
|

Heads Cleaning

]

&

Pattern Test

&

Roller Bath Inspection | | [ || Riesct

‘wiper Cleaning | N | [

Head Alignment | | | ||

Load Cel Calibration | || ||
Flestart Computer | || | [ Reset
Blade Replacement

‘wiper Blade [ || | [ [ Resst

Falker Blade [ N | [ R ] O

Figure 6-24 Maintenance Counters screen

The Maintenance Required indicator appears by default for most operator-
performed maintenance tasks. The check box under “User Warning”
controls whether or not it appears when a particular task is due.

For maintenance tasks that are controlled by wizards, the dates and printing
times are reset automatically when the relevant wizard is run and completed
successfully. Manual maintenance tasks (for example, roller inspection and
wiper replacement) are reset by clicking the reset button in the Maintenance
Counters screen.
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UV Lamp Check

A heat-sensitive label is fixed to the UV lamp covers as a warning against
overheating. Its center changes from white to black if the temperature of the
cover reaches 65°C (150°F). If this occurs, do not use the printer, and call your
service provider. As a precaution, it is recommended that you check the label
before and after printing.

Marmal

Overheating problem

Figure 6-25 Heat-sensitive label on UV lamp cover

%{ If the UV lamp continues to overheat, and the temperature around the lamp
reaches 90°C (194°F), a heat fuse turns off the electricity to the power to the
UV lamp and the motors for the X, Y, and Z axes. In the unlikely event that
this occurs, the printer cannot be used until it is serviced by an authorized
service engineer.

Cleaning the Print Heads and the Roller

Periodic inspection and cleaning of the orifice plates on the bottom of the print
block ensures that the print nozzles are not clogged. A wizard guides you
through the procedure, and adjusts components of the printer to enable you to
perform it. This procedure takes about 20 minutes, and should be done at the
beginning of the work day or before a big printing job.

To clean the print heads and the roller:

1. Prepare—
[ 90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
O disposable cleaning gloves
O a supplied cleaning cloth or equivalent
O amirror

2. Start the Head Cleaning wizard from the Options menu (see Figure 6-30 on
page 6-32).
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3. Follow the instructions on the wizard screens, and select the confirmation
check boxes.

Head Cleaning Wizard

Check Printer

Confirm before continuing:

™ The cover is closed.

<" stratasys

Figure 6-26 Tray and cover confirmation
4. Click Next.

The printer prepares for you to clean the print heads.

5. When the following screen appears, open the cover.

Head Cleaning Wizard

L Check Printer

=

\

|

Confirm before continuing:

i

[ The roller was manually rotated and cleaned.

<" stratasys

Figure 6-27 Head cleaning wizard—steps 5-11

Warning: Hot Surface

" The print head orifice plates (bottom surface) may be hot. Do not touch
them with your bare hands, and proceed with caution.

6. Place the mirror on the build tray.

7. Puton the gloves.

Caution

Uncured printing material on the print heads might cause skin irritation. Use
disposable cleaning gloves to protect your hands.

8. Soak the cleaning cloth with alcohol.
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9. Clean the orifice plates, with a back-and-forth motion (see Figure 6-28).
Use the mirror to make sure that you have removed all of the residue
material.

Figure 6-28 Cleaning the heads
10.Clean the entire roller surface, by rotating it as you clean.

Use this opportunity to clean the glass lens on the UV lamps using the
supplied sanding sponge.

11.When you have finished cleaning, select the confirmation check boxes in
the wizard screen (see Figure 6-27) and click Next.

12.Remove the cleaning materials from the printer and close the cover.

13.Select the confirmation check boxes in the wizard screen and click Next.

The head-purge cycle begins. When the process is complete, click Done in
the final wizard screen.

Wizard Completed

Figure 6-29 Final wizard screen
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Cleaning and Replacing the Wiper

A rubber wiper removes excess material from the print heads after the purge
sequence. This is done automatically before each print job, and performed
manually during maintenance tasks. You should clean the wiper and
surrounding area at least once a week. If the wiper is damaged or worn,
replace it.

To inspect and clean the wiper:

1. Prepare—
[ 90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
O disposable cleaning gloves
(J a supplied cleaning cloth or equivalent
(J aspare wiper

2. Start the Wiper Cleaning wizard from the Options menu.

File  Options Help

Go to Tray Upper Position

Go to Purge Position 24 Sep 2015

Wipe

Go To Head Inspection

Purge Sequence F4 14

Pattern Test

Wizards Material Replacement

Built In Tests... Ctrl+Alt+B Wiper Cleaning f
Maintenance Counters... IRzl g,
Head Filling Calibration

UV Calibration {

UV Lamp Replacement

Collect Service Data

Head Alignment

Head Optimization
Previous job last slice: 0 Load Cell Calibration

Shutdown

Figure 6-30 Starting the Wiper Cleaning wizard
In the opening wizard screen, click Next.

4. Make sure that the build tray is empty, and close the printer cover.
Confirm this in the wizard screen, and click Next.

Wiper Cleaning Wizard

Check Printer

Confirm before continuing:

-J .
r

[~ The build tray iz empty.

[” The cover is closed.

</ stratasys

XK Cancel | <2 | s |

Figure 6-31 Tray and cover confirmation
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5. When the following screen appears, open the cover.

f Wiper Cleaning Wizard
b Check Printer
Q Confirm before continuing:
= [ The wiper blade iz clean.
| 2" Stratasys

Figure 6-32 Wiper Cleaning wizard during steps 6-10

6. Puton the cleaning gloves.

7. Using a generous amount of alcohol on the cleaning cloth, remove any
material remaining on the wiper and the surrounding area.

8. Remove any pieces of waste material collected in the purge unit.
If necessary, remove the waste collector to clean it. Wipe the rubber seal.

Figure 6-33 Purge unit waste collector

Note: When returning the waste collector to the purge unit, make sure to
insert it as shown.

9. Inspect the wiper.
If the wiper is scratched, torn or worn, or if you cannot clean it completely,
replace it:

a. Grasp it and pull it up and out of its bracket.
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b. Insert the new wiper blade, making sure that it is straight and secured
well on both sides.

10.In the wizard screen (see Figure 6-32), confirm that the wiper blade is
clean, and click Next.

11.Remove all tools and cleaning materials from the printer, and close the
cover.

12.Confirm this in the wizard screen, and click Next.

Wiper Cleaning Wizard

| Check Printer
L}’ Confim bafore cosntinuing
- I [Thes bnskd beiy o= masvied |
_— [ T bl oy 15 il
™ The cower it clobed
' Stratasys
X Concel I

13.In the final sceen, click Done to close the wizard.

Pattern Test

The pattern test is the basic verification of the printer’s ability to produce quality
3D prints, since it demonstrates the condition of the nozzles in the print heads.
Make sure, therefore, that you perform this test weekly, and whenever you
suspect a printing problem.

To perform the pattern test:
1. Make sure that the build tray is empty.
2. Prepare a sheet of pink paper, A-4 or Letter size.

3. Inthe printer, tape the pink paper to the center of the build tray.

Figure 6-34 Paper positioned for pattern test
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4. Press F3, or open the Options menu and select Pattern Test.

File  Options Help

Go to Tray Upper Position F5
Go to Purge Position F&
Wipe F7
Go To Head Inspection F8
Go to Tray Lower Position F10
Execute Purge Sequence F4
Pattern Test F3

Dynamic Nozzle test

Wizards »
Built In Tests... Ctrl+Alt+B
Maintenance Counters... Shift+Ctrl+C
Collect Service Data F2

Figure 6-35 Selecting Pattern Test
5. Click Yes in the Confirm dialog box to begin.

i -

Confirm @

Perform Pattern Test?

[ Yes || DNo |

Figure 6-36 Pattern Test confirmation

6. Ifthe build tray is not clear, click No in the following dialog box.

T TR
TR TR
T TR
(TTRUEERHRRER IR ETUEERYEE R
TR TR AR

Figure 6-37 Sample Pattern Test
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7. Carefully inspect the test paper to see if there are missing lines.
Too many missing lines, especially if they are in the same area, indicates
that the quality of printing when producing 3D prints will be poor. If this is
the case, see "Improving Print Quality" below.

Note: Acceptable 3D print quality is subjective, and depends on the type
and scale (size) of the 3D prints produced. As a rule, however, more than
10 missing lines in one area of a column is considered unacceptable.

Improving Print Quality

If you suspect that print quality is poor, perform the Pattern Test (see "Pattern
Test" on page 6-34). If the results are poor, use the following procedure to
improve print quality.

If the results of the last pattern test are poor:
1. From the Options menu, select Purge Sequence, or press F4.

2. Inthe confirmation dialog box, click Yes.

The print heads are purged of model and support material, and the wiper
removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see "Cleaning the Print Heads and the
Roller" on page 6-29).

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue left
on them.

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

> Optimize the print heads and replace faulty print heads, if necessary (see
"Optimizing (Calibrating) Print Heads" on page 6-46).

Cleaning the Roller Waste Collector and Inspecting the Roller Scraper

DOC-37004 Rev. J

The roller waste collector removes waste material scraped from the roller.
Suction removes this waste to the printer's waste container.

This assembly should be cleaned weekly to prevent a blockage in the tubes
leading to the waste container, so that waste material does not overflow into
the printer.
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To clean the roller waste collector:

1. Prepare—
0 M2.5 and M2 Hex (Allen) keys

O disposable cleaning gloves

[ 90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
[ cleaning cloth

[ cotton swabs (Q-tips or similar)

O mirror

O flashlight

2. From the Option menu, select Go to Head Inspection Position.
3. Puton the gloves.

4. Remove the right UV-lamp assembly:
a. Disconnect the UV power cable and the fan power cable.

Fanpower
connector

U Power
connector

Screw

Figure 6-38 Disconnecting the right UV assembly

b. Remove the screw that secures the right UV lamp, and then pull and lift
up the UV lamp.
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5. Loosen the two screws securing the suction tube on the print block.

Suctiontube
SCTEWS

Figure 6-39 Lifting the suction tube
6. Liftthe suction tube to secure itin a raised position.
7. Remove the two screws securing the covering of the roller waste collector

and remove it.

Be very careful to save the covering screws. These are special screws; if
they are lost, you need to order replacements.

Rollerwaste
- collector screws

Figure 6-40 Removing the roller waste collector screws

8. Remove the covering by pulling it out, and then lower it.
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9. Clean the roller waste collector and the scraper blade surface using cotton
swabs. Make sure to remove any remaining printing materials.

Figure 6-41 Cleaning the roller waste collector

% Before replacing the covering, you can check the effectiveness of the roller
scraper—see below.

To check the effectiveness of the roller scraper:

1. Puton the cleaning gloves.

2. Wet a cloth with isopropanol.

3. Use the cloth to wet the bottom of the roller.
4

. Turn the roller slowly with your hand. As the blade scrapes the roller, make
sure the isopropanol is spread evenly over the entire length of the blade.

5. Inspect the roller. Ifitis not dry, replace the blade. (See "Replacing the
Roller Scraper" on the next page.)

6. Before returning the roller waste collector to the print block, make sure that
the pins are clean.

Rollerwaste
collector pins

Figure 6-42 Roller waste collector pins

To re-assemble the components:

1. Return the roller waste collector to the print block and screw on the
covering (see Figure 6-40 on the previous page).
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2. Loosen the screws securing the suction tube.

" !
O == Securing screws

Figure 6-43 Positioning the suction tube

3. Lower the suction tube so that the hole in the panel behind the tube is
visible, and tighten the screws to secure the tube.

4. Attach the right-UV-lamp assembly to the print block and reconnect the UV
power and fan cables.

Replacing the Roller Scraper

You should replace the roller scraper blade—
« after 1,000 hours of printing.
« if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you
clean the roller waste collector. See "Cleaning the Roller Waste Collector
and Inspecting the Roller Scraper" on page 6-36.

To replace the roller scraper:

1. Prepare—
(O anew roller scraper blade
O a Phillips 1x75 mm screwdriver
O a2.5-mm and a 2-mm hex (Allen) key

2. Remove the right UV lamp and the roller waste collector covering (see
steps 4 to 7 on page 6-37).

3. Loosen the two screws securing the roller waste collector and pull it out.

Figure 6-44 Removing the roller waste collector
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4. Remove the screws that secure the roller scraper assembly.

Figure 6-45 Removing the roller scraper screws

5. Remove the scraper blade and discard it.

Figure 6-46 Removing the old roller scraper blade

6. Place the new scraper blade onto the pins in the holder, as shown.

oval hole
(in blade)

round hole
(inblade)

Figure 6-47 Inserting the new roller scraper blade
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7. Insert and tighten the roller scraper blade screws.

Important:

¢ Tighten the screws in the order shown in Figure 6-48.
¢ Use the new screws supplied in the replacement kit

Figure 6-48 Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to the print
block. (See steps 5 to 7 on page 6-37 in "Cleaning the Roller Waste
Collector and Inspecting the Roller Scraper".)

Aligning the Print Heads
You should check the alignment of the print heads—
» once a month
« after replacing one or more heads

« if quality is not acceptable even after cleaning the orifice plate on the bottom
of the print block (see "Cleaning the Print Heads and the Roller" on page 6-
29).

This procedure takes about 20 minutes.

To check the alignment of the print heads:
1. Prepare—

O atransparency sheet, about half of the standard A-4 or Letter size

O any type of adhesive tape, to fasten the transparency sheet to the build
tray

2. Start the Head Alignment wizard from the Options menu.
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. When instructed to do so, place the transparency on the build tray—next to

the left and rear edges of the tray, as shown in the following figure.

Figure 6-49 Positioning the transparency on the build tray

. Make sure that the transparency sheet is lying flat, and tape it to the tray.
. Close the printer cover.

. In the wizard screen, select the check box to confirm that the transparency

sheet is secured to the build tray, and click Next.

When you click Next, the printer prints the head alignment test on the
transparency. When printing is finished, the following screen appears.

-
Head Alignment Wizard ‘

Check Printer

Confirm before continuing:

[ The tranzparency iz secured to the build tray.

9

*" Stratasys
|

Figure 6-50 Head Alignment wizard—steps 7-9

7. Open the printer and remove the transparency.

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.
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Print Head Numbers
0 1 2 3 4 5 6

il i i TRl it i Tl
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Figure 6-51 Sample head-alignment test

Note: There is no column for head H7 because its alignment is used as a
reference for aligning all other heads.

. For each column of lines, use a magnifying glass or loupe to inspect pairs of

consecutive rows printed on the transparency to see where the vertical
lines align.

1234567
S\ | A7

I|I|II II|I|I
II|I|I llllll]
II|I|I I|I||| ]

Figure 6-52 Comparing rows of alignment lines

Note: It does not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper and
lower rows are aligned, as in Figure 6-52. In the example shown, no change
to the head alignment is necessary. If other lines in the set are aligned, you
need to change the alignment of that head—in the next wizard screens.
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9. Inthe wizard screen shown in Figure 6-50, select the Transparency
removed check box, and click Next.

The first in a series of alignment screens appears.

.
Head Alignment Wizard

oFF Head 6

OFF

OFF Selectthe number representing the aligned lines
oK on the transparency.

OFF
OFF
OFF 1 2 3 4 5 B 7

L

' Stratasys

= Help I X Lancel I I%Erevious] [ et ]

Figure 6-53 Head alignment selection

10.In the head-alignment screen, select the number that indicates which lines
align in the upper and lower rows of a pair on the transparency (counting
from the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number
“4” is selected, by default, in the wizard screen. This does not change the
head alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

11.Click Next to display the next head alignment screen, and again select the
number representing the most closely aligned vertical lines on the
transparency for that print head.

When you have finished aligning all of the heads, the following screen is

displayed.
Head Alignment Wizard
Select Action
@ Update spstem with new parameters.
) Keep previous parameters.
! Stratasys
2 Help I XK Cancel ‘ I%Erevious‘ I Mext = ‘

Figure 6-54 Parameter update confirmation
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12.Continue as follows:

(J To make the alignment changes in the printer, make sure that Update
system with new parameters is selected, and click Next.

0 To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

O If you do not want to make alignment changes in the printer at this time,
select Keep previous parameters, and click Next.

13.In the following screen, you can choose to either repeat the head alignment
procedure, or close the wizard.

Head Alignment Wizard
Select Action
@ Fepeat the test and print another transparency.
End this wizard.
Stratasys
2 Help | XK Cancel | |~(Erevious| [ Mext = ]

Figure 6-55 Repeat head alignment option

O If the most closely aligned vertical lines for a print head were at either
extreme, choose Repeat the test, then click Next.

The additional transparency test will show if the heads are now properly
aligned, and—if not—the wizard will allow you to “fine tune” the
alignment.

O Ifthe vertical lines for the print heads were not aligned at either extreme,
choose End this wizard, then click Next.

Optimizing (Calibrating) Print Heads

The condition of the print heads directly affects the quality of 3D prints. To
maintain optimum printing, you should routinely test the print heads, and
calibrate them to the best working configuration possible by running the Head
Optimization wizard every 300 hours of printing.

You also need to calibrate the print heads in these cases:

« after replacing Vero with Digital ABS or Agilus30 model materials (and the
reverse)

« after changing the type of support material (SUP705/705B/706/706B)

« after replacing the support material with cleaning fluid (and the reverse)
During this procedure, you place a scale on the build tray and connect it to the
printer. Printing material (resin) is jetted from each head and its weight is
automatically recorded and the wizard determines how to optimize the print
heads.
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If, during the optimization process, the wizard determines that a print head is
faulty—or that it is negatively affecting layer uniformity with the current head
configuration—the wizard instructs you to replace it. If this happens, you can
continue the wizard to replace the print head, or abort the wizard, to replace the
head at another time.

Run the Head Optimization wizard every 300 hours of printing or whenever
the condition of print heads is negatively affecting the quality of 3D prints, or
if you suspect that there is a problem with one or more of the print heads.

Note: Allow at least 40-50 minutes per mode for performing this procedure
(not including time required for replacing faulty print heads). To accurately test
and calibrate print heads, they must be clean. If necessary, run the Head
Cleaning wizard before beginning this procedure.

To test and calibrate the print heads:

1. Prepare—
O disposable cleaning gloves (any clean, powder-free protective gloves)
O pink paper
[ the Missing Nozzles ruler

O the scale supplied for use in the Head Optimization wizard

Important: Before beginning this procedure, ensure that the scale is
calibrated and at least partially charged.

2. Check that there is a material cartridge loaded in the M3 slot. If necessary,
insert a cartridge that contains different material than is loaded in the other
slots, or insert a cleanser cartridge.

Note: The Head Optimization wizard will not operate if the M3 cartridge
slot is empty.

3. Start the Head Optimization wizard from the Options menu.

File Options Help
Go to Tray Upper Position
Go to Purge Position 24 Sep 2015 14:28
Wipe
Go To Head Inspection
Purge Sequence F4 r

Pattern Test

Wizards Material Replacement
Built In Tests... Cirl+Alt+B Wiper Cleaning f

Head Cleaning

Maintenance Counters...

Collect Service Data B2 Head Filling Calibration

UV Calibration {
UV Lamp Replacement

Head Alignment

Head Optimization
Previous job last slice: 0 Load Cell Calibration

Shutdown

Figure 6-56 Starting the Head Optimization wizard

4. Inthe opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.
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5. Read the conditions, select | Agree and click Next.

6. Inthe following screen, select Continue with Head optimization if you
have recently cleaned the print heads. Otherwise, cancel the wizard and
run the Head Cleaning wizard.

-
Head Optimization Wizard

Py = N Select Action

If wou are naot sure that the heads are clean, cancel
this wizard and run the Head Cleaning wizard first.

(71 Cancel this wizard to clean the heads first.

(@) Continue with Head Optimization.

-/ stratasys

[ X Lancel ] [4Erevious] [ Heut 3= ] ;

Figure 6-57 Clean print heads screen

7. Inthe following screen, make sure Optimize all print heads is selected, and
click Next.

F =

Head Optimization Wizard

P = N Select Action

(@ Optimize all print heads.

() Replace faully heads and optimize all heads.

-/ Stratasys
|

Figure 6-58 Procedure selection screen

DOC-37004 Rev. J 6-48



Objet260 User Guide 6 Operating and Maintaining the Printer

8. Select the printing mode for which you want to optimize the print heads and
click Next.

Head Optimization Wizard

P N Select Print Mode

High Speed
High G uality

@ Digital Materials

</ stratasys

Figure 6-59 Printing mode selection

%{ If your printer is set to print in Single material mode, only the High Speed
and High Quality options are enabled.

If your printer is set to print in Digital Material mode, only the Digital Material
opiton is enabled.

9. Make sure that the build tray is clear and clean, and confirm this in the
wizard screen.

Head Optimization Wizard

&S

stratasys

Check Printer

Caonfirm before continuing:

[ The build tray is empty.
[ The cover iz closed.

’ x Lancel ] ’{ Erevious]

Figure 6-60 Preparing for head optimization (1)

When you click Next, a frame is printed on the build tray.

DOC-37004 Rev. J




Objet260 User Guide 6 Operating and Maintaining the Printer

10.When the following screen appears, open the printer and tape a sheet of
pink paper to the surface left of the build tray.

Head Optimization Wizard

Preparations for pattern test

Confirm before continuing:

[ & news test pattern paper is properly positioned
[T The cover iz closed.

stratasys

Figure 6-61 Preparing for head optimization (2)
When you click Next, the Pattern Test is printed on the pink paper.

11.When the following screen appears, open the printer and remove the
Pattern Test paper.

Head Optimization Wizard

Enter Missing Nozzles

4 A
M

&
,f" Enter the number of mizsing nozzles for each head below.

ot ol ol o ol o

Head 0 Head 1 Head 2 Head 3Head 4 Head 5 Head B Head 7

</ stratasys

4 Help XK Cancel |

Figure 6-62 Enter Missing Nozzles screen

12.Carefully inspect the Pattern Test paper with the Missing Nozzles Ruler to
see if there are missing lines.

Print Biock &

Frant of Prvier §
Figure 6-63 Inspecting the Pattern Test
Each missing line represents a faulty nozzle in the print head.
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13.In the Missing Nozzles screen, enter the number of missing nozzles for
each print head and click Next.

14.The wizard continues according to the number of missing nozzles you
entered.

O If there are too many missing nozzles for acceptable printing, the wizard
instructs you to replace the defective print head(s). You can do this now,
or abort the wizard.

If you are prepared to replace print heads now, the wizard guides you
through the procedure when you click Next. Make sure you have
replacement heads and the required tools (see page 6-55). Then,
continue with "Preparing the Print Block" on page 6-56.

Head Optimization Wizard

Error: High Missing Nozzle Count

Head b defective.

@ Replace defective head(z).

) Abort wizard.
stratasys
=T X Concel

Figure 6-64 Head replacement due to missing nozzles

O If the number of missing nozzles in all print heads is acceptable, the
wizard continues with the head optimization process (below).

15.Set up the scale in the printer by performing the steps listed in the wizard
screen.

Head Optimization Wizard

Prepare Scale

Perfarm the steps in the order below and caonfirm:

[ Paosition the scale on the tray and cornect the cable
[] Presz 1" to turm on the scals [without the container).
[ "wait For the scale to display '0.00"

[] Place the container on the scals.

[7] Press 'T' to zero the scale with the container.

[ Cloge the printer cover.

! Stratasys
2 Help X Cancel

Figure 6-65 Setting up the Head Optimization scale
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16.After confirming all of the items listed in the wizard screen, click Next.

Printing material (resin) is jetted from each head and its weight is
automatically recorded. Then, the following screen appears.

Head Optimization Wizard

Empty Resin Container

Ferform the following:

Empty container into purge unit.
Return the container to the scale.

Cloge printer cover,

Stratasys

x Lancel

Figure 6-66 Emptying the resin container

17.0pen the printer. Carefully remove the resin container from the scale and
empty itinto the purge unit. Then return the container to the scale.

& Caution: The resin in the container is uncured

¢ To prevent contact with skin, wear neoprene or nitrile gloves.

¢ Dispose of uncured resin in accordance with applicable regulations. By
emptying the container into the purge unit, the resin is stored in the printer’s
sealed waste container.

18.Close the printer cover, confirm the items listed in the wizard screen, and
click Next.

The printer cures the resin in the container.

19.When the following screen appears, open the printer and remove the scale.

Head Optimization Wizard

Remove Scale

Confirm befare continuing:

The scale and cable are removed.
The build tray iz empty and clean.

The cover iz clozed.

Stratasys

x Lancel

Figure 6-67 Remove Scale confirmation screen

20.Confirm the items listed in the wizard screen, and click Next.
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The wizard uses the data collected to analyze the condition of the print
heads and optimize them so they print with a uniform layer of material.

3 If the heads are in satisfactory condition, the following wizard screen
appears.

Head Optimization Wizard

N Print-head Optimization
4 Completed

C% The wizard has optimized the print head parameters.

You need to restart the printer application to print with the
new parameters.

Click 'Done' to close the wizard and restart the printer
application.

= Stratasys

57 Carcel | Ereviousl W Done I

Figure 6-68 Final wizard screen, after optimizing print heads

3 If the wizard determines that a print head is faulty—or that it is
negatively affecting part quality with the current head configuration—
you need to replace it. Indicate whether or not you want to do so now.

Head Optimization Wizard

P N Weight Test Results

Head 5 defective.

@ Replace defective head(s).

() Ahort wizard.
- Stratasys

Figure 6-69 Defective print heads found

» Select Replace defective head(s) if you are prepared to replace
the print heads now (see below).

or—

» Select Abort wizard if you want to replace the print heads at
another time.

% Replace print heads only after consulting with an authorized Stratasys
service provider.
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To replace print heads, you need these tools and materials:

O replacement print head(s)
O 90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

O disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)

O a supplied cleaning cloth or equivalent
O amirror

O a5-mm flat-head screwdriver or a 3-mm hex (Allen) key (depending on
the type of print block)

O the Missing Nozzles ruler

O the scale supplied for use in the Head Optimization wizard (Weight
Test)

Important: Before beginning this procedure, ensure that the scale is

calibrated and at least partially charged.

If you are replacing print heads now, the wizard guides you through the
procedure when you click Next. Continue with "Replacing Print Heads" below.

Replacing Print Heads

The condition of the print heads directly affects the quality of 3D prints. You
may need to replace a print head if one or more of the following symptoms
occurs:

* The Head Optimization wizard determines that a print head is defective.
(See "Optimizing (Calibrating) Print Heads" on page 6-46.)

* There are noticeable grooves in the surface of 3D prints.

* Visual inspection of the head reveals that its surface is damaged—peeling
or bubbles in the nozzle area.

» The printer interface displays a warning or malfunction message relating to
a print head—
O Head Heater temperature timeout
(J Head Heater thermistor open
O Head Heater thermistor short

%{ Replace print heads only after consulting with an authorized Stratasys
service provider.

The Head Optimization wizard guides you through the procedure of replacing a
print head, and configures printer components to enable you to perform it. Only
replace a print head with the aid of the wizard.
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The entire print-head replacement procedure takes up to three hours, and
consists of the following phases:

A

mmoo

Identifying the head(s) needing replacement.

This is normally done by the Head Optimization wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction message
indicates which head needs replacing.

Preparing the print block for head replacement.
This is done automatically when you run the wizard.

Removing the defective print head.

Installing a new print head.

Optimizing the print heads (done automatically by the wizard).
Performing head alignment.

To replace a print head:

1.

4.

Prepare—
replacement print head(s)

90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
disposable cleaning gloves (use clean, powder-free gloves)
lint-free cleaning cloths

a mirror

I R R I N A

a 5-mm flat-head screwdriver or a 3-mm hex (Allen) key (depending on
the type of print block)

[ the scale supplied for use in the Head Optimization wizard (Weight
Test)

O the Missing Nozzles ruler

Important: Make sure that you have these items and that the scale is
calibrated and at least partially charged before continuing.

Start the Head Optimization wizard from the Options menu (see the figure
on page 6-46).

In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

Read the conditions, select | Agree and click Next.
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5. In the following screen, select Continue with Head optimization if you
have recently cleaned the print heads. Otherwise, cancel the wizard and
run the Head Cleaning wizard.

Head Optimization Wizard

Select Action

If ywou are not sure that the heads are clean, cancel
this wizard and run the Head Cleaning wizard first.

() Cancel this wizard to clean the heads first.

(@) Continue with Head Optimization.

-/ stratasys

’ X Qancel] ’{Erevious” Mext = ] |

Figure 6-70 Clean print heads screen

6. Inthe following screen, select Replace faulty heads, and click Next.

g ~

Head Optimization Wizard

Select Action

() Optimize all print heads.

@ Replace faulty heads and optimize all heads.

-/ stratasys

ﬂ o) |

Figure 6-71 Procedure selection screen

Preparing the Print Block

7. Select the print head(s) needing replacement, and click Next.

"Head Optimization Wizard

Select heads to be replaced

HO H1 H2 H3 H4 H5 HE HT
Head 0 Head 1 Head 2 Head 3 Head 4 Head 5 Head 6 Head 7
B B B B 8 8 B

-/ Stratasys

| x Lancel | ’{ Erevious]

Figure 6-72 Head selection screen
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The printer heats and empties the print block, and prepares the printer.
(This should take up to 15 minutes.)

[Tiead Ophimieatan

Preparing for Head Replacement

QQ This step can take up ta 15 min.

< stratasys

x LCancel | <E Brevious | Hest §> I

Figure 6-73 Printer preparation progress screen

The following screen appears when the printer is ready for you to replace
print heads.

" Head Optimization Wizare
Print Head Replacement

The printer is ready for you to replace print heads.
Click 'Next' to continue.

< stratasys

XK Cancel | <72 Previous |

Figure 6-74 Printer ready for head replacement

8. Puton the protective gloves and open the printer cover.
Note: The printer disconnects power to the heads for your safety.

DOC-37004 Rev. J 6-57



Objet260 User Guide 6 Operating and Maintaining the Printer

Removing the Defective Head

9. Onthe print block, release the upper and lower screws that secure the print
head in the block. (If necessary, you may use a screwdriver to loosen the
SCrews.)

Figure 6-75 Releasing the locking screws

10.Press down on the upper and lower locking screws to release the print
head.

Figure 6-76 Releasing the print head
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11.Loosen the screws on the door of the compartment protecting the
print-head driver cards (A), then pull and lift up the door (B).

Fnag

;{\9 )

Ptin

Figure 6-77 Opening the print-head compartment

12.Pull the print-head driver card out of its socket so that the head is free (A),
and remove it from the bottom of the print block (B).

A Y,
25 4 4
fir ¢

Figure 6-78 Releasing the print-head driver card to remove the head

13.Make sure that along with the head, you remove the two rubber O-ring
seals.

Figure 6-79 O-ring seals on the print head

%{ Important

If the seals are not removed with the head, they are probably stuck to the
print block housing. If so, remove them.
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Figure 6-80 Making sure the O-rings are not stuck to the print block

Installing the New Head

14.Inspect the replacement head, and make sure that the O-ring seals are in
place (see Figure 6-79 on the previous page).

15.Gently insert the replacement head into the vacant slot in the print block,
and push the print-head driver card into its socket.

Note: Make sure to insert the head with the driver card facing its socket, in
the rear of the print block.

Figure 6-81 Inserting the print-head driver card into its socket
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16.Push the head up until you hear it click into place, in both front and rear
holders.

[{{((t[{

Py

Figure 6-82 Pushing the head into place in the print block

17.Lower the door of the print head compartment, and tighten the screws to
lock it in place.

18.Tighten the upper and lower screws that secure the print head in the print
block (see Figure 6-75 on page 6-58).

Note: Hand-tighten these screws. Do not use a screwdriver.

19.In the Replace print heads screen, select the check box to confirm that you
have replaced the head(s), and click Next.

Head Optimization Wizard

Replace print heads

Fefer to the instructions included in the head
replacement kit or click 'Help'. Confirm:

HO H1 HZ H3 H4 H5 HE HT -
[~ Head 0 replaced

-/ Stratasys

4 Help | Wiew Movie |

Figure 6-83 Head replacement confirmation
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20.With your fingers, make sure that the new head is level and even with the
other heads.

Figure 6-84 Checking the level of the new head

21.Confirm that the heads are level by selecting the check box in the following
wizard screen, and click Next.

[ Head Optimization Wizan

Installation Check

Check thatthe print heads are level and ewven.

et e

::,'.’Stratasys

‘? Help | x LCancel | ~(Ereviousl ﬂext§> I

Figure 6-85 Installation-check screen

22.In the next wizard screen, confirm that you have removed all tools and
objects from the printer.

Check Printer
Corifirn badors continuing

Figure 6-86 Cleared-tray confirmation screen
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23.Close the printer cover.

The wizard continues by heating the heads, then filling and purging them. If

there are no installation problems, the optimization procedure begins, to

calibrate the print heads to the best working configuration—see "Optimizing

(Calibrating) Print Heads" on page 6-46.

If installation problems are detected, the wizard alerts you and instructs you

how to continue (see "Installation Problems" below).

24 After replacing print heads, you should check the head alignment before
using the printer to produce 3D prints. In the final wizard screen:

O Select Yes and click Done to open the Head Alignment wizard (see
"Aligning the Print Heads" on page 6-42).

[ Select No and click Done to align the heads at another time.

Head Optimization Wizard

b Print-head Optimization

@ Completed

Do oo weant 10 run the “Head Aligrmignt’ wirard
e F'II:IW'I"

(Eiired
CiNe

" Stratasys

o Doem

Figure 6-87 Final wizard Screen

Installation Problems

If the printer detects that there is a problem after you install print heads, a
relevant warning screen appears.

> |f the printer software does not detect the replaced head:
a. Open the print head compartment (see Figure 6-77 on page 6-59).

b. Re-insert the print-head driver card into its socket (see Figure 6-81 on
page 6-60).
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> |f the replacement head was not calibrated by Stratasys, remove the head
and replace it with another one.

‘ Inserted head does not contain ‘

Q’G’G factory data

The installed head does not contain valid data.
Try replacing itwith another head.

Alternate print head installed.

Stratasys

x Lancel

Figure 6-88 Invalid-head warning
Contact your Stratasys service provider about the uncalibrated head.

Testing and Calibrating the UV Lamps

The level of UV radiation from the lamps used for curing 3D prints can change
over time. To ensure optimum curing of 3D prints during printing, a pop-up
message reminds you to test the lamps and calibrate the level of UV radiation
after every 300 hours of printing. You do this by running the UV Calibration
Wizard.

To measure the UV radiation, you need:

« Stratasys TOL-03005-S (UV sensor and cable)
or—

* a stand-alone UV radiation meter, approved for use with the printer

The wizard compares the measured radiation to the recommended radiation
level for each of the lamps, at each printing mode—High Speed and
High Quality / Digital Material.

When calibrating the lamps, the wizard attempts to adjust the radiation level, if
necessary.
* If the reading is within the acceptable range, the wizard continues to the
next phase.
* If further adjustment is necessary, the current phase is repeated.

* If the level of UV radiation is too low to be properly adjusted, the wizard
continues to the next phase, but the final wizard screen indicates that the
lamp’s radiation for the printing mode is unacceptable.

QE{ Before testing and calibrating the UV lamps:

¢ Make sure the glass lens on each of the UV lamps is clean. For easy
access, run the Head Cleaning Wizard, and use the special sanding
sponge supplied in the Start-Up Kit.

¢ Make sure that the glass over the UV radiation sensor is clean.
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To test and calibrate UV lamp radiation:

1.
2.

3.

Start the UV Calibration Wizard from the Options menu.

In the following screen, select Calibrate UV Intensity to adjust the lamp’s
radiation level to the acceptable range.

UV Testing/Calibration Wizard

o N Select Action

@ Test LV intensity
() Calibrate L1 intensity

() Calibrate LY senzor box [Support use only)

- Stratasys

Figure 6-89 UV Test/Calibration selection

In the following screen, select the UV sensor and measuring device to be
used.

UV Testing/Calibration Wizard

P = N Select Device

@ 1Y senzor box

(1 U external radiation meter

- Stratasys

Figure 6-90 UV device selection

% UV Measuring Device

When you use the Stratasys UV sensor box (TOL-03005-S), you connect it
to the printer. The wizard automatically measures and calibrates the UV
radiation.

If you use a stand-alone UV radiation meter, you need to manually enter the
readings from the meter in the wizard screens.
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4. Make sure that the build tray is empty. Confirm this in the wizard screen and
click Next.

UV Testing/Calibration Wizard

Check Printer

Confirm before continuing:

[ The build tray is empty.

Stratasys

x Lancel

Figure 6-91 Printer preparation

> When using a Stratasys UV sensor box that you connect to the printer

(TOL-03005-S), continue with "UV Sensor Connected to Printer" on the
next page.

> When using a stand-alone UV radiation meter, continue with "External UV
Meter" on page 6-69.
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UV Sensor Connected to Printer

The following steps apply when using the Stratasys UV sensor box that you
connect to the printer. They do not apply when using a UV external radiation
measuring device.

1. To synchronize the wizard and the UV sensor, enter the CF number from
the label on the back of the UV sensor box.

Synchronize Wizard and UV
Sensor

Enter the CF number prnbed on the LV-permor Label
[

Figure 6-92 UV sensor synchronization

UV SENSOR

em:  AAFUE ooy

[

CIF:
Calbration dote: =[5 [ AN

R

Figure 6-93 Label on the bottom of the UV sensor box

2. Click Next.
The build tray lowers.
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3. Open the printer and connect the UV sensor cable to the connector in the
printer.

Figure 6-94 UV sensor connector in the printer
4. Position the UV sensor as shown in the wizard screen.

5. Confirm the items listed in the wizard screen and click Next.

Check Printer

Coanfirn bafons continuing

[ [The L seraor bos iy conneched io e pandes
[T The L seror bas i pogitiored on sy 50 shown
[T The ghass ir the LUV seroon boe i chean:

[T The peinier covd i clogad

Figure 6-95 Sensor positioning

Continue with "UV Measurement " on page 6-71.
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External UV Meter

The following steps apply when using a stand-alone UV meter. This section
does not apply when using the Stratasys UV sensor box connected to the
printer.

1. When the following screen appears, open the printer and place the UV
sensor (probe) at the rear edge of the tray, in the center.

Check Printer

Coarfirn bafons continuing

[T |Thee LW weron is in e conter of the may's L edge
[T The senao cable i sted bo B hort of the prirksr

2 Hel X Corcel | ' |

Figure 6-96 Sensor placement screen

2. Lead the cable out of the printer so that you can close the printer, and tape
it down to make sure that it does not interfere with the moving print block.

1
Figure 6-97 Correct UV-sensor placement

3. Close the printer, while checking that the sensor does not move out of
position.

4. Setthe UV meter to measure md/cma2.

5. Setthe range on the meter to 2,000.
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6. Connect the cable from the sensor to the UV meter.
7. Turnon the UV meter, and wait until “0 0 0.0” appears on the display.

8. Inthe wizard screen, confirm that the sensor is positioned correctly, and
click Next.

Continue with "UV Measurement " on the next page.
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UV Measurement

The UV lamps power up and stabilize. (This takes several minutes.) Then, the
print block passes over the sensor and the wizard compares the measured
radiation to the recommended level for each UV lamp. During this process,
which takes 20—40 minutes, you need to monitor the progress as displayed in
the wizard screen.

UV Intensity Measurement

Q\I% Cusmerty sesdrg Right UV lsmp i Digital Materials Made
1 - Lamp stabilration

R 180 =)

ICyces

' stratasys

Figure 6-98 UV measurement progress

When using a stand-alone radiation meter (not the Stratasys UV sensor box
connected to the printer): Reset the meter and enter the reading
(measurement) when you are prompted to do so.

Enter, Yalue E|

Enter U measurement device reading

| nker value here, .,

[ Ok H Cancel ]

Figure 6-99 UV Measurement dialog box
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If the UV level measured is not acceptable, the wizard calibrates the UV lamp

by adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the
condition of the lamps after calibration (see Figure 6-100 below).

UV Testing/Calibration with External Device Wizard

| m Left UV Lamp
e DM Qﬂ 212.4 % [100%]
1 :-_‘:) 1655 -» 1455

HQ #1621 % [100%]
Q” 1655 -> 1435

HS & 147 8 % [110%]
Q” 1734 -» 1495

-/ Stratasys

UV Calibration Results

Right U¥ Lamp
& 228.6 % [100%]
Q” 1655 -» 1455

Q,ﬂ 162.1 % [100%]
1655 -> 1435

Q,ﬂ 147.8 % [130%]
1734 -» 1495

Figure 6-100 Results and condition of UV lamps after calibration

After examining the UV calibration results:

1. Click Next.

2. Remove the UV sensor and close the printer cover. After confirming the
items listed in the wizard screen, click Next.

If the results are not acceptable for quality printing, this is indicated in the

final wizard screen.

UV Testing/Calibration Wizard

Wizard Completed

stratasys

Figure 6-101 Final UV Calibration Wizard screen
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Calibrating the Load Cells

Load cells are sensors that measure the weight of the material cartridges and
the waste container in the printer. It is important that you periodically check that
the weight measurements are accurate to prevent unnecessary waste of
printing materials or printer malfunctions.

To calibrate load cells:

1. Start the Load Cell Calibration wizard from the Options menu.

2. Inthe following screen, select one or more load cells that you want to
calibrate.

Load Cell Calibration Wizard

Select Load Cells to Calibrate
Remove each cartridge you selected from the cart.
[ Model - 3 Left A [C1Model - 3 Right
[ Model - 2 Left A [T1Model - 2 Right
[ Model - 1Left ':“1—1 [T1Model -1 Right
[~ support Left ..'“1—1 [ support Right
‘ [ waste
=' Stratasys

(€

Figure 6-102 Load cell selection

3. Remove each selected cartridge from the materials cart, and click Next.

Load Cell Calibration Wizard
Remove the following cartridges
Before continuing, you must remove the cartridges shown,
Model - 3 Left ':“ﬁ Model - 3 Right
[ Model - 2 Left A Model - 2 Right
Model - 1 Left ':“1—1 Model -1 Right
§ LLLL] .
Support Left 111 [ support Right
- Waste
=" Stratasys

Figure 6-103 Confirmation of cartridge removal

4. Inthe next wizard screen, observe the numbers and wait until the weight
level is relatively stable—two units above or below the average level
shown.
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-

Load Cell Calibration Wizard

Indicate when Values are Stable

S
f-r" . ! Select the checkbox below when the active values are stable.
Lj 1163480 "“I". 1]
1162320 A 1162300
1161160 Sish 1161740

=

1160000 s 1160580

e

1]
stratasys [7] The active values above have stabilized.

Figure 6-104 Weight stabilization

5. Select the check box, and click Next.

6. Click Done in the final wizard screen.

Load Cell Calibration Wizard

Wizard Completed

L

If you removed the waste container, replace it and ensure
that the drain tube is not bent.

T If, after calibrating the load cells, you suspect that they are
not accurately measuring the weight of the containers,
contact your local customer support representative.

- Stratasys

b

Figure 6-105 Final wizard screen

Replacing the Odor Filter

If the printer exhaust is not connected to an external ventilation system, a
built-in activated-carbon filter removes odors from printing materials. This filter
should be replaced regularly (as necessary) to keep your working environment
pleasant. This is normally done during the preventive-maintenance service

visit.

If the printer exhaust is connected to an external ventilation system, the
odor filter is not needed and should be removed from the printer.

Odor filter removal improves heat expulsion and system cooling.
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Replacing the UV Lamps

The UV lamps used for curing 3D prints have a long, but limited, working life.
You can test and adjust their effective power with the UV Calibration wizard
(see "Testing and Calibrating the UV Lamps" on page 6-64). If you need to
replace a UV lamp bulb or UV reflector, follow these instructions:

To replace the UV lamp bulb or UV reflector:

1. Make sure the printer is in offline mode.

Y - L |

Figure 6-106 Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be red.
If not, click it to switch the printer to offline mode.

Warning

Before continuing, make sure that the safety interlock is not defeated, and
that the UV lamp is not hot.

2. Startthe UV Lamp Replacement wizard from the Options menu.

3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer, and click Next.

UV Lamp Replacement Wizard

Check Printer

Caonfirm before continuing:

-/ Stratasys

x LCancel |

Figure 6-107 Tray confirmation
The axes move to the “home” position.
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4. Selectthe UV lamp(s) to be replaced and click Next.

.
UV Lamp Replacement Wizard

P - N Select Action

[] Replace the right LY lamp.
[] Replace the lsft L% lamp.

stratasys

Figure 6-108 UV lamp selection screen

5. Disconnect the UV-lamp power connector and the UV heat fuse connector.

UV heat fuse
connector

Note: Do not disconnect the power connection to the cooling fans.
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6. Loosen the screw securing the UV lamp cover (A), and pull the cover up
(B), then out (C).

Figure 6-110 Removing the UV lamp cover
7. Pull the UV reflector out of the print block.

.rL
——

=

. ﬁ )
= \I’“’ - ‘
| Jl?ﬂfiﬂﬂ-i[

] s
e

R

!

Figure 6-111 Removing the UV lamp reflector

8. Using a 2.5-mm hex key, remove the UV lamp clamp (2 screws).

Figure 6-112 Removing the UV lamp clamp
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9. Remove the UV lamp bulb from the UV reflector.

Figure 6-113 Removing the UV lamp bulb

10.Before continuing, inspect the spring-loaded pins. If there are burn marks
around the pins or if the pins are loose—their springs are not functioning
properly—and do not support the bulb, continue with step 15, to replace the
UV reflector.

Otherwise, continue with step 8 to replace the UV bulb.

Figure 6-114 Spring-loaded pin
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11.Using the polyurethane tube provided in the kit, push the new UV lamp bulb
into the UV reflector. Make sure that the tip on the bulb is facing the slot.

12.Twist the tube by 180° (a), and continue to insert the UV lamp bulb into the
UV reflector (b).
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13.Use the UV lamp clamp to insert the lamp into place in the UV reflector.

Figure 6-117 Pushing the UV lamp into place

14.Using a 2.5-mm hex key, secure the clamp to the UV reflector, and continue
with step 25.

Figure 6-118 Attaching the UV lamp clamp

15.Inspect the new UV reflector, and make sure that a black strip is attached to
the inside of it. If not, install one—on the side of the reflector opposite (not
next to) the print block.

Note: Extra black strips are included in the printer Start-Up Kit. If
necessary, you can remove the black strip from the old reflector and install it
in the new reflector (as long as the black paint has not faded).

16.Discard the old UV reflector and lamp.

%{ Dispose of the used UV lamp in accordance with environmental and safety
requirements.

DOC-37004 Rev. J 6-80



Objet260 User Guide 6 Operating and Maintaining the Printer

Warning: Broken UV lamp hazard
UV lamps contain mercury. Deal with broken lamps with caution.

¢ Ventilate the room thoroughly.

¢ Use protective gloves when collecting mercury and lamp components.

¢ Remove spilled mercury with a method that prevents the generation of
mercury vapor, such as a syringe, packing tape or paper.

¢ Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container.

17.Insert the UV reflector unit into the housing, next to the print block.

UY lamp assembhy IV lamp azsembly

Black sfip 4‘ H Black strip

Figure 6-119 Print block and UV lamp assembly, showing correct
placement of black strip

18.Replace the UV lamp cover by inserting it into the slot on the bottom of the
housing, and tighten the securing screw on top.

Figure 6-120 Replacing the UV lamp cover
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19.Reconnect the power and heat fuse connectors.

Figure 6-121 Connecting the UV lamp

20.In the wizard screen, confirm that you have replaced the UV lamp(s) and
that the black strip is attached, then click Next.

UV Lamp Replacement Wizar:

Check Printer

Caonfirm before continuing:

[~ iThe selected U lamps were replaced.

[~ Shadow bracket iz placed comectly (zee help]

< stratasys
2 Help | X LCancel | <§Erevious| Mest £ I

Figure 6-122 UV-installation confirmation
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The wizard operates the UV lamps and checks if their power is within the
acceptable range for each printing mode.

Note: The mode currently being checked appears in the lower-left corner
of the printer interface.

UV Lamp Replacement Wizard

Warming UV Lamps

oﬁ LYV l[amp(s) warming up. This takes about 4 minutes.

<" stratasys

Figure 6-123 Status during UV lamp check

After replacing a UV lamp, it is recommended that you calibrate its power.
The next screen allows you to continue to the UV Calibration wizard (see
"Testing and Calibrating the UV Lamps" on page 6-64).

UV Lamp Replacement Wizard

Select Action

@ End the wizard.

(71 Run the Uy Calibration “Wizard now.

stratasys

Figure 6-124 Calibration selection screen

6-83



Objet260 User Guide

6 Operating and Maintaining the Printer

Built-in Tests

%
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The printer application contains a suite of tests for regularly checking the
hardware and software, and for troubleshooting.

Because running the tests affects the operation of the printer, you can only
open the Built-in Tests interface when the system is not printing.

The test suite features:

* The organization of printing-related tasks in categories:
Communications

Data cards

Temperatures

Voltages

Encoder repeatability

Print-head heating

Print-head filling

aqaaoaaaaan

* A clear display of test results and the source of any failures, enabling you to
determine if printing is possible or worthwhile.

* The ability to monitor test results for specific components.

* Troubleshooting tips.

Running these tests can help identify problems in the printer hardware and
software. A large number of hardware defects (or near-defects) warns you of
possible printing problems, either for current or future jobs.

Stratasys recommends running the built-in tests in the following cases:

e as aroutine test, once every two weeks
¢ as a system check, before major (long) jobs
¢ as needed, for troubleshooting

To open the Built-in Tests screen, do one of the following:

* From the Options menu, select Built-In Tests.
* Press CtrI+Alt+B.

ations Help

-3'!St Go to Tray Upper Position F5
Far Go to Purge Position F6
Wipe F7
Go To Head Inspection F&
j Purge Sequence F4
Pattern Test F3
|
l Wizards 3
\[ Built In Tests... Ctrl+Alt+B
| l Maintenance Counters...
Collect Service Data F2

\
Figure 6-125 Selecting Built-In Tests from the Options menu
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The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are

displayed.

Built In Tests (=]
Test Hame Group Statuz  Emor Description it Bi
O FIFO Monnkerupt Test [Data Card ? _
O FIFD Intermupt Test Drata Card ? a Resat
O Svstem Info Erwvironment ?

[ Parameter Sanity Check Parameters ?
OFrFID RFID ?
O Sub-Systern Communications Cormrunica... ?
[ Cabin Temperature General ? =
O Head Waltages Head Cards ?
[ Head/Black Heaters Heaters ?
O System Voltages Spstem ot P Summary
[ U Lamps UyLamnps ? ?
[ &xes Limits M akars ?
[ Black Filling Filing ?
O Encoder Steps Count Erncoder ?
% acuum Test Yacuum ? i
L ICY . . L . . L |
4 1 3
Tests Selection T
Group Selechon Set "‘g Help
| Al | | Hane | |Unknown| |--None-- vl |--None-- v| S
)’z Cloge

Figure 6-126 Built In Tests screen
Test List

Test Name
This column lists all of the tests, together with selection check boxes.
Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group drop-down list at the bottom of the screen.
Group
This column shows the component categories for each test.

This tells you which tests are run when selecting a category from the Group
drop-down list at the bottom of the screen.

Status

This column shows the results of each test after you run it:

V" Test successfully completed.
X Testfailed. (Double-click on a failed test’s line to review the failure details.)

7 Unknown results. (The test has not been run yet.)
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Test Selection Area

In the Test Selection area, at the bottom of the screen, you can quickly select
or de-select tests by their characteristics:

All

Click to select all of the tests in the list.

None

Click to de-select all of the tests in the list.

Unknown

Click to select all test that have not been run yet (Status = ?).

Group

Use this menu to select tests by component category.

Selection Set

Use this menu to select a pre-configured set of tests to run at
specified times (computer startup, before printing, etc.).

Running Built-in Tests

To run the selected tests:

> Click |

After you run a test, the Save and View command buttons are added to the
Built In Tests screen.

DOC-37004 Rev. J
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Test Results

To save and view a report of all tests:

> Use the Save and View command buttons.

Command Buttons

/- Miew

T 2le
< |1 Al
H & |3

Summary

X

‘8 Help
L Close

if

Click the command buttons, on the right side of the screen to perform the
following operations:

Run
Click to run the selected tests.

Reset
Click to clear previously run tests. This returns the status of each test to
Unknown (7?).

Save
Click to save a report that summarizes the tests run. The report is saved as an
HTML file. You can save any number of reports for the tests you run; the name
of the file saved is BITReport [date][time].htm. By default, these files are
saved in the printer installation folder, but you can save it in any other folder.

View

Click to display the latest test report that you saved. (You can view other test
reports by opening the relevant files in your Web browser. To do so, open
Windows Explorer, and double click the BITReportfile.)
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Close

Click to close the Built-in Tests screen.

Summary

On the right side of the screen, a symbol represents the combined results of all
the tests run, using the symbols from the Status column.

v All tests successfully completed.
X Atleast one test failed.

? Not all tests performed.
Test Descriptions and Troubleshooting
The following table lists the name of each test in the Built-in Tests suite,

together with its description and a possible reason for its failure. If you need
assistance, contact your Stratasys service provider.

Test Name Description Possible Reason for Failure
FIFO Non-Interrupt/ | « Tests the data queue in the « If both FIFO tests fail:
FIFO Interrupt DATA PCl card. Faulty DATA_PCl card.
+ Tests the Windows interrupt.  Ifonly the FIFO Interrupt test fails:
Faulty Windows interrupt.
System Info Compares the following parameter | Failure of RAM memory allocation in
values with the minimum the printer computer.

requirements.
» physical memory
+ available memory
» free space on disk
* monitor resolution

Parameter Sanity Compares the values of all printer | One or more of the printer parameters
Check parameters (in cfg files) to the is not within the required range.
required values. Details appear in the BIT report.
RFID Verifies the presence of RFID tags + Faulty RFID reader.
on material cartridges, and tests - Faulty RFID reader power supply.

them (by writing data to the tag and

then reading it). » Faulty or misaligned RFID tag.

» High level of electromagnetic
noise around the RFID tag.

Sub-System Tests communication between « Disconnected communications
Communications printer components. cable.

+ Faulty cable.

Cabin Temperature | Tests the temperature level in the « Faulty temperature sensor
build-tray area. (OHDB).

* Failure of exhaust fan.

+ Clogged exhaust filter.
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Test Name Description Possible Reason for Failure

Head EEPROMs Tests the read/write capabilities of | Faulty print-head driver card(s).
the print-head driver cards.

Head Voltages Checks the control of voltages Faulty print-head driver card(s).
supplied to the print heads.

Head/Block Heaters | Tests the heaters in the print heads | Faulty heaters or thermistors.
and in the print-block body.

System Voltages Checks if the following voltages are | « VPP power supply:
within 5% of the required voltage: Faulty head driver.
e 40V to the print heads by the « VDD power Supp|y:
VPP power supply Faulty height thermistor.
* 12V to the height thermistors by
the VDD power supply
UV Lamps Tests each UV lamp at the High  Faulty UV lamp.
Quality power level. « Faulty UV power supply.
» Disconnected UV cable.
Axes Limits Tests the hardware and software Faulty hardware sensors.
limits of all axes. Wrong Max Position parameter.
Block Filling Analyzes the thermistor readings Faulty thermistor.
when the block is full and when it is
empty.
Encoder Steps Count | Tests the encoder's reliability by Misaligned or faulty encoder.

comparing readings from multiple
runs along the X-axis.

Vacuum Test Tests the vacuum level in the print « Faulty vacuum sensor.
block. + Vacuum leakage.
* Wrong parameters.
Interlock Tests the interlock in the printer + Failure of interlock mechanism.
cover. + Faulty latch.

» Disconnected cable.

Version Tests Checks the compatibility between
the software and component
firmware versions.

DOC-37004 Rev. J 6-89



Objet260 User Guide

6 Operating and Maintaining the Printer

Replacing the Waste Container
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Printer waste contains partially cured polymeric material, collected during
normal operation and maintenance of the printer. For safety and environmental
reasons, this material is kept in a special leak-proof, disposable container.

The container has a capacity of about 8 kilograms of waste material—usually
enough for several months of printer use. The printer application displays a
warning message when there are 7.3 kilograms of material in the container,
and stops the printing when the net weight reaches 7.8 kilograms. Above 7.3
kilograms, the software does not allow you to start a printing job or activity until
you replace the waste container.

You can monitor the weight of the waste container in the Printer Indicators
display in the printer interface. You can also visually inspect the level of waste
in the container. To access it, see page 6-91.

To monitor the waste weight (and other indicators) in the printer:

> In the main printer interface screen, click the display toggle to view the
printer indicators.

16 Oct 2012 19:14

Heads (°C)

65 | 65 BRI 65 | 65 § 65 | 65 | 65 | 65 UL

Waste (gr) m Heads Liquid
¢ “ Heads Vacuum
UV Lamps n n Pre Heater Front

Pre Heater Rear
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The waste container consists of a plastic container inside a cardboard box.
You typically dispose of the entire waste container—including the box.
Therefore, you must assemble a new box and insert a new plastic container
before you can install it in the printer.

Replacement boxes, plastic containers, and sealing caps are supplied in
the printer start-up kit and in the preventive-maintenance kit.

To prepare a new waste container:

1.

Assemble the cardboard box, making sure to punch out the perforated
sections.

Fold a new waste bag—so it fits in the box—and insert the bag’s screw-
connector into the hole in the top of the box.

Note: Do not close the box until you connect the waste drain tube from the
printer.

To replace the waste container:

1.

Push the door of the lower printer compartment to open it.

2. Push in the top-center of the door to release the latch and open the door.

Waste
container

Figure 6-127 Waste container under the printer

3. Carefully slide out the waste container to remove it from the printer.

Figure 6-128 Waste container removed from the printer

4. Place the new waste container next to the full container.
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5. Unscrew the cap securing the waste drain tube and connect it to the new
container.

6. Close the full container with the cap supplied with the new waste container.
Note: The sealing cap contains an inner stopper that prevents leakage

when the cap is tightened. Do not be concerned that air can still flow
through the opening on the top of the cap, since the inner stopper seals the

waste container.

Stopper Opening in top

Figure 6-129 Waste container sealing cap

7. Close the new waste container box.

8. Position new the waste container in the printer.
Note: Make sure that the waste drain tube is not crimped or twisted, and
that it is not pinched by the container.

9. Close the compartment door.

Dispose of the full waste container in accordance with environmental and
safety requirements.
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Cleaning the Exterior Panels

The painted exterior plastic panels of the printer has a durable finish, offering
excellent chemical resistance to common cleaning materials. Follow the
recommendations below when cleaning these areas of the printer.

Acceptable Cleaning Agents

* mild soap solution

» common household cleaners and window cleaners

» common commercial and industrial detergents, 5% solution in water

+ alcohol (ethanol, isopropanol), 10% to 40% solution in water
Wipe the exterior of the printer, using a soft cloth moistened with the cleaning
solution.
Unacceptable Materials

* industrial solvents
* cleaning agents containing hydrocarbons, ketones, esters and lacquer
thinners

* spray disinfectants

« abrasives and agents which could wear away the panel finish

Cleaning the UV Screen

The transparent section of the cover is made of strong, acrylic material that
screens out harmful UV radiation. Use extreme care when cleaning it to
prevent the appearance of scratch marks.

& Caution

Do not use abrasive cleaners or cleaning fluids containing ammonia,
alcohol, acetone, benzine, carbon or tetrachloride. These materials can
cause permanent damage to the surface.

To clean the UV screen:

1. Blow off surface dust.
Do not wipe the surface to remove dust; this might scratch the surface.

2. Prepare a 1-percent solution of mild dish-washing soap in water—about
two teaspoons (10 ml) in a liter of water.

Note: While soapy water is effective for cleaning, commercial products are also
available for cleaning acrylic surfaces (for example, Novus® and Brillianize®).

These products give the surface antistatic, smudge and scratch-resistant
properties.

3. Soak a micro-fiber cloth in the solution.
Do not use paper towels, which can cause scratch marks.

4. Thoroughly wet the surface with the cloth. Do not wipe!

5. Rinse the cloth with clean water.
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6. Absorb the solution from the acrylic surface with the cloth, without applying
pressure.

7. If necessary, repeat to remove any remaining marks, or apply clean water
to rinse the surface.

8. Ifthe surface is still wet, you can dry it with a clean, micro-fiber cloth by
gently wiping in one direction.

If convenient, you can apply the cleaning solution and water to the acrylic
surfaces with a spray bottle instead of with the cloth.
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Removing 3D Prints After Printing

When printing is completed, you should allow the 3D prints to cool as much as
possible before handling them. If additional 3D prints do not have to be
produced on the printer, it is best to let the 3D prints cool in the printer, with the
cover closed, as long as possible.

If the printer must be used to produce additional 3D prints as soon as
possible:

1. Letthe 3D prints cool on the build tray for at least 10 minutes.

2. Puton protective gloves .

& Warning:

Wear protective gloves when handling 3D prints before they are washed.

3. Very carefully, remove the 3D prints from the tray with a scraper or spatula
(supplied in the tool kit), taking care not to pry or bend the 3D prints.

Warning: Sharp Object Hazard

Directing the scraper at of body parts can result in injury. When removing
the parts, always push the scraper away from you.

4. Place the 3D prints on a flat surface, and cover them with a cardboard box
or paper hood.

This allows them to cool slowly and evenly.

5. Letthe 3D prints cool for several hours.

Removing the Support Material

After the 3D prints have cooled, the support material must be removed. This
can be done by different methods, depending on the type of support material,
the size of the 3D print, how delicate it is, the amount and location of the
support material, and other factors. The methods described in this section refer
to removing general-purpose support materials from 3D prints, for most
printing applications. Use this information as a guide, and adapt the methods
(or a combination of them) for cleaning your 3D prints.

For special printing applications, refer to documents on the Stratasys
Support Center or consult a Stratasys 3D printing expert.
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The following types of support material available:

» SUP705/705B, a gel-like support material.

» SUP706/706B, an easily removed support material that dissolves in a
solution of caustic soda and sodium metasilicate.

The support material can be removed from 3D prints using the following
methods, in this order:

1. by hand
2. water pressure (in a suitable cleaning unit)

3. SUP706/706B: 2% caustic soda and sodium metasilicate solution.
SUP705/705B: 1% caustic soda solution (recommended for a smooth
finish)

Removing Support by Hand

While wearing protective gloves, break away excess support material on the
outside of the 3D print. For delicate 3D prints, use a toothpick, pin or small
brush after dipping the 3D prints in water.

» For SUP705/705B, after breaking away excess support material, soak the
3D printin a 1% caustic soda solution (see "Removing SUP705/705B with
Caustic Soda" on page 7-4).

» For SUP706/706B, after breaking away excess support material, soak the
3D printin a 2% caustic soda and sodium metasilicate solution (see
"Removing SUP706/706B with Caustic Soda and Sodium Metasilicate" on
the next page).

Removing Support with Water Pressure

For most 3D prints, the most efficient way to remove support material is by
using a high-pressure water jet. One suitable system is the Objet WaterJet
cleaning unit. This device is marketed by Stratasys.

Figure 7-1 Objet WaterJet Cleaning Unit
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To clean a 3D print using this device, you manipulate it and the water using the
built-in, waterproof sleeves. A pump turns ordinary tap water into a high-
pressure jet. A wiper keeps the window clear.

Use caution when cleaning delicate 3D prints with high-pressure water
systems.

Removing SUP705/705B with Caustic Soda

Soak 3D prints in a 1-percent solution of caustic soda (sodium hydroxide) to
remove support material from difficult-to-reach areas and to give the 3D printa
smooth, clean finish. The amount of time you soak the 3D prints in the solution
depends on how delicate it is and how much support material needs to be
removed, but it is typically between half-an-hour and several hours. In any
case, you should remove as much support material as possible before the
caustic soda treatment, and rinse the it thoroughly (with a water jet) afterwards.

& Warning

Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour
water into caustic soda. When diluting the solution, always add caustic soda
to water. Take adequate safety precautions; always use nitrile gloves when
handling caustic soda and 3D prints soaked in it.

Removing SUP706/706B with Caustic Soda and Sodium Metasilicate

%

T\
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Soak 3D prints in a 2-percent solution of caustic soda (sodium hydroxide) and
sodim metasilicate (Na,SiO3) to remove support material. The amount of time

you soak the 3D prints in the solution depends on how delicate it is and how
much support material needs to be removed. Rinse the 3D print thoroughly
under running water afterwards.

SUP706/706B will dissolve into the caustic soda and sodium metasilicate
solution and saturate it, reducing its effectiveness. Replace the solution
when the support material reaches 15% of the solution (after approximately
one month of average use).

Warning

Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour
water into caustic soda. When diluting the solution, always add caustic soda
to water. Take adequate safety precautions; always use nitrile gloves when
handling caustic soda and 3D prints soaked in it.
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Post-Printing Treatment

Post-printing treatment is recommended for 3D prints with several special-
purpose materials or for special applications. Recommendations for treating
and finishing 3D prints after printing are described in the Best Practices for the
desired printing material available on the Stratasys Support Center.

Photobleaching for Transparent 3D Prints

3D prints fabricated with clear materials, such as VeroClear (RGD810) and
have a slight yellow tint when removed from the printer. This is especially true
for 3D prints with a glossy finish. The yellow tint fades naturally over time, but
you can greatly accelerate this process by using a suitable photobleaching
treatment. This involves exposing 3D prints to intense light immediately after
printing.

%{ Photobleaching methods and instructions are described in the Best
Practices for the relevant clear material. These are available on the
Transparent materials page on the Stratasys Support Center.

Refer to the Best Practices for:
* VeroClear RGD810

Storing 3D Prints

3D prints are cured as they are printed, making them safe and stable for a long
time. However, proper storage conditions are necessary to prevent deforming.

» Keep 3D prints at room temperature and in a low-humidity environment.

* Do not expose 3D prints to direct sunlight and other heat sources.
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